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1. Get Started with OMNIC Paradigm 

Software
Welcome to OMNIC Paradigm software. Learn how to install and update your software, explore software options, and learn 
the basics of using OMNIC Paradigm software to measure and analyze spectra.

In this section: 

1.1 Welcome to OMNIC Paradigm Software 5

1.2 What’s new in OMNIC Paradigm v2.3 8

1.3 Key Concepts and Features 15
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1. Get Started with OMNIC Paradigm Software

1.1 Welcome to OMNIC Paradigm Software
Thermo Scientific™ OMNIC™ Paradigm software for desktop and touchscreen is an advanced software package for FTIR 
spectroscopy and microscopy, designed to simplify how you acquire, process, and interpret data and to help you work 
remotely and collaborate with colleagues around the globe.

1.1.1 Manage New and Recent Work from the Dashboard

With the new dashboard in OMNIC Paradigm software, you can set and save your measurement settings, measure a new 
sample, resume your recent work, or run an automated workflow all from the same, convenient screen. 

In the touchscreen interface, the home screen provides many of these same tools and features in an even more 
streamlined, intuitive interface so operators can focus on their work and on the tools they need.
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Learn More

 l "Set and Save Measurement Options"

 l "Measure a Sample"

 l "Create and Run Your First Workflow"

1.1.2 Process, Analyze, and Explore Spectra in the Spectra 

View

Use the Spectra view to process, analyze, or explore your data in depth. Here you can process your data, find and label 
peaks, and optimize the view so you can more easily compare or analyze spectra.

The results pane allows you to quickly add or remove a spectrum from the main view, explore details of each spectra, or 
review the change history of your selected spectrum.

Learn More

 l "Identify an Unknown Sample with ATR"

 l "Identify an Unknown Sample with Transmission"
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1.1.3 Automate Repetitive Tasks with Workflows

Automate your tasks with a workflow to ensure that measurements are collected and processed in exactly the same way 
each time. Edit or create a workflow by simply dragging and dropping tiles in the workflow editor, and then run the workflow 
at the click of a button. 

Operators using Paradigm for touchscreen can import and run one of our factory installed performance tests or a custom 
workflow right from the home screen.

Learn More

 l "Create and Run Your First Workflow"

 l "Workflow Tiles Reference"
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1.1.4 Share Your Work Remotely

Upload your data to the cloud and use OMNIC Anywhere to view, analyze, or share your data using any connected PC, 
Apple computer, Android or iOS device. 

With a free Connect account, measure samples in the classroom or lab, upload the data to your Connect account, and view, 
explore, or share the data on another device in your dorm or workspace.

Learn More

 l View Your Data with the OMNIC Anywhere App

1.2 What’s new in OMNIC Paradigm v2.3
With OMNIC Paradigm software version 2.3, if you have the Time Series package, you can collect Time Series data and 
quickly identify components in your sample as well as import TA Instrument data to see even more information about your 
sample. New processing tools now give you more ways to explore your data.

For a full list of new features and resolved issues, see the Release Notes.

1.2.1 Collect Time Series data

With a Time Series analysis, you can now measure a series of data to identify and analyze change over time, such as in a 
TGA or GC analysis.
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1.2.2 Identify components in time series data

Select Search in your Time Series analysis to identify components in your data. This search is like Mercury TGA in OMNIC 
software and uses MCR and multi-component search to show you what components appeared during your analysis and 
when they were present.
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1.2.3 Import TGA data

If you are collecting TGA data on a TA Instruments analyzer, you can import a .TGA file to add weight, temperature, and 
derivative weight to your profiles.
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1.2.4 Import qualification standards

With the new qualification standards tool, you can import DST and QDF standards files and track key details about your 
standards, such as expiration dates and serial numbers, conveniently in the software.
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1.2.5 Straight line

Use the straight line tool in the Processing menu to replace a region of the spectrum with a straight line. As with the blank 
region tool, this is useful for removing unwanted features of your spectrum.
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1.2.6 Collect single-point measurements in the microscopy 

view

When using the microscopy view, use the Auto Sample feature to collect data at the point currently shown in the live view. 
The new measurement is automatically added to the measurements list on your dashboard.

1.2.7 Apply atmospheric correction after collection

With single measurements, you can now apply atmospheric correction after the measurement is complete. Before, you 
could only apply the correction before measuring data.
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1.2.8 Add many spectra to a library at once

You can now add many spectra to a custom library at once. Before, you could only add spectra to a library one at a time.
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1.3 Key Concepts and Features
This section introduces the core concepts of using OMNIC Paradigm software. The information in this section will help you 
develop a basic understanding of OMNIC Paradigm software so that you can leverage all of the features and tools to 
analyze your samples. 

1.3.1 OMNIC Paradigm Software Basics

Understanding the core concepts of using OMNIC Paradigm software will help you more efficiently and effectively collect, 
analyze, and report spectral data. 

You may not always carry out every step of the following process, and you can customize OMNIC Paradigm software to 
meet your specific needs, but in general, you will likely follow a common process:

Plan Your Project

Before getting started with the software, it’s important to consider your project goals. Planning in advance will help you 
decide what type of processing and analysis is appropriate for your work, what measurement settings will yield the best 
data, and how you can most efficiently carry out your procedures. 

Before acquiring data, you should be able to answer the following questions:

 l What are my goals for the project? 

For example, do you want to identify an unknown sample or verify that your sample is meeting your standards. With 
OMNIC Paradigm software, you can run different processes and analysis steps depending on how you will use the 
data. Common goals include the following:

 l Identify a pure sample 

 l Identify the components of a mixture 

 l Verify that a sample meets your specifications

 l Quantify the components of a sample 

 l How will I measure my sample?

OMNIC Paradigm software supports a variety of spectrometer sampling accessories and measurement techniques. 
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See “FTIR Sample Handling Techniques” on FTIR Spectroscopy Academy for a full discussion of choosing the best 
collection method for your specific work.

 l Am I planning only a few measurements or will this be a routine, repeated procedure?

If you would like to automate a routine procedure, you can create a workflow. With a workflow, you specify settings for 
data collection, provide instructions to operators, and define data processing, reporting, and archiving in advance. You 
or other operators can then use the workflow to carry out procedures with the knowledge that exactly the same steps 
will be taken each time.

For a step-by-step guide on creating a new workflow, see "About Workflows"

Acquire Data

Once you have a plan for collecting and working with your data, you’re ready to start measuring samples. Generally, to 
measure a sample and collect data, you will follow these steps:

 1. Prepare the spectrometer, sampling accessory, and sample to be measured.

Usually, you should make sure your spectrometer, sampling accessory, and sample are ready before you begin. This 
can mean ensuring the spectrometer is warmed up and functioning well, that the sampling accessory is installed, and 
that the sample is prepared. 

The specific steps for setting up the spectrometer and accessory will vary depending on the instrument and on your 
sample. See the user guides and tutorials for your instrument for specifics on preparing your spectrometer. Or, see 
FTIR Spectroscopy Academy for more on handling and measuring samples.

Note that you must measure the background without the sample present. The best time to collect a background 
spectrum will vary by the type of sample you are measuring. 

 2. Select or edit your measurement settings.

When the instrument is ready, you can adjust settings both for how the software will collect and process the data and 
for setting up the spectrometer. Select your saved settings from a menu on the dashboard or edit settings individually 
for a single measurement.

See "Set and Save Measurement Options" for a discussion of how to edit and save measurement settings.

 3. Measure the background.

When you measure a sample, the spectrometer records data from the sample as well as from the environment in the 
spectrometer. To ensure that your sample spectrum represents only your sample, without any data from the 
background environment, you must measure the background. The background spectrum is then compared to (or 
ratioed against) the sample spectrum and any data from the background is accounted for, leaving you with data from 
only your sample.

See "Measure the Background" for a full discussion of when and how to collect a background spectrum.

 4. Measure the sample.
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Finally, you can measure the sample. During the measurement, you can preview the spectrum and refine your 
measurement settings before proceeding. If you indicated an analysis type in the settings, the data will automatically be 
processed after collection.

Once the data are collected, you will be able to view and explore the spectrum in the spectral view.

Process Data

After you measure your sample, it’s often helpful to process your data so that it is easier to analyze or compare to other 
spectra. Common spectral issues that OMNIC Paradigm software can help you correct include the following:

 l A sloping, curving, shifted or otherwise undesirable baseline

 l Peaks obscured by noise in the data

 l Variation in depth of penetration from an ATR measurement

 l Totally absorbing peaks from too thick of a sample

 l Issues caused by CO2 or H2O in the atmosphere

Analyze the Sample

OMNIC Paradigm software has tools designed to help you carry out common analyses and to explore spectral data in-
depth. Common types of analysis include the following:

 l Identify an unknown sample or mixture

To identify an unknown sample or the components of a mixture, compare the spectrum of your sample to reference 
spectra that are stored in spectral libraries. Spectral libraries are collections of spectra and usually contain additional 
information on the stored compounds. Libraries can be created or they can be purchased. When you run a correlation 
or multi-component search, the software searches your stored libraries and finds spectra that are similar to your 
sample spectrum and indicates how closely the spectra match. 

For more on spectral libraries, see "Manage Spectral Libraries"

For more on identifying an unknown sample, see "Identify an Unknown Sample with ATR"

 l Verify the composition of a sample

You can quickly verify that a sample meets your specifications by using QCheck. With QCheck, you can compare two 
selected spectra or compare one or more spectra with a reference spectrum or spectral group. QCheck results show 
the degree of similarity between the spectra as a match value from 0.0 (no similarity) to 1.0 (the spectra are identical). 
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 l Find the concentrations of components in a sample

Quantitative analysis methods that you have created in TQ Analyst software are available for use in OMNIC Paradigm 
software. You can select these quantification methods and run the quantification analysis from the OMNIC Paradigm 
dashboard. 

 l Perform custom, in-depth analysis

OMNIC Paradigm software features many tools to help you to explore the spectra further. For example, the Find Peaks 
tool lets you quickly identify and label peaks, or you can subtract one spectrum from another or perform other 
operations using Spectral Math.

Generate Reports and Save Data

Once you have collected, processed, or analyzed your data, you’ll likely want to store or share it. With OMNIC Paradigm 
software, you can customize how your data is stored or exported.

 l Exporting reports

When it’s time to share your data, you can generate reports automatically using templates. Templates can include 
results from library searches, QCheck, quantification methods, and more, or they can be used to send data directly to 
Microsoft Word, Excel, or PowerPoint.

 l Storing data

By default, the software is configured to store data in a MariaDB Server database, but you can also configure the 
software for other databases, such as Oracle Database or Microsoft SQL Server.

Additionally, settings, spectra, and workflows can be exported as files that you can backup, store, or share.

For a discussion of data security options in OMNIC Paradigm software, see “21 CFR Part 11 Compliance.”

1.3.2 Next Steps

You may not always follow every step of the process described in this guide, but in general, you will be able to achieve 
better results by understanding the overall process and capabilities of using OMNIC Paradigm software.

Next, get started by measuring your first samples, reviewing setup of your spectrometer, or creating a workflow to automate 
routine procedures. 
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1.3.3 OMNIC Paradigm Software Options

OMINIC Paradigm software features three interfaces to suit your device or task and pairs with other Thermo Scientific 
software, allowing you to develop and run quantification methods or protect and audit your data. 

OMNIC Paradigm Software Interfaces

Switch anytime between OMNIC Paradigm software’s touchscreen and desktop interfaces to best suit your device and 
goals.

Touchscreen Interface

Figure 1-1: The touchscreen interface features a simplified interface for streamlined analysis.

The touchscreen interface is optimized for small screens, such as the Thermo Scientific™ Nicolet™ Summit spectrometer’s 
optional touchscreen device.

Use the touchscreen interface for measuring and analyzing samples or running workflows in a streamlined, simplified 
interface. 
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Desktop Interface

Figure 1-2: The desktop interface includes a wider range of features and tools for more complex measurements and 
analyses.

Use the desktop interface when working from a larger screen and when you need additional features not available in the 
touchscreen interface, such as the workflow editor and select spectral processing and analysis tools.

Connect your Summit spectrometer to an external monitor and a USB mouse and keyboard for the best experience using 
the desktop interface.

Operator interface

The Operator interface is used for running workflows loaded from packages and for managing packages. After opening a 
package, operators are presented with a simplified interface designed to run the package workflows.
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For details on using the Operator interface and developing custom solutions, see "Custom Solutions". 

Switching Between Interfaces

Although desktop and touchscreen software are optimized for different tasks and devices, you can switch between 
interfaces at any time. 

❖    To switch between the touchscreen and desktop interfaces

 l To switch from desktop to touchscreen, select Configure > View > Touchscreen.

The software will close briefly and re-open with the touchscreen interface.

 l To switch from touchscreen to desktop, from the home screen, select Switch to Desktop from the menu.

The software will close briefly and re-open with the desktop interface.

Pairing OMNIC Paradigm with Other Thermo Scientific Software 

OMNIC Paradigm software is compatible with other Thermo Scientific software for added flexibility and for quantitative 
analysis and data security. 

Quantitative Analysis Software

Pair OMNIC Paradigm software with TQ Analyst™ software version 9.8 or later to develop and run quantitative analysis 
methods that you can use in OMNIC Paradigm software. 
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 l TQ Analyst EZ Edition

 l TQ Analyst Professional Edition

See “TQ Analyst™ Pro Edition Software” on thermofisher.com for details.

Data Security Software

Use Thermo Scientific™ OMNIC™ Security Suite Software version 2.2 or later to ensure your data’s security and integrity. 
The Security Suite software ensures 21CFR Part 11 compliance and includes the following:

 l Security Administration for controlling system access, handling security policies, and setting digital signatures for 
responsibility and data integrity

 l Audit Manager for creating and managing complete audit trails

 l Thermo Software IQ tool to verify your security installation
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2. Configure Your System
In OMNIC Paradigm software, you can configure your instrument connection and database, set up a back up schedule for 
your database, update your software, or customize display settings and other options.

In this section: 

2.1 Connect to a Spectrometer 25

2.2 Connect an Instrument to a Thermo Fisher Connect Account 33

2.3 Configure Your Database 36

2.4 Set OMNIC Paradigm Options 37

2.5 Manage qualification standards 38
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2.1 Connect to a Spectrometer
There are three ways to connect your laptop or other device to your spectrometer. The connection you choose depends on 
the instrument.

 l USB

 l Network connection

 l local area network

 l wireless network

 l Direct Ethernet connection

See the user guides and help content for your instrument for more on setup, installation, and connecting to other devices.

2.1.1 Connect to an instrument using a USB connection

Some instruments can be connected using an USB connection. For example, the Nicolet iS5 and Nicolet Summit LITE 
spectrometers use this type of connection.

❖    To connect to an instrument using a USB connection

 1. Using a USB cable, connect the spectrometer to your computer running OMNIC Paradigm software.

 2. In OMNIC Paradigm software, go to Configure and select Connectivity.

 3. Select the spectrometer from the list of instruments and click Connect.

2.1.2 Connect to an instrument using an Ethernet or wireless 

network connection

You can connect to the Nicolet Summit,  Summit PRO , or Summit OA spectrometer using an ethernet or wireless network 
connection. Before you connect to an instrument, make sure you understand database usage and user authentication.

Database Usage

When you connect to an instrument, you will always use the database configured by the client system.

For example, if you are using OMNIC Paradigm software on a laptop and you connect to a Summit spectrometer, you will 
continue to use the database configured by the software on the laptop. When you disconnect from the spectrometer, the 
software on the laptop will still show the data that was collected while connected to the spectrometer. If you then work 
directly on the Summit spectrometer, you will not see any of the data that was collected with the laptop.

When using a shared remote database, the data that is visible depends on which system you are using. For example, if 
several Summit spectrometers share a remote database with OMNIC Paradigm software that is being run on a laptop, you 
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can use the laptop to view data collected by any of the instruments. However, any individual spectrometer will show only 
data collected on that machine and not from any other spectrometer.

For more information on configuring your database, see "Configure Your Database".

User Authentication

When you connect to a Summit spectrometer, the spectrometer needs to authenticate your device to ensure the connection 
is safe and trusted.

Many organizations manage authentication between devices by using a Windows domain. A domain is a group of 
computers that share user account information and security settings. With a domain, an administrator can manage many 
devices, accounts, and policies from a single server called a domain controller. This often allows you to log into many 
devices on the domain using the same username and password.

When you connect to a spectrometer from your laptop, the spectrometer and your laptop both communicate with the domain 
controller to make sure that the connection is safe and trustworthy. If either device is not on the domain, you will not be able 
to make the connection.

If both devices are managed by the same domain, use a local or wireless network connection to connect to the 
spectrometer.

❖    To connect to a Nicolet Summit spectrometer on a local area network or a wireless network

If your computer and spectrometer are part of a shared domain (recommended), connect using WiFi or Ethernet. Before you 
begin, make sure the Summit spectrometer and the computer are on the same Ethernet or WiFi network.

 1. In OMNIC Paradigm software, go to Configure and select Connectivity.

 2. Select a spectrometer and click Connect.

If your spectrometer does not appear on the list of available instruments, you can also enter the IP address or 
hostname of the instrument and then click Connect.

If the spectrometer is already in use when you attempt to connect, the connection may be denied. The request can be 
denied for two reasons:
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 l The instrument is busy measuring a sample or processing data and cannot be interrupted.

 

 l Another user is operating the instrument and chose not to relinquish control.

 

If the current user does not respond within 30 seconds of the request, the connection is allowed automatically.

If the request is denied automatically or by the current user, you can return to Workstation mode, connect to another 
instrument, or try to connect again.

2.1.3 Connect directly to the instrument with an Ethernet cable

You can also connect to the spectrometer directly using an Ethernet cable.
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Using a direct connection requires you to edit the local security policies on the spectrometer. Because the instrument cannot 
communicate with a domain controller for user authentication when you are using this configuration, you must modify 
security policies to allow communication between the instrument and your computer.

Note Modifying security policies could pose a security risk to your organization. Follow your organization’s security 
policies.

❖    To use a direct connection

 1. Modify security policies on the instrument

 a. On the Nicolet Summit spectrometer, open the Local Security Policy application.

 

 b. Navigate to Security Settings > Local Policies > Security Options.
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 c. Set Network access: Let Everyone permissions apply to anonymous users to Enabled.

 2. Use an ethernet cable to connect the computer directly to the spectrometer.

 3. In OMNIC Paradigm software, if the software does not recognize the instrument automatically, go to Configure > 
Connectivity and connect to the spectrometer.

Preventing Connections from Unsecured Devices

If your spectrometer is using Thermo Scientific Security Suite software to protect and secure your data, you may want to 
prevent connections from unsecured devices. For example, with the default settings, if a laptop that is not managed by 
Security Administration software and Audit Manager software connects to a secure spectrometer, any action taken on the 
laptop would not be managed or logged.

To prevent connections from unsecured devices, you must edit your firewall settings on the secure spectrometer. Disable all 
Inbound rules that belong to the group RabbitMQ or to OMNIC Paradigm. See "Firewall Settings" for additional details on 
these rules.

The following procedure describes disabling the Inbound Rules in Windows Defender Firewall. Your organization may use 
another application to manage firewall settings.

❖    To disable Inbound Rules in Windows Defender Firewall

 1. Open Windows Defender Firewall with Advanced Security.
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 2. In the left pane, navigate to Inbound Rules.

 3. In the primary pane, under Inbound Rules, select a rule to disable.

 4. In the Actions pane, click Disable Rule.

The Enabled column for the rule you have selected changes to No.

To re-enable the rule, click Enable Rule in the Actions column.

Troubleshooting

Instrument Not Appearing in Available Connections

If your spectrometer does not appear automatically in the list of available instruments when you go to Configure > 
Connectivity, check your network connections.

The spectrometer and the computer making the connection must be on the same network for the instrument name to appear 
in the list. For example, if your organization has several wireless networks, make sure that the spectrometer and computer 
are on the same network.

If the spectrometer’s name doesn’t appear in list of instruments, you can attempt to connect by entering the spectrometer’s 
IP address.

not communicating with services after computer name change

If the the System Status dialog shows that the system is not communicating with any services after you have changed the 
computer name, you must repair the OMNIC Paradigm Prerequisites installation. 

For instructions how how to repair the installation, see Microsoft's support information on how to repair apps and programs 
in Windows. Follow the instructions to repair OMNIC Paradigm Prerequisites. 
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Advanced Troubleshooting

If you cannot connect to a spectrometer, you may need to check your firewall settings. Only the IT or network administrator 
at your organization should edit firewall settings.

Firewall Settings

When OMNIC Paradigm software is installed, your firewall settings are updated to allow a connection between a 
spectrometer and OMNIC Paradigm Workstation software. If you experience problems with your connection, check your 
firewall settings on both the spectrometer and the connecting computer to confirm that the following ports allow traffic.

The table below reflects the inbound rules as set in Windows Defender Firewall. The available fields may be different 
depending on the application your organization uses to manage network firewall settings.

Name Description and Ports Used

Password Management (NB-
Name-In)

Description: Inbound rule for Password Management to allow NetBIOS Name Resolution.

Group: Thermo Scientific Password Management

Program: System

Ports: UDP 137

Action: Allow

Profile: Domain, Private, Public

Password Management (NB-
Session-In)

Description: Inbound rule for Password Management to allow NetBIOS Session Service connections.

Group: Thermo Scientific Password Management

Program: System

Ports: TCP 139

Action: Allow

Profile: Domain, Private, Public

Password Management (SMB-
In)

Description: Inbound rule for Password Management to allow Server Message Block transmission 
and reception via Named Pipes.

Group: Thermo Scientific Password Management

Program: System

Ports: TCP 445

Action: Allow

Profile: Domain, Private, Public

Table 2-1: Required inbound rules
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Name Description and Ports Used

Thermo Scientific Instrument 
Discovery

Description: Allows clients to discover this instrument

Group: OMNIC Paradigm

Program: C:Program Files\Thermo Scientific\IR Instrument Engine\Instrument.IR.Engine.Service.exe

Ports: UDP 50123

Action: Allow

Profile: Domain, Private, Public

Thermo Scientific Web 
API Server

Description: Allows client to access a web API

Group: OMNIC Paradigm

Program: System

Ports: TCP 9004

Action: Allow

Profile: Domain, Private, Public

RabbitMQ - Peer Discovery 
(EPMD)

Group: RabbitMQ

Program: C:\Program Files\erl9.3\erts-9.3\bin\epmd.exe

Ports: TCP 4369

Action: Allow

Profile: Domain, Private, Public

RabbitMQ - Client Connection 
(erl)

Group: RabbitMQ

Program: C:\Program Files\erl9.3\erts-9.3\bin\erl.exe

Ports: TCP 5671, TCP 5672

Action: Allow

Profile: Domain, Private, Public

RabbitMQ - Management 
Console (erl)

Group: RabbitMQ

Programs:

C:\Program Files\erl9.3\erts-9.3\bin\erl.exe

C:\Program Files\erl9.3\bin\erl.exe

Ports: TCP 15672

Action: Allow

Profile: Domain, Private, Public
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Name Description and Ports Used

Thermo Scientific History 
WebAPI

Group: OMNIC Paradigm

Program: System

Ports: TCP 9002

Action: Allow

Profile: Domain, Private, Public

Thermo Scientific Workflow 
Engine

Group: Thermo Scientific Workflow Engine

Program: System

Ports: TCP 9090

Action: Allow

Profile: Domain, Private, Public

2.2 Connect an Instrument to a Thermo Fisher 

Connect Account
Connect your instrument to your Thermo Fisher Connect account to view and manage your instruments and data remotely.

For more information on Thermo Fisher Connect and managing your connected instruments, see the Help guide in the 
Thermo Fisher Connect application.

Before you begin

To connect your instrument to Thermo Fisher Connect, you need a Thermo Fisher Connect account. To create an account, 
visit https://www.thermofisher.com/us/en/home/digital-science/thermo-fisher-connect.html.

❖    To connect your instrument to your Thermo Fisher Connect account

 1. Using the Desktop interface of OMNIC Paradigm software, from the Dashboard, go to Acquire Data > Diagnostics > 
Instrument Health.

 2. Optional: Opt-in to sharing instrument health data.

 3. Click Link Instrument.

 4. To complete the connection, scan the QR code using the Thermo Fisher Instrument Connect app on your mobile 
device or use the 6-digit code.
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 l To use the 6-digit code

 a. Click Copy to copy the code to your clipboard.

 b. Go to Thermo Fisher Connect in your web browser.

 c. On the dashboard of the Thermo Fisher Connect web application, under My Instruments, paste or enter the 6-
digit code and click Link.

The instrument is now displayed in the InstrumentConnect section of Thermo Fisher Connect.

 l To scan the QR code
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 a. Open the Instrument Connect app on your mobile device.

 b. Touch the + icon in the upper right corner of the screen to add an instrument.

 c. Select QR Code.

 d. Use your device to scan the QR code.

The instrument is linked and displayed in the mobile app and online.
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2.3 Configure Your Database
When you first install OMNIC Paradigm software, the default database is set up on the local device and ready to use. You 
can continue to use the local database or connect to a remote database in another location on your network. Use a remote 
database to easily share measurements, settings, and other data across devices. 

2.3.1 Connect to a Remote Database

Connect to a remote database to easily share measurements, settings, and other data across devices. Change your 
database configuration at any time to suite your work. 

❖    To connect to a remote database

 1. Using the desktop interface of OMNIC Paradigm software, go to Configure and select Database. 

 2. Select the database type from the Database list. The default selection is Thermo Scientific Built-in. To connect to a cus-
tom database, enter the database type, version, name, and port. You may also need to enter a username and pass-
word.

 3. Enter the IP address or URL for the database server. 

 4. Click Test Connection to check if the software can connect to the server.

 5. If the test reports a valid connection, click OK to connect to the remote database.

The software restarts during connection. 

Check the Measurements group on the dashboard to confirm that you are seeing data from the remote database, or return 
to the Configure > Database menu to view your current connection. 
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2.4 Set OMNIC Paradigm Options
Use the Options dialog to customize the spectral display, to set the number of digits used for peak area, height, and 
location, and to configure automatic baseline correction.

❖    To set and save OMNIC Paradigm options 

 1. Open the Options dialog.

 l Desktop interface: open the Configure menu and select Options.

 l Touchscreen interface: Open the settings and navigate to the Options tab.

 2. Select New.

 3. Enter a name for the new options and click Save.

 4. Edit your settings.

 5. When you are finished editing settings, select Save to save your changes.

 6. Select Close to return to your previous screen. 

Figure 2-1: The Options dialog
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2.4.1 Customize Spectral Display Settings

The Spectral Display group is used to set the color and line weight of spectra in the Spectra view. 

 l Line Weight: Determines the thickness of the line used to draw the spectrum. Applies to all spectra shown in the Spec-
tra view.

 l Selected Spectrum Color: Determines the color used to highlight the currently selected spectrum. 

The additional colors set the colors of spectra that are not selected.

2.4.2 Set Number of Digits

Use the Number of Digits group to set the limit for the number of digits after the decimal separator. The limit is applied to the 
following: 

 l Peak area
 l Peak height
 l Peak location - X value
 l Peak location - Y value

Note that this setting only applies to operations carried out after the setting is adjusted. Numbers in the spectrum 
information maintain the settings used at the time they were recorded and are not updated to reflect new settings. For 
example, if you carry out a find peaks operation with settings specifying 3 digits, the spectrum information shows 3 digits. If 
you then change your settings to use only 1 digit after the decimal, the spectrum information from the earlier find peaks 
operation will still show the 3 digits. 

2.4.3 Configure Automatic Baseline Correction

Use Automatic Baseline Correct in the Process menu to automatically correct tilted or curving baselines. 

Set the polynomial order and number of iterations to specify the order of the equation and number of iterations to use for 
correcting baselines automatically.

2.4.4 Add a custom logo to reports

Use your own logo on reports and template reports. The image is shown on standard reports and reports you create using 
the Template Report tile in workflows. 

Report images must be a PNG file and are automatically resized to be 120 px by 75 px. 

2.5 Manage qualification standards
Use the Qualification Standards tool to manage any certified standards that came with your system. With this tool, you can 
import QDF and DST standards files and track expiration dates, serial numbers, and more.
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❖    To add a qualified standard

 1. Using the Desktop view, go to the Configure menu and select Qualification Standards.

 

 2. Select Import Qualification Standards. 

 3. Click Browse and select either a QDF or DST standards file. Select Open to load the data from the standard.

 4. Select a value from the Expires list to choose when the standard should expire, in years. Notice that the Expiration Date 
updates to match the Expires value.

 5. Select Save Qualification Standard. Once you save, the standard is committed, and you cannot edit or delete it. If you 
want to change the expiration date, you must re-import the standard and save it again. This adds a standard with a new 
expiration date, but it does not replace or remove the first standard.

 6. Close the dialog. The new standards are viewable in the table.

Tip Click the column headings to sort the table. For example, click the Expiration Date heading to order the standards by 
how soon they expire.
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3. Tutorials and Walkthroughs
The tutorials in this section guide you through some of the most common techniques used with OMNIC Paradigm software, 
including identifying, quantifying, and verifying samples as well as creating and running a workflow to automate your most 
common tasks. 

These tutorials are intended to be as accessible as possible for those new to OMNIC Paradigm software. If you prefer to get 
started on your own, see "Measure the Background" to start measuring your samples. If you prefer a more conceptual 
overview, see "Key Concepts and Features".

In this section: 

3.1 Identify an Unknown Sample with ATR 40

3.2 Identify an Unknown Sample with Transmission 51

3.3 Verify Sample Composition with QCheck 64

3.4 Quantify Sample Composition 68

3.5 Create and Run Your First Workflow 72

3.1 Identify an Unknown Sample with ATR
Your FTIR spectrometer and OMNIC Paradigm software can help you determine what’s in an unknown sample. This article 
demonstrates how to measure and analyze a sample using the Attenuated Total Reflection, or ATR, sampling technique. It 
is a common and “mess-free” technique for acquiring FTIR data from a sample material. This article includes a number of 
examples to help you build confidence in interpreting your analysis results.

You will learn how to:

 l Prepare the ATR accessory

 l Set up and run the analysis, and

 l Evaluate and confirm the results

Follow these instructions to measure and analyze an unknown pure sample using the ATR sampling technique.
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3.1.1 Prepare the ATR Accessory

To begin, make sure your ATR accessory is inserted in the spectrometer sample compartment and that it has an 
appropriate crystal installed. Each crystal material provides some kind of sampling advantage such as a wider spectral 
range, a higher energy throughput, or more durability. The correct choice depends on what crystals are available, which one 
works best with your sample material, and which one produces the needed information. See the information that came with 
your ATR accessory for more information.

Here is the Thermo Scientific™ Everest ATR accessory with a diamond crystal installed in our Nicolet™ Summit FTIR 
spectrometer.

Make sure the crystal is clean so the spectrometer can take an accurate background measurement when it’s ready. To 
clean the crystal, dab it with a soft cloth. If the crystal requires more rigorous cleaning, check the user guide that came with 
your ATR accessory. The guide should list appropriate cleaning solvents for each crystal type.

3.1.2 Set Up the Analysis

The next step is to set up the OMNIC Paradigm software. After you open the software, you see the dashboard in the main 
window. The important measurement settings are at the top.
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First, make sure the Sampling Accessory readout shows the installed accessory. If it doesn’t, reseat the accessory. Notice 
that the factory presets for that accessory appear under “Settings.”

Then enter a measurement name, or you can leave the suggested name, which is the exact date and time of the 
measurement.

Next make sure the Analysis Type is set to Search. This performs a point-by-point comparison of the sample spectrum 
against FTIR library spectra. The quality of the output depends on the source and quality of the spectra in the selected 
libraries.

Finally, check the acquisition settings (sample scans, resolution and final format). The settings shown above are all good 
starting values for this analysis.

It’s important to note that the quality of the sample data you acquire will affect the analysis results. For example, speeding 
up the analysis by measuring fewer scans, or decreasing the resolution could lead to a less certain analysis result.

3.1.3 Consider Your Spectral Libraries

All existing spectral libraries are selected automatically by default. Choose Search Setup in the Identify menu to view or 
change your library selections.
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For this demonstration, we are using the free libraries provided with OMNIC Paradigm software.

Choose Cancel to close the Search Setup window.

You can also use the Library Manager in the same menu to easily create a spectral library. Any libraries you create should 
be from pure materials that represent what you expect to find in your unknown samples.

The library spectra are normally the same quality or higher quality than the sample spectrum. It is also helpful if they are 
acquired using the same sampling technique (ATR in this case). If your library spectra were acquired using the transmission 
technique, OMNIC Paradigm software has a correction that can be applied to the sample spectrum to improve the results. 
You’ll learn more about that later in this article.

There is no need to perform conversions such as final format, resolution or spectral range on the sample data before 
performing a search—the software does that for you.

3.1.4 Measure and Analyze the Sample

To start the analysis, click Preview and Measure Sample.
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The analysis starts with a background measurement. The only requirement for an ATR background is to make sure the 
crystal is clean. The background spectrum is used to eliminate any signals in the sample data that are due to the 
spectrometer, the ATR crystal, or the background environment.

The software shows a preview of the current background spectrum in the spectral pane. The background shape shown 
below is typical for a diamond crystal.

Click Start Background Measurement.

When the background measurement is completed, its image appears in the results panel and in the spectral pane.
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If your sample is a liquid, raise the pressure tower and rotate it out of the way. Use a clean pipette to place a single drop on 
the crystal. Keep in mind that crystal types vary in size and some may require more sample. Use just enough sample to 
cover the crystal completely.

Figure 3-1: Measure a liquid with ATR

For a solid sample, rotate the knob on the pressure tower counterclockwise to raise the arm. Then place the sample on the 
crystal and rotate the knob clockwise to lower the arm. Continue to rotate the knob until clicks. For this demonstration, we 
are measuring a plastic card.
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Figure 3-2: Measure a solid with ATR

Once a sample is in place, click Preview Sample to preview the sample data in the spectral pane. If the peaks in the 
preview spectrum are very small, use a more concentrated liquid sample. If you are measuring a solid, reposition the 
sample on the ATR crystal and reapply pressure.

If the spectrum has no sample peaks, check that the sample material absorbs energy in the infrared region of the light 
spectrum. If you observe extra peaks in the spectrum, make sure the crystal is clean.

When you are ready to continue, choose Start Sample Measurement (see the previous image) and wait for the progress 
bar to complete. The software quickly compares the sample spectrum to the selected library spectra and shows you the 
results.

3.1.5 What’s in My Sample?

The spectral pane shows the sample spectrum along with the best matched spectrum from the selected libraries. The two 
spectra are overlaid with the same Y-axis scale so you can compare the results visually. (If the spectra are very similar, as in 
this case, there are other views that will highlight the differences. We’ll talk more about that later.) The results panel shows a 
list of the 5 best matched spectra, along with their match values.
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Figure 3-3: Sample and top search result displayed together using the same Y-axis scale

1. Sample spectrum (red)

2. Best match (yellow)

3. Results panel

The match values tell you how well each library spectrum matches the unknown sample. The closer this value is to 100, the 
better the match.

In this example, the top match has a match value that is above 90, which indicates a good match. The match value for the 
next spectrum in the list is well below that.
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Figure 3-4: Match values showing a clear best match

If we look at the overlaid spectra in the spectral pane, the positions of the main peaks line up along the X-axis, and they 
differ only in their peak heights.

Figure 3-5: Overlaid spectra showing a clear match

Click the Stack button to see the two spectra scaled to fill each Y-axis. Again, the spectra are well matched except for the 
slightly raised baseline in the sample spectrum’s low frequency region. As a result, we can conclude that the sample is 
polyethylene and the analysis is complete.
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Figure 3-6: Stacked spectra showing a minor difference in the low frequency region

To get more information about a spectrum in the match list, including the library it came from and its identification number, 
hover over the spectrum’s grey arrow in the results panel.

Figure 3-7: Information button for a library spectrum

3.1.6 What if there isn’t a clear (single) match?

If the analysis results show several matches that all have similar match values, as in this example, Shift + click the three 
matches in the results panel to add all three spectra to the spectral pane.
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Figure 3-8: Stacked spectra showing several similar matches

3.1.7 How can I improve my analysis results?

If no clear match appears, there are a number of options to consider that may improve your results. (Some setting 
adjustments will require a new background measurement.)

Figure 3-9: Search results with changeable measurement settings displayed
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For starters, you can return to the dashboard and adjust the Resolution setting for the unknown sample. For example, you 
can acquire the spectrum at a higher resolution by using a lower Resolution setting. If the sample peaks are sharper or more 
numerous, you may get a better analysis result.

You can also acquire more scans (see image above) to reduce spectral noise, which can also affect the results. Then restart 
the analysis by choosing Identify (menu) > Correlation Search or click the Search button on the toolbar.

If the sample spectrum has a tilted or curved baseline, try applying Automatic Baseline Correction (Process menu) to your 
sample spectrum and then restart the analysis.

If you need to search against transmission spectra, try using the Advanced ATR Correction (Process menu) and then repeat 
the analysis. This correction adjusts an ATR spectrum so that it looks more like a transmission spectrum, which can improve 
the results.

3.1.8 How to Specify the Spectral Region for the Analysis

If your sample spectrum has a peak that is so large it is off the Y-axis scale, you may want to exclude that peak from your 
analysis. Here is an example:

Figure 3-10: Example of a totally absorbing peak

These “flat topped” peaks are referred to as “totally absorbing” and can contain excessive spectral noise, which affects the 
analysis results. To exclude a totally absorbing peak, open the search settings, de-select Use full spectral range, and 
specify the regions to search that exclude the totally absorbing region. 

3.2 Identify an Unknown Sample with 

Transmission
Your FTIR spectrometer and Thermo Scientific™ OMNIC Paradigm software can help you identify the chemical composition 
of an unknown sample. This article demonstrates how to measure and analyze a sample using infrared transmission. By 
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“transmission” we mean that the infrared beam passes directly through the sample. Transmission is a common technique 
for acquiring FTIR data. This article includes a number of examples to help you build confidence in interpreting your analysis 
results.

You will learn how to:

 l Prepare the transmission accessory

 l Set up and run the analysis, and

 l Evaluate and confirm the results

3.2.1 Prepare the Transmission Accessory

To begin, make sure your transmission accessory or sample holder is inserted in the spectrometer sample compartment. 
Here is the Thermo Scientific™ iD1 Transmission Accessory in our Nicolet™ Summit FTIR Spectrometer.

Remove any sample from your accessory or sample holder so the spectrometer can take an accurate background 
measurement when it’s ready. The iD1 accessory cover can be open or closed. (If your transmission accessory is purged 
with dry air or nitrogen, keep the cover closed unless you are adding or removing a sample.)

3.2.2 Set Up the Analysis

The next step is to set up the OMNIC Paradigm software. After you open the software, you see the dashboard in the main 
window. The important measurement settings are at the top.
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First, make sure the Sampling Accessory readout shows the installed accessory. If it doesn’t, reseat the accessory. Notice 
that the factory presets for that accessory appear under “Settings.”

Then enter a measurement name, or you can leave the suggested name, which is the exact date and time of the 
measurement.

Next make sure the Analysis Type is set to Search.

This performs a point-by-point comparison of the sample spectrum against FTIR library spectra. The quality of the output 
depends on the source and quality of the spectra in the selected libraries.

Finally, check the acquisition settings (sample scans, resolution and final format). The settings shown above are all good 
starting values for this analysis.

It’s important to note that the quality of the sample data you acquire will affect the analysis results. For example, speeding 
up the analysis by measuring fewer scans, or decreasing the resolution could lead to a less certain analysis result.

3.2.3 Consider Your Spectral Libraries

All existing spectral libraries are selected automatically by default. Choose Search Setup in the Identify menu to view or 
change your library selections. For this demonstration, we are using the free libraries provided with OMNIC Paradigm 
software and the Nicolet Summit Pro spectrometer.
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Choose Cancel to close the Search Setup window.

You can also use the Library Manager in the same menu to easily create a spectral library. Any libraries you create should 
be from pure materials that represent what you expect to find in your unknown samples.

The library spectra are normally the same quality or higher quality than the sample spectrum. It is also helpful if they are 
acquired using the same sampling technique (transmission in this case). There is no need to perform conversions such as 
final format, resolution or spectral range on the sample data before performing a search—the software does that for you.

3.2.4 Measure and Analyze the Sample

To start the analysis, click Preview and Measure Sample.
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The analysis starts with a background measurement. The only requirement for a transmission background is to remove any 
sample from the path of the infrared beam. The background spectrum is used to eliminate any signals in the sample data 
that are due to the spectrometer, your transmission accessory or sample holder, or the background environment.

The software shows a preview of the current background spectrum in the spectral pane. The examples below show typical 
background spectra for transmission analysis using a transmission accessory that has not been purged with dry air or 
nitrogen, and one that has been purged.

Figure 3-1: Background spectrum from a transmission accessory that has not been purged

 

Figure 3-2: Background spectrum from a transmission accessory that has been purged
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Click Start Background Measurement.

When the background measurement is completed, its image appears in the results panel and in the spectral pane.

To install a mounted film sample, open the cover for the transmission accessory and slide your sample or sample holder into 
a slot that best fits the sample or sample holder width. If your sample or holder allows it, choose a slot that is close to the 
beam’s focal point (for the iD1 accessory, this is roughly in the center of the sample compartment). For this demonstration, 
we are measuring a plastic film mounted on a sample card.

Figure 3-3: iD1 Transmission Accessory beam focal point
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Once a sample is in place, click Preview Sample to preview the sample data in the spectral pane.

If the peaks in the preview spectrum are very small, try using a thicker sample. If the spectrum has no sample peaks, check 
that the sample material transmits energy in the infrared spectrum.

57 OMNIC Paradigm Software User Guide Thermo Scientific



When you are ready to continue, choose Start Sample Measurement (see the previous image) and wait for the progress 
bar to complete. The software quickly compares the sample spectrum to the selected library spectra and shows you the 
results.

3.2.5 What’s in My Sample?

The spectral pane shows the sample spectrum along with the best matched spectrum from the selected libraries. The two 
spectra are overlaid with the same Y-axis scale so you can compare the results visually. (If the spectra are very similar, as in 
this case, there are other views that will highlight the differences. We’ll talk more about that later.) The results panel shows a 
list of the 5 best matched spectra, along with their match values.

Figure 3-4: Sample and top search result displayed together using the same Y-axis scale

1. Sample spectrum (red)

2. Best match (blue)

3. Results panel

The match values tell you how well each library spectrum matches the unknown sample. The closer this value is to 100, the 
better the match.

In this example, the top match has a match value that is above 85, which indicates a good match. The match value for the 
next spectrum in the list is well below that.
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Figure 3-5: Match values showing a clear match

If we look at the overlaid spectra in the spectral pane, the positions of the main peaks line up along the X-axis, and they 
differ only in their peak heights.

Figure 3-6: Overlaid spectra showing a clear match

Click the Stack button to see the two spectra scaled to fill each Y-axis. Again, the spectra are well matched except for the 
slightly raised baseline in the sample spectrum’s low frequency region. As a result, we can conclude that the sample is 
polyethylene and the analysis is complete.

59 OMNIC Paradigm Software User Guide Thermo Scientific



Figure 3-7: Stacked spectra showing a clear match

To get more information about a spectrum in the match list, including the library it came from and its identification number, 
hover over the spectrum’s grey arrow in the results panel.

Figure 3-8: Information button for a library spectrum

3.2.6 What if there isn’t a clear (single) match?

If the analysis results show several matches that all have similar match values, as in this example, Shift + click the three 
matches in the results panel to add all three spectra to the spectral pane for a detailed comparison.
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Figure 3-9: Stacked spectra showing several similar matches

3.2.7 How can I improve my analysis results?

If no clear match appears, there are a number of options to consider that may improve your results. (Some setting 
adjustments will require a new background measurement.)

For starters, you can return to the dashboard and adjust the Resolution setting for the unknown sample. For example, you 
can acquire the spectrum at a higher resolution by using a lower Resolution setting. If the sample peaks are sharper or more 
numerous, you may get a better analysis result. You can also acquire more scans to reduce spectral noise, which can also 
affect the results. 

If the sample spectrum has a tilted or curved baseline, try applying Automatic Baseline Correction (Process menu) to your 
sample spectrum. Then restart the analysis by choosing Identify (menu) > Correlation Search, or click the Search button 
on the toolbar.

3.2.8 How to Specify the Spectral Region for the Analysis

If your sample spectrum has a peak that is so large it is off the Y-axis scale, you may want to exclude that peak from your 
analysis. Here is an example:
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Figure 3-10: Example of a totally absorbing peak

These “flat topped” peaks are referred to as “totally absorbing” and can contain excessive spectral noise, which affects the 
analysis results.

To exclude a totally absorbing peak, choose Identify (menu) > Search Setup and use the tools to select the regions to 
search.

First, clear the “Use Full Spectral Range” check box to enable the region tools.
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Figure 3-11: Tools for selecting the regions to search

Then position the vertical bars to select the first region to search.

To add a search region, click the Add button and use the second set of vertical bars to select the next region. Here we used 
the first set of vertical bars to select the region to the left of the fully-absorbing peak. And then we added a region and used 
the second set of vertical bars to select the region to the right of the fully-absorbing peak.
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When you are finished selecting regions, click Save to return to the Dashboard view, and then click the Search button on 
the toolbar to re-run the search.

3.3 Verify Sample Composition with QCheck
Verify your sample quality with a QCheck analysis. With QCheck, your sample is compared to a known reference, and the 
results report a correlation value between your sample and the reference, giving you quick verification that your sample 
meets your specifications. 

This guide walks you through an example QCheck analysis. 

Prerequisites

This guide assumes that you have already set up your instrument and sampling accessory. For instructions on installing a 
sampling accessory, see the documentation that came with your instrument.

You will also need at least one spectrum to use as a reference. You can specify any spectrum in your database as the 
reference spectrum. To use a spectrum from a library, first extract the spectrum from the library so that it is available in the 
database. For details, see "Extract a Spectrum from a Library"

3.3.1 Performing a QCheck Analysis

Running a QCheck analysis requires you to set up your analysis and measurement settings, measure the background, 
measure your sample, and interpret your results. Finally, when your analysis is complete, you can create and save a report.

❖    To verify your sample composition with QCheck

 1. Set up the analysis.

Before measuring your sample, review your analysis settings.

 a. Navigate to Identify > QCheck Setup.

 b. Review the QCheck Setup options.
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Setting Description

High 
Sensitivity

Select high sensitivity for more exact results between a sample that is very similar to the reference. You may want to 
de-select high sensitivity if you are measuring samples with some natural variation.

Pass/fail 
threshold

Set a threshold for pass or failure. Enter an integer between 0 and 100. 

A correlation value of 100 indicates a perfect match.

If you de-select this option, all results will show Pass.

Maximum 
spectra in 
QCheck 
results

Sets the number of results shown in the results panel. For example, if you set the value to 2, only the two best matches 
will be shown in the results panel.

Prompt for 
reference

Select to choose a reference during the measurement. De-select to specify one or more reference spectra in advance. 
If you are planning to compare several samples to the same references, it is convenient to set them in advance to avoid 
having to keep selecting the same reference every time you measure a sample.

Blank 
diamond ATR 
region (2200 - 
1955)

Select to exclude data in the region from 2200 wavenumbers to 1955 wavenumbers, where diamond ATR crystals 
absorb radiation.

Blank CO2 
region (2390 - 
2240)

Select to exclude data in the region from 2390 wavenumbers to 2240 wavenumbers, where carbon dioxide absorbs 
radiation.
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Setting Description

Use full 
spectral 
range

Select to use the full range in the analysis.

De-select to specify only a limited range to use for the analysis.

 c. To save your settings and return to the dashboard, click Save.

 d. On the dashboard, review your measurement settings, and confirm that the listed sampling accessory matches the 
accessory you are using.

 e. From the Analysis Type list, select QCheck.

Once you are satisfied with your measurement and analysis settings, you are ready to measure the background.

 2. Measure the background.

Before measuring your sample, you need to have a current measurement of the background.

The background spectrum is used to eliminate any signals in the sample data that are due to the spectrometer, the 
sampling accessory, or the background environment.

 a. Click Preview and Measure Background.

 b. Click Start Background Measurement. When the background measurement is complete, the spectrum is added 
to the results panel.

 3. Measure your sample.

 a. Load your sample. For instructions on loading a sample, see the documentation that came with your instrument or 
sampling accessory.

 b. Click Preview Sample. The Sample Preview displays a live preview of your sample spectrum. The preview gives 
you the opportunity to correct any potential issues before measuring the sample. 

 c. When you are ready to continue, click Start Sample Measurement.

If Prompt for Reference is selected in your analysis settings, the Select Reference Spectrum dialog opens after the 
measurement is complete.

 d. Select one or more reference spectra to use in the analysis and click OK. 

Hold Ctrl and click to add a spectrum to your selection. 

Hold Shift and click to add a group of spectra to the selection.

 4. Interpret your results.

When the measurement and analysis are complete, your results are displayed in the results panel. Hover over the gray 
arrow for additional details.
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 5. Create a report

When you are finished with your analysis, create a report to export your results to Microsoft™ Word™, PowerPoint™ or 
Excel™ or to print or save your results. 

 a. Navigate to File > Create Report.

 b. Give your report a title.

 c. Select a format from the Format list and choose the QCheck template. A preview of the report is shown in the right 
panel.

 d. Click Create.
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3.3.2 Improving Your Results

If your correlation value is lower than expected, there are several options to consider that may improve your results. 

 l Return to the dashboard and adjust the Resolution settings for your measurement. For example, you can measure the 
sample at a higher resolution by selecting a smaller value, such as 1 or 2. If the sample peaks are sharper or more 
numerous, you may get a more accurate analysis result.

 l Increase the number of scans in your measurement, which may reduce spectral noise.

 l If the sample spectrum has a tilted or curved baseline, try applying Automatic Baseline Correction to your sample and 
then restart the analysis from the Identify menu.

 l Exclude selected regions from the analysis. If your sample spectrum has a peak that is so large it is off the Y-axis scale, 
you may want to exclude that peak from your analysis. These “flat topped” peaks are referred to as “totally absorbing” 
and may affect the analysis results. Open QCheck Setup, de-select Use Full Spectral Range, and select ranges that 
exclude the sample spectrum’s totally absorbing peak. Then, rerun the QCheck analysis.

3.3.3 Extract a Spectrum from a Library

Extract a spectrum from a library to use it as a reference in a QCheck analysis. Spectra extracted from commercial libraries 
can be used for analysis, but cannot be renamed, tagged, or exported.

❖    To extract a spectrum from a library

 1. From the dashboard of the desktop interface of OMNIC Paradigm software, navigate to Identify > Library Manager.

 2. Select a compound to extract.

 3. Click Extract. A confirmation message states that the spectrum was successfully extracted. 

3.3.4 Next Steps

In this guide, you set up and ran a QCheck analysis to verify that your sample matched a known reference within a pre-set 
threshold. 

Next, see "Create and Run Your First Workflow" for a guided tutorial on using workflows to create routine, repeatable 
procedures.

3.4 Quantify Sample Composition
Find the concentrations of components in your sample using a Quantify analysis. A Quantify analysis uses a previously 
created quantitative analysis method and reports the concentration of components in the sample or other kind of 
information, such as peak height or match value. 

This guide walks you through setting up and running a Quantify analysis using the desktop interface of OMNIC Paradigm 
software.
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Prerequisites

This guide assumes that you have already set up your instrument and sampling accessory. For instructions on installing a 
sampling accessory, see the documentation that came with your instrument.

You will also need a valid quantification method saved as a QNT file. The quantitative analysis method must be calibrated 
using Thermo Scientific TQ Analyst software. See the documentation that came with that software for information on 
calibrating quantitative analysis methods.

3.4.1 Performing a Quantify Analysis

Running a Quantify analysis requires you to import a QNT file, review your measurement settings, measure the 
background, and finally measure your sample. When analysis is complete, you can create a report to save or share your 
results.

❖    To perform a Quantify analysis

 1. Set up the analysis.

 a. On the dashboard of the desktop interface of OMNIC Paradigm software, confirm that the settings display your 
sampling accessory.

 b. Navigate to Identify > Quantify Setup and browse to the QNT file you would like to use in the analysis.

The file explorer displays additional information about the QNT file that you have selected, such as the method 
title, method type, and whether the method has been calibrated.

 c. To import the method, click Open.

 d. In the Analysis type list, select Quantify. A symbol indicates that you have imported a valid QNT file. A red circle 

with an X [ ] indicates that a valid method has not been imported. 

When selecting a QNT file, the file explorer displays additional information to help you make a selection, including 
the method title and type and whether the method has been calibrated. Only methods that have been calibrated 
with TQ Analyst software are valid.
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 2. Measure the background.

Before measuring your sample, you need to have a current measurement of the background.

The background spectrum is used to eliminate any signals in the sample data that are due to the spectrometer, the 
sampling accessory, or the background environment.

 a. Click Preview and Measure Background.

 b. Click Start Background Measurement. When the background measurement is complete, the spectrum is added 
to the results panel.

 3. Measure the sample.

 a. Load your sample. For instructions on loading a sample, see the documentation that came with your instrument or 
sampling accessory.

 b. Click Preview Sample. The Sample Preview displays a live preview of your sample spectrum. The preview gives 
you the opportunity to correct any potential issues before measuring the sample. 

 c. When you are ready to continue, click Start Sample Measurement.

 4. Interpret your results.

When the sample measurement is complete, the Quantify dialog box displays results of the analysis. The results 
shown depend on the settings in the quantitative analysis method used in the analysis. The results shown below show 
a measurement only result indicating a passing value.
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After clicking OK to close the Quantify dialog box, you can view the analysis results by clicking the information icon [

] next to the spectrum in the results panel. In the Spectrum Information dialog, navigate to the History tab and see 
the Quantify Results section.

 5. Create a report

When you are finished with your analysis, create a report to export your results to Microsoft™ Word™, PowerPoint™ or 
Excel™ or to print or save your results. 

 a. Navigate to File > Create Report.

 b. Give your report a title.

 c. Select a format from the Format list and choose the Quantify template. A preview of the report is shown in the right 
panel.

 d. Click Create.

3.4.2 Improving Your Results

If your results are unclear or problematic, there are several options to consider that may improve your data. 

 l Return to the dashboard and adjust the Resolution settings for your measurement. For example, you can measure the 
sample at a higher resolution by selecting a smaller value, such as 1 or 2. If the sample peaks are sharper or more 
numerous, you may get a more accurate analysis result.

 l Increase the number of scans in your measurement, which may reduce spectral noise.

 l If the sample spectrum has a tilted or curved baseline, try applying Automatic Baseline Correction to your sample and 
then restart the analysis from the Identify menu.

3.4.3 Next Steps

In this guide, you set up and ran a Quantify analysis.
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Next, see "Create and Run Your First Workflow" for a guided tutorial on using workflows to create routine, repeatable 
procedures.

3.5 Create and Run Your First Workflow
This tutorial explains a simple way to create workflows in OMNIC Paradigm software. For basic information about workflows 
and brief descriptions of the workflow features and editing tools, see the article titled “About Workflows” in the OMNIC 
Paradigm online help.

Note The software operations to create workflows are available only in the desktop version of OMNIC Paradigm 
software (not the touchscreen version).

There are several ways to create workflows. Some approaches may work better than the others, depending on the steps 
you are trying to automate and how you want to start. For example, you can create a new workflow by:

 l building a workflow from scratch

 l editing a workflow that someone gave you

 l duplicating an example workflow provided with the software

 l performing the measurement tasks you want to automate and letting the software create the workflow from the spec-
trum’s history information

This article shows how the software can create a workflow automatically based on the history of an acquired spectrum. It 
also demonstrates how to:

 l run a workflow from the workflow editor or dashboard

 l identify workflow generated spectra

 l edit a workflow by adding tiles, and

 l fix a common workflow error

The last section provides useful tips for creating and editing workflows.

3.5.1 Create a Workflow

❖    To create a new workflow from an acquired spectrum

 1. From the OMNIC Paradigm dashboard, acquire a spectrum of a sample material.

It doesn’t matter what kind of material or sampling technique you use. If the software requires a new background 
measurement, go ahead and do that first. When the sample measurement is completed, the sample spectrum is 
displayed in the spectral view.

Here is our example spectrum (plastic bag measured with an Attenuated Total Reflectance, or ATR, accessory) 
displayed in the spectral view:
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 2. Make sure the spectrum is selected in the spectral pane and then perform any processing or analysis steps you like (for 
example, subtraction, baseline correction, correlation search, etc.).

Here is our example spectrum after applying Advanced ATR Correction and Automatic Baseline Correction and then 
performing a Correlation Search.
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 3. Give your spectrum a descriptive name (the software will use this name for the created workflow as the default, or you 
can give the workflow a new name).

 a. Right click the image of the original spectrum in the results panel and choose Rename Spectrum.

 b. Replace the default name with a descriptive name for your workflow and choose OK. Here is our renamed 
example spectrum.
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 4. Once you have completed your processing and analysis steps, click the History button in the results panel.

The history panel shows all the tasks performed on the selected spectrum in the order in which they were performed. 
Here is the history information for our example spectrum.

75 OMNIC Paradigm Software User Guide Thermo Scientific



 5. At the bottom of the history panel, click Create Workflow.

The software creates a workflow that includes all of the steps you just performed. The workflow is displayed in the 
workflow editor. Each performed task is represented by a colorful tile. Depending on which steps you performed, your 
workflow may look different from our example below:
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 6. To save your new workflow, click the Save button on the toolbar.

 7. To run the workflow, click the Run button on the toolbar.

The workflow performs the same tasks you completed manually in exactly the same sequence. In our case, we 
measured a spectrum, performed an Advanced ATR Correction, corrected the spectral baseline, and performed a 
correlation search.

When the workflow is done, the software returns to the Workflow Editor.

 8. Click the Dashboard button on the toolbar to see your newly created workflow in the Workflows list.

The workflow is named automatically based on the name of the spectrum used to create it. Here is our newly created 
example workflow in the Workflows list and a preview of the workflow in the preview box.
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 9. The workflow-generated spectra appear in the Measurements list.
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Our example workflow created four spectra, the measured background spectrum, the measured sample spectrum, the 
ATR corrected sample spectrum, and the ATR and baseline corrected sample spectrum with the search results. The 
workflow-generated spectra are named with the Tile Name properties of their associated workflow tiles.

3.5.2 Add Tiles to a Workflow

This section demonstrates how to use the workflow editing tools to add tiles to your auto-generated workflows.

 1. From the dashboard, right-click the workflow name and choose Edit.

The workflow opens in the workflow editor.
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 2. Add a Tag Spectrum tile to the workflow.

Workflow-generated spectra are saved in the OMNIC Paradigm database along with any data acquired manually. Let’s 
tag the workflow spectra to associate them with our workflow. This makes it easy to open and view them later.

 a. In the workflow editor, drag the Tag Measurement tile from the selection 
bar to the canvas so that your mouse cursor hovers over the grey arrow  between 
the Measurement and ATR Correction tiles.

The grey arrow changes to a plus sign.
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 b. Release the mouse button.

The tile is added to that location in the workflow and its settings box is opened below the canvas.
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 c. In the Tag Settings enter a base name for your workflow-generated spectra, such as “ATR Search Spectra”, make 
sure Select Spectrum is set to your measured spectrum (“Measurement - Sample”), and choose OK.

The Tag Measurement tile will automatically add the “ATR Search Spectra” tag to each spectrum generated by the 
workflow. We’ll explain how to search for those spectra later.

Now let’s explore what happens when we add a tile that flags an error.

 3. Add a Report Template tile to the workflow.

 a. In the workflow editor, use the mouse to hover over the grey arrow between the Search and End tiles (arrow 
changes to a plus (+) sign) and then click the mouse button. The software opens the Add Tile box. (This is another 
easy way to add tiles.)
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 b. In the Add Tile box, select the Template Report and choose OK.

The tile is added to that location in the workflow and its settings box is opened below the canvas.
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Notice that the Report Template tile has a red border, which indicates the workflow won’t run successfully right 
now. If we view the Report Template settings, the boxes are all blank.

To fix the problem, we need to specify a template for the report and which results to include.

 c. Set Template Type to your preferred report style (we are using the Search Results template), set Search Results 
To Display to your workflow’s output (“Search Result” in our example) and choose OK.
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Notice that the red border is no longer there.

 4. To save the updated workflow, click the Save button on the toolbar.

 5. To run the workflow, click the Run button on the toolbar.

The workflow runs through all the steps and then displays the final report.

Click the arrow button to end the workflow.
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 6. Click the Dashboard button on the toolbar to return to the dashboard.

 7. If you select the workflow in the Workflows list, the preview has been updated.
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 8. If you enter your tag in the Search box, the software shows you the workflow-generated spectra in the Measurements 
list.
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To view the spectra in the spectral pane, use Shift + Click to select all four in the Measurements list, then right-click and 
choose “Open Selected Measurements.”

 9. To see the workflow-generated report, click this arrow button and select “Reports.”

3.5.3 Tips on Creating Workflows

Before you head off to create more workflows, read through these answers to common questions about workflows and tips 
for solving any problems that may occur.

 l Is the order in which the tiles appear in the workflow important? Yes, the order of the tiles is important. Each work-
flow tile builds on the previous tiles, and all the tiles are interconnected by their input requirements and their output res-
ults. For example, if you add a Measure tile, it creates an output result (a spectrum), which can only be accessed by 
tiles positioned after the Measure tile in the workflow. If you want to correct the baseline of an acquired spectrum, you 
would need to add a Processing tile after the Measure tile, and then set the Processing tile input to the Measurement 
output (i.e., the spectrum). Otherwise, the Processing tile will have a red border, indicating it contains options that must 
be set before the workflow will run. If you see a tile that has a red border, use the mouse to hover over that tile for help 
finding the source of the problem.

 l Do I need to add a background measurement to my workflow? Not unless you want the workflow to perform an oper-
ation only on the background spectrum. If you only need a background spectrum in order to process your measured 
sample data, then you just need to add a Measure tile to the workflow and use the Measure tile settings to define the 
background measurement.
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 l Can I change the titles of the workflow tiles? Each workflow tile has a setting that specifies the tile name. (Double-
click the tile in the workflow editor to open its associated settings.) The Tile Name setting can be used to add detail to 
your workflow. This can help the workflow developer keep things organized, especially when creating workflows that 
contain multiple paths or loops, or multiple tiles of the same type (several Measure tiles, for example, in the same work-
flow).

The tile names may also be used to name output files when the workflow is run. Here are some examples:

 n Measure tile. This tile acquires background and sample spectra. When the workflow is run, the sample spectrum 
is saved with the tile name of its associated Measure tile.

 n ATR Correction Tile, Process Tile, etc.. Tiles that operate on acquired spectra generate output spectra that are 
saved along with the final sample spectrum when the workflow is run. Each interim “processed” spectrum is saved 
with the tile name of the workflow tile that generated it.

 n Report tile. This tile creates a sample report. When the workflow is run, the report is saved with the tile name of its 
associated Report tile.

 l Should every workflow have an Export tile? The answer to this question is “no.” Any spectra and reports generated 
from a workflow are saved automatically in the OMNIC Paradigm database, along with all the other spectra and reports 
that are created manually with the spectrometer (that is, not from a workflow). If you want to save your workflow-gen-
erated spectra and reports as files that can be archived or opened elsewhere (from your OMNIC Paradigm workstation 
software, for example), use an Export tile to create those files automatically.

 l Why doesn’t my workflow run? Before you run a newly created workflow, ensure there are no tiles with a red border. 
Here is an example:
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The workflow will not run to completion if it contains a tile with a red border.

If your workflow has a red bordered tile, use the mouse to hover over the tile for tips on how to solve the problem. 
Typically, the red border indicates the tile contains required options that have not been set. However, it can also mean 
the tile is “illegal.” For example, if you place a Processing tile before a Measure tile in a workflow, the Processing tile will 
have a red border and the workflow will contain an unresolvable error because there is no output spectrum to baseline 
correct.
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4.1 Manage your data
OMNIC Paradigm software includes tools to simplify finding and managing your data, including measurements, reports, and 
sessions. 

4.1.1 Manage Spectral Libraries

Libraries contain lists of compounds and related information and can be purchased or created from your own data. When 
you perform a correlation or multi-component search, the analysis compares your sample spectrum to compounds stored in 
the libraries you specify in your search settings.

Use the library manager to view information about your libraries and stored compounds and to create or delete libraries.

Create a New Library

Create a new library to manage your spectral data and to search against your own measured data.

❖    To create a new library in the desktop interface

 1. From the menu bar, select Identify > Library Manager.

 2. In the Library Manager, select New Library. 

 3. Enter a name for the library and add any optional fields.
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Optional fields are used when you add spectra to a library. 

Figure 4-1: Name your library and customize optional fields in the New Library view.

 4. Click Save to create the new library.

Your new library is listed in the Libraries column of the library manager.

❖    To create a new library in the touchscreen interface

 1. From the home screen, open the menu [ ] and select Library Manager. 

 2. Select New Library from the toolbar. 

 3. In the New Library view, enter a name for the library and add any optional fields.

Optional fields are used when you add spectra to a library. 

Figure 4-2: Name your library and customize optional fields in the New Library view.

 4. Touch Save to save your new library.

Add Spectra to a Library

Add spectra to a library to use your own sample data in other Search analyses.
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❖    To add spectra to a library in the desktop interface

 1. In the spectral view, select the spectrum you want to add to a library.

 a. a. To add more than one spectrum, select multiple spectra

 i. Right-click the main spectra view and choose Select All to select all visible spectra.

 ii. Hold CTRL and select spectra in the main spectra view to select more than one spectrum.

 2. From the menu bar, select Identify > Add to Library to open the Add to Library view.

 3. Select the library you want to add the spectrum to from the list of libraries.

 4. Make any adjustments to the spectrum information and set a name for the compound. The default name will be the 
measurement name used when the sample was measured.

 5. Click Save. Your spectrum is now available in the library, and you can view it in the library manager.

❖    To add spectra to a library in the touchscreen interface

 1. In the spectral view, select the spectrum to add to a library. Hold CTRL and select to add a spectrum to your selection.

 2. Select Add to Library from the menu.

 3. In the Add to Library view, select a library from the Libraries column.

 4. Name the compound, specify any optional fields and touch Save. The spectrum will now be available in your selected 
library.

Extract Spectra from Libraries

Extract spectra from libraries to use them as references in your analyses or workflows. Extracted spectra are stored with 
your measurements in the database, but cannot be renamed, tagged, or exported.

❖    To extract a spectrum from a library

 1. Navigate to Library Manager.

 2. Select a compound to extract.

 3. In the toolbar, select Extract. A message confirms that the spectrum has been extracted successfully. View your meas-
urements to find the extracted spectrum.

Delete Libraries and Compounds

When you delete a compound, that compound is no longer used in search analyses and is crossed out in the list of 
compounds. The index position of other compounds in the library is maintained.

You can delete or edit only the libraries that you have created. Commercial libraries and their compounds cannot be 
deleted.

Note Deleted libraries and compounds cannot be recovered. 
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❖    To delete a compound from a library

 l Using the Desktop interface

 1. In the Library Manager, navigate to the compound you want to delete.

 2. Right-click the compound and select Delete. In the dialog box, click Yes to confirm.

 l Using the Touchscreen interface

 1. In the Library Manager, select to the compound you want to delete.

 2. Touch Delete in the Spectrum pane.

❖    To delete a library

 l Using the Desktop interface

 1. In the Library Manager, select the library to be deleted.

 2. Click Delete in the toolbar, then click Yes to confirm.

 l Using the Touchscreen interface

 1. In the Library Manager, select the library to be deleted.

 2. Touch Delete in the main toolbar.

Add Library Locations

Use the Library Locations tab in Search Setup to specify additional library locations. This is useful if your libraries are stored 
in a shared location such as a network drive. After you add a location, you can use libraries in that location for Search, 
QCheck, and other analyses. 

❖    To add a library location

 1. Using the desktop interface, open the Identify menu and select Search Setup.

 2. Navigate to the Library Locations tab.

 3. Click Add Location.

 4. Browse to the location of the additional libraries and click Open.

 5. Click Save. 

4.1.2 Back Up and Restore a Database

Back up your database periodically to ensure that you can recover your data in the event of hard drive failure. With the 
database maintenance tools in OMNIC Paradigm software, you can easily backup and restore your data directly from the 
software. 
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Back Up Your Database

Back up your database on a separate device in case of hard drive failure. For example, back up the data on a separate 
computer or external hard drive or in a remote network location. 

❖    To back up your database

 1. Using the desktop interface of OMNIC Paradigm software, go to Configure > Database Maintenance and select Back 
Up.

 2. Select a backup location to save the backup database.

 3. To schedule backups, set a date and time for the first backup. 

 a. Ensure that Repeat is selected and choose a repeat option from the list.

 b. Click Save. 

 3. To back up the database manually without a schedule, click Back Up Now. 

To set a new backup location before backing up, first change the location and save your changes, then reopen the 
Database Maintenance - Back Up window and click Back Up Now. 

 4. Click Close to return to the dashboard. 

Notice: The database backup tool backs up only a portion of Session data. Session data contains two parts: a portion of the 
session is stored in the database and a portion of the session is saved in files on the disk drive. The database back up tool in 
OMNIC Paradigm software backs up only the data stored in the database. 

To ensure you can restore your data, you must use a separate backup utility program to back up the files stored in the 
following directory: C:\Users\Public\Documents\thermo scientific\omnic paradigm\Sessions

To back up Session data, use the database backup tool as normal and also use a separate backup utility program, such as 
the Backup and Restore tools in your operating system, to back up the files in  C:\Users\Public\Documents\thermo 
scientific\omnic paradigm\Sessions. 

To restore Session data, use your backup and restore utility to restore the files in the Sessions directory and then restore the 
database. 
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Restore a Database from a Backup

Use the Restore tool in OMNIC Paradigm software to restore your database from a previously saved backup. 

Note This action will permanently remove all data currently in your database and will replace it with data from the 
selected backup.

❖    To restore your database

 1. Using the desktop interface of OMNIC Paradigm software, go to Configure > Database Maintenance and select 
Restore.

 2. Click Browse and select the location of the backup database.

If you are using OMNIC Paradigm software on a Summit spectrometer and you are restoring from a remote backup that 
is shared with other spectrometers, you can restore data from any individual spectrometer that is using the backup.

To back up data from only a single spectrometer, select a spectrometer from the list of hostnames. 

 3. Click Confirm.

 

4.1.3 Delete Unwanted Measurements with Database Cleanup

Use Clean Up in Database Maintenance to automatically delete past measurements when they reach a specified age. For 
example, to save space on your system, you may want to automatically delete any measurements that have not been 
modified in more than one month.

To clean up the database, you can either set the length of time you want to keep measurements before they are 
automatically deleted or you can select Clean Up Measurements Now to remove any measurements already older than you 
like.

Once old measurements are deleted, they cannot be recovered.
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Tip To keep select measurements, add them to a library. In the future, you can extract them from the library and use 
them if needed.

❖    To automatically delete old measurements in the Desktop interface

 1. Using the desktop interface, go to Configure > Database Maintenance > Clean Up.

 2. Set how long you want to keep your measurements. 

Select Forever to keep your measurements.

 3. Click Save.

To immediately remove any measurements older than the set age, select Clean Up Measurements Now. 

❖    To automatically delete old measurements in the Touchscreen interface

 1. From the Home screen, select the Settings icon

 2. Go to the Database Maintenance tab.

 3. Select Clean Up.

 4. Set how long you want to save your measurements.

Select Forever to keep your measurements indefinitely.

 5. Select Save.

To immediately remove any measurements older than the set age, select Clean Up Measurements Now. 

Tip You can also delete all of your measurements at once. To delete all measurements, set the filter to show all 
measurements, select all the measurements, and right-click the measurements and select Delete Selected 
Measurements, or in the Touchscreen interface, select Delete.
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4.1.4 Finding Measurements and Reports

When looking for saved measurements and reports, use tags and search keywords to filter the measurements and reports 
lists.

Searching

When you search for a measurement, the search term is checked against information such as the spectrum tags, title, last 
modified date, identified compounds, custom strings, serial numbers, etc. If you search for a report, fields used for the 
search include report name, date created, and the template type.

Tip Click a column header, such as Measurement Name or Type, to sort the measurements. By default, measurements 
are sorted to show the most recently modified item first.

❖    To search for measurements and reports

 1. Select either Reports or Measurements from the list. 

 2. Select a time to limit the search results.

 3. Enter your search terms and click Search.

Use the following search techniques to refine your results. 

Search Technique Description Example

Quotation Marks (“”)

Use quotation marks to return only exact matches 
from the tags. This is useful if you are searching for 
a two-word tag and do not want to see spectra 
tagged with only one of the words. 

“red blue”

Returns: only spectra with the tag “red blue”. Does 
not return spectra with tags “red” or “blue” 
separately. 

* (asterisk)

Add an asterisk (*) to the end of your search terms 
to return all results that include the text preceding 
the asterisk

Note: The * can be appended to the end of the 
search terms but cannot come before other terms. 

Poly*

Returns: Any measurement with a term beginning 
with poly, such as polystyrene.

99 OMNIC Paradigm Software User Guide Thermo Scientific



Search Technique Description Example

AND, OR, NOT 
operators

These keywords must be in all capital letters, as 
shown. 

AND: Returns only results that contain both terms. 

OR: Returns results that contain either keyword.

NOT: Returns only results that contain the first term 
but do not include the term after NOT.

 

Sample AND Background

Returns: Only measurements that have both 
Sample and Background in the searched fields.

Sample OR Background

Returns: Measurements with either sample or 
background in the data are returned.

Sample NOT background

Returns: Measurements or reports that have 
sample in the data and do not have background in 
the terms.

title:<keyword>
Use to specify that the keyword must be in the 
measurement or report title.

title:poly

Returns: measurements with poly in their name, 
but those with poly elsewhere (such as identified 
compounds) are ignored. 

tags:<keyword>

Use to specify that the keyword must be a tag.

If the tag is two words, use an underscore instead of 
a space. 

tags:blue

tags:blue_powder

Returns: measurements with blue as a tag, but 
those with blue elsewhere (such as the 
measurement name) are ignored. “blue_powder” 
searches for the two word tag “blue powder”.

Tagging

Tags give you another convenient way to locate measurements and reports in your database. For example, if you are 
collecting many measurements related to a single project, you might tag each of those measurements with the same 
“Project A” tag. Later, you can use this tag to filter your measurements to show you only measurements with the “Project A” 
tag. 

❖    To add or delete a tag in the desktop interface 

 1. Right-click a measurement in the Measurements list and select Manage Tags. 

Tags currently assigned to the measurement are listed under Current Tags.

 l To add a new tag, enter text in the New Tag field and click Add. The new tag is added to the current tags.

 l To delete a current tag, click the delete icon ( )in the upper right corner of the tag. The tag is removed imme-
diately. 

 2. To save your changes, click OK. Click Cancel to exit the Manage Tags dialog without saving the changes.
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❖    To add or delete a tag in the touchscreen interface

 1. From the Home screen, navigate to the Measurements tab.

 2. Select a measurement and touch the more options icon.

 3. Touch Manage Tags.

 l To add a tag, enter text in the New Tag field and touch Add. The new tag is added to the current tags list. 

 l To delete a tag, touch the delete icon ( )in the upper right corner of the tag.

 4. To save your changes, touch OK. Touch Cancel to exit the Manage Tags dialog without saving the changes.

Filtering measurements by their signature status

Use Signature filters to quickly find measurements, reports, and sessions based on their signature status.

For example, the Signature filter is great for finding measurements that have been signed with an Authorship reason but that 
still need to be approved.

To filter your records based on the signature status

 1. From the dashboard of the Desktop interface, click Signature.

 2. Select your filter options and click Ok.

The dialog shows a list of all signature reasons. For each reason, you can select signed, unsigned, or N/A.

 l Signed: Select to show records signed with this reason. Any records signed with this reason are shown.

 l Unsigned: Select to show records that have not been signed with this reason. Any records with this signature are not 
shown.

 l N/A: Ignore this reason when filtering. Records with and without this signature are shown.

In this example, these settings will show all the records that still need to be approved.
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Tip Double-click the column heading ("Signed") to select that column for all options. Double-click again to reset all 
options to N/A.

Tip The Signature filter works with the time filter. For example, to see all measurements from the past month that need 
to be approved, set the time to Past Month and the signature filter for Approval to Unsigned.

Tip To sign multiple records at once, after you filter them, select all records, right-click, and select Sign.

4.1.5 View Measurement History

View the measurement history to visually compare a spectrum at different stages of processing and analysis. For example, 
after applying automatic baseline correction, view the measurement history to quickly see how the spectrum changed.

❖    To view the measurement history

 1. From the Spectral View, navigate to the history panel.

 2. Right-click any item in the history and select Measurement History.

The historical data displays the spectrum at each stage in your processing and analysis.

 l To create a report of the historical data, open the File menu and select Create Report. Select the Historical Spectrum 
template, edit your report settings, and click Create.

 l To exit the measurement history, click Close Measurement History.
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4.1.6 Revert Measurement

Use Revert to undo one or more steps when processing or analyzing a measurement. For example, if a processing step 
degraded the quality of your measurement data, instead of starting over and collecting a new sample measurement, use 
Revert to return to an earlier step.

When you revert to an earlier state, any actions taken after the step you are reverting to are lost. In other words, there is no 
way to undo a revert.

If you are in a secure environment, Revert is not available. However, you can instead use the Duplicate tool to create a copy 
of the measurement as it was at an earlier step. You can then work with the duplicated measurement without having to 
remeasure your sample. See "Duplicate Measurement" for details.

❖    To revert to an earlier step

 1. In the Spectral View, select your measurement from the results panel.

 2. Click the  icon to view the history panel.

Click any item in the history to preview the measurement at that stage.

 3. In the list of events, right-click the step you want to revert to.

 4. In the context menu, select Revert.

 5. Click Yes to revert or No to cancel.

4.1.7 Duplicate Measurement

Create a copy of a measurement by using Duplicate as New Measurement. You can duplicate a measurement from its 
current state or from an earlier step in its history.
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Tip Duplicate can be useful as an alternative to Revert. For example, while reverting discards the current data and 
returns the measurement to an earlier state, with Duplicate, you can copy the measurement from an earlier state and 
keep your current data. 

You might also use Duplicate to save a copy of your measurement at specific stages while you work. For example, you 
might duplicate your measurement immediately after collecting data to save a copy of the measurement without any 
further processing, and then work with only one copy of the measurement.

When you duplicate a measurement, not all of the measurement information is copied to the new measurement. Most 
information is duplicated, but there are some differences: 

 l If the original measurement has tags, the tags will not be copied to the new measurement.

 l The measurement history is copied, but the history panel in the spectral view does not display any steps prior to the 
point at which the measurement was duplicated. Open the Measurement Information and view the History tab to review 
the measurement history.

❖    To duplicate a measurement 

 l From the dashboard

Duplicate from the dashboard to copy the measurement in its current state.

 1. Right-click a measurement in the Measurements pane.

 2. Select Duplicate as New Measurement.

 3. Enter a name for the new measurement or keep the default name.

 4. Click OK.
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 l Duplicate from the measurement history

Duplicate from the Spectral View to copy the measurement from a previous point.

 1. In the Spectral View, select the measurement in the Results pane.

 2. With the measurement selected, navigate to the history panel.

Click any item in the history to preview the spectrum at that point.

 3. Right-click the step at which you want to duplicate the measurement.

Events that did not change the spectrum, such as Add to Library or Create Report, cannot be duplicated as a new 
measurement.

 4. Select Duplicate as New Measurement.

 5. Enter a name for the new measurement or keep the default name.

 6. Click OK.

 

4.2 Spectroscopy
This section describes core features in OMNIC Paradigm software.

4.2.1 Measure Samples

To acquire new data with OMNIC Paradigm software, set and save your measurement settings, collect a background 
spectrum, and finally measure the sample.

Set and Save Measurement Options

Measurement settings allow you to specify how your sample is measured and how the data is processed after the spectrum 
is collected. Your settings control both how the instrument and sampling accessory measure the sample and how OMNIC 
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Paradigm software processes the data.

After adjusting your measurement settings, you can use them immediately or save them for later use.

This guide describes how to set, save, and use common measurement options. For a discussion of advanced settings, see 
"Advanced Measurement Settings"

Set Measurement Options

Set and save your measurement settings or use previously saved settings before starting a measurement. 

In OMNIC Paradigm software for touchscreen, edit individual settings or import a settings file (.expx) before you measure 
your sample. To edit or review measurement settings, select an analysis type from the home screen.

Figure 4-1: Review measurement settings in the Summary, Details, and Background tabs

When using the desktop interface, set and save your measurement settings from the dashboard, or update a few options 
while previewing a sample spectrum.
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Figure 4-2: Edit measurement settings in the New Measurement pane.

The following table describes the settings you will use most frequently.

Option Description
Default 
Setting

Measurement 
name

The name of your sample data. This name will appear when you save or open this data and in any 
reports you generate. The default name is the date and time of collection.

Date and 
Time

Number of 
sample scans

How many times the sample is scanned during the measurement. The resulting data reflects the 
average of all the scans.

More scans will result in more accurate data but will take longer to measure.

10

Resolution 
(cm-1)

Like the resolution of a photo or video, a better resolution will mean finer detail in your spectral data. 
For example, a better resolution will distinguish between two very close peaks while a poor resolution 
might combine them.

A smaller value results in a higher (better) resolution, but also takes longer to measure. 

Typically, resolutions of 4 are used for solid and liquid samples. For gas samples, use a resolution of 1 
or 0.5.

4

Analysis type

With OMNIC Paradigm for touchscreen, you select your analysis type from the home screen rather 
than selecting from a list.

Allows you to automatically process your data after it’s collected.

Use None to measure a sample without additional analysis.

Search performs a correlation search. Use search to identify an unknown sample. Edit search settings 
in the Search Setup view.

QCheck results indicate a match value between your sample and a reference. Use QCheck to verify 
the composition of a known sample. Edit QCheck settings in the QCheck Setup view.

Quantify is used to quantify the components of a sample using a pre-selected quantification method. 
Select Identify > Quantify Setup to specify a quantification method.

None

Tag Allows you to add a tag to the spectrum. Tags can later be used when searching for a spectrum.  

Final format
Determines the units used for the collected data. You can convert your data to another Y-axis unit 
after collection in the View/Display menu.

Absorbance

Sampling 
accessory

The sampling accessory used to measure the sample. Smart accessories are detected automatically.  
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Save Your Measurement Settings

You can save, edit, or delete your measurement settings only when using the desktop interface.

Name and save your measurement settings so that you can easily select them from the dashboard for later use. Settings for 
Search, QCheck, and Quantify analyses are not saved in these settings.

❖    To save your measurement settings

 1. Make any desired changes to the settings.

 2. Click New near the Settings menu at the top of the dashboard.

 3. Enter a name for the settings and click Save.

Saved settings are added to the Settings list for later use.

❖    To make changes to your saved settings 

 1. Select the named settings that you want to update from the Settings menu.

 2. Edit the settings

 3. Click Save.

Your new settings are now saved under the old setting name and are available in the Settings menu.

❖    To delete your saved settings

 1. Select the named settings you want to delete from the Settings menu.

 2. Click Delete.

 3. In the confirmation dialog, click OK to permanently delete the named settings. 

Import and Export Saved Settings

Import a settings file to automatically update your current measurement settings to those you saved previously. When 
importing settings, you can import an OMNIC Experiment file (.exp) or an OMNIC Paradigm settings file (.expx). 

OMNIC Paradigm software is compatible with .exp files that were created with OMNIC software. However, with OMNIC 
Paradigm, you can export only .expx files, which are not compatible with earlier versions of OMNIC software.

Importing an OMNIC Experiment file updates your measurement settings, but does not alter your analysis settings, such as 
Search Setup or QCheck Setup. 

❖    To import a settings file

 l If you are using the touchscreen interface

 a. From the home screen, select an analysis type.

 b. While viewing the Summary tab, open the menu and select Open Settings.
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 c. Select an OMNIC Experiment file (.exp) or OMNIC Paradigm settings file (.expx) file to import and touch Open.

 l If you are using the desktop interface

 a. In the toolbar, click Settings.

 b. Select the file to import and click Open. 

❖    To export a settings file

Settings can be exported only from the desktop interface. Settings files are saved with a .expx file name extension.

 1. Choose the settings you wish to export from the Settings list

 2. Select Acquire Data > Export Settings.

 3. Enter a name for your settings file, select a directory to save the file, and click Save.

The settings file is now saved and ready for future use.
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Advanced Measurement Settings

Use advanced measurement settings to control apodization, zero fill, range limits, instrument-specific settings, and more.

These advanced settings should typically be left in their default state. Only in rare or specific circumstances should you edit 
these settings. 

To review or edit advanced settings in the touchscreen interface, open the Details tab.

Figure 4-1: The Details tab displays advanced measurement settings.

To review or edit advanced settings in the desktop interface, click More in the New Measurement pane.
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Figure 4-2: Advanced measurement settings are available from the dashboard

Advanced Measurement Settings

The following table describes each of the advanced settings.

Option Description
Default 
Setting

Detector

The detector is a device inside the spectrometer that produces an electrical signal in response to the 
infrared beam striking it. 

The detector setting is updated automatically based on your spectrometer setup. 

Nicolet Summit: DTGS. 

Nicolet Summit Pro: TEC DTGS.

 

Optical velocity

Determines the optical velocity in the interferometer. The default value is determined by the type of 
detector you are using, and can only be changed on certain spectrometers. 

On the Nicolet Summit spectrometer, the default value is 0.4747 and cannot be changed.

 

Zero fill

Interpolates data points between the collected data points. This doesn’t increase the actual resolution 
of the data, but can smooth out sharp features and improve the line shape of a spectrum.

Collect your sample and background spectra using the same Zero Fill setting.

Options

None: No zero filling is done.

1: One data point is added between each collected data point

2: Three data points are added between each collected data point

2
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Option Description
Default 
Setting

Source

The component inside the spectrometer that emits the infrared radiation that travels to the detector.

The source type is determined by your spectrometer setup. See your spectrometer user guide for 
details on the source.

 

Apodization

Apodization refers to a mathematical function that is applied to the single beam data to reduce or 
remove peak side-lobes that can occur because the interferogram is not an infinite set of data.

Strong apodization reduces more noise but can also reduce the resolution of the data and broaden 
peaks.

You may want to consider weaker apodization, such as Boxcar, if you are measuring spectra with very 
narrow peaks, such as high-resolution gas spectra.

See "Apodization Functions" for a description of each type of apodization.

Norton-Beer 
Strong

Automatic 
Atmospheric 
Suppression

Suppresses the effects of water vapor and carbon dioxide on the spectra you have collected.

In general, it is better to control for atmospheric conditions using a current background spectrum. If 
you measure the background frequently or if atmospheric conditions change slowly, there is no need 
to use this feature.

Use this feature only if you measure the background infrequently or when atmospheric conditions 
change rapidly.

Deselected

Range Limits Sets the limits for the range of frequencies, in wavenumber, included in the collected spectrum.
Max: 4,000

Min: 400

Aperture

Controls the intensity of the infrared radiation that reaches the sample.

Aperture can only be changed when using spectrometers with adjustable apertures.

In general, larger apertures will result in a better signal-to-noise ratio while smaller apertures result in 
better stability and accuracy. Small apertures are better for high-resolution measurements.

You may need to use small apertures to acquire true high-resolution spectra.

 

Apodization Functions

Apodization refers to a mathematical function that is applied to the single beam data to reduce or remove peak side-lobes 
that can occur because the interferogram is not an infinite set of data. 

Strong apodization reduces more noise but can also reduce the resolution of the data and broaden peaks.

See FTIR Spectroscopy Academy for a general introduction to apodization.

The following table describes the available apodization types:

Setting Description

Boxcar
The interferogram is unweighted; that is, the data are simply truncated at the beginning and end. Use this type when you 
are measuring a gas sample, want maximum resolution and are not concerned about ringing effects (side lobes). The 
greatest amount of ringing will be present with this type.
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Setting Description

Cosine
This setting suppresses side lobes and only moderately degrades the resolution of the spectrum. This setting is similar to 
the Happ-Genzel and Norton-Beer medium apodization. Cosine is normally used only to reproduce the results of other 
experiments that used it.

Happ-
Genzel

Suppresses side lobes more effectively than the Triangular type and with less reduction in resolution than that type. (It 
results in more reduction in resolution than the boxcar type.) 

Norton-Beer 
Weak

This setting has a less pronounced smoothing effect on data than do the Norton-Beer Medium and Norton-Beer Strong 
types and degrades the resolution less than those types. Side lobes appear on both sides of peaks and are more 
pronounced for sharper peaks. 

Use this setting only when the best possible resolution is required. This setting is generally not recommended and is 
normally used only to reproduce the results of other experiments that used it.

Norton-Beer 
Medium

This type has a smoothing effect on data which is between that of the Norton-Beer Weak and Norton-Beer Strong types. 
It suppresses side lobes as much as possible given that it only moderately degrades the resolution of the spectrum. The 
side lobe suppression is more significant than for Norton-Beer Weak apodization. This setting is suitable for most normal 
samples; it gives results virtually identical to those obtained with Happ-Genzel.

Norton-Beer 
Strong

Norton-Beer Strong is the recommended apodization for the Nicolet Summit and Summit Pro spectrometers.

This setting has a greater smoothing effect on data than do the Norton-Beer Weak and Norton-Beer Medium types and 
degrades the resolution of the spectrum more. The side-lobe suppression is more significant than for Norton-Beer 
Medium apodization.

Triangular
Mathematically weights interferogram data to reduce ringing effects (side lobes), resulting in lower resolution than that 
obtained with the boxcar and Happ-Genzel types. Some ringing will usually be present with this type. This setting is 
normally used only to reproduce the results of other experiments that used it.

Blackman-
Harris

The 4-term Blackman-Harris function is a strong apodization function that is better than any of the others at suppressing 
side lobes. However, it results in greater line broadening than any of the others. In practice this has the effect of reducing 
random noise in a spectrum while causing band broadening.
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Measure the Background

Accurate sample spectra require an accurate and current measurement of the background.

When you collect a background spectrum, you are collecting a measurement of the environment in the spectrometer without 
a sample in place, including characteristics of the detector and atmosphere inside the spectrometer. This background 
spectrum is then used to eliminate any signals in your sample spectrum that are due to the spectrometer or to the 
background environment. Without a measurement of the background, there would be no way to know whether you were 
seeing data from the sample you measured or from the background environment.

When to Measure the Background

Because the background environment in the spectrometer can change over time, you should update your background 
spectrum frequently. 

In addition to collecting a new background spectrum periodically as the environment changes, collect a new background 
after any of the following circumstances:

 l You have changed the hardware in your spectrometer, including changing sampling accessories

 l You have changed the settings for measuring samples

Background Settings

There are several options for when and how to measure the background. These options determine when and if you are 
prompted to collect a new measurement of the background.

To select a different background option in the touchscreen interface, select an analysis option and open the Background 
tab.

To select a different background option in the desktop interface, click More in the New Measurement pane of the dashboard 
and scroll to the Background group. 
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Figure 4-1: In the touchscreen interface, select a background setting in the Background tab.

Figure 4-2: In the desktop interface, select a background setting in the Background pane.

The following table describes the background settings.

Setting Description

Background 
scans

How many times the background will be measured. The resulting spectrum represents the average of all 
scans. More scans will produce a more accurate spectrum but will require a longer collection time. The default 
is 10.

Measure before 
every sample

If this option is selected, you will be prompted to collect a new background spectrum before every sample 
measurement. This is a good option when you are measuring only a few samples, as it ensures a current 
measurement, but it can slow down the measurement process.
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Setting Description

Measure every _
__ min

Allows you to measure many samples using the same background spectrum. You can enter any integer value 
between 1 and 1024, but note that the background environment may change over time and your sample 
spectra may become less accurate as time passes.

Smart 
background

Smart background measures the background automatically, so that you always have a current measurement 
without having to manually measure the background. 

Use previous 
background

Allows you to select a previous background spectrum. This option should be used only rarely and under 
unusual circumstances (for example, if it would be impossible to load or remove the sample without changing 
the system environment). In this case, you would collect and save a background spectrum earlier, using 
conditions as close as possible to the conditions under which you will measure the sample.

Measure the Background

Measuring the background requires only a few simple steps. If you attempt to measure a sample without a current 
background spectrum, you will be prompted to measure the background before proceeding.

❖    To measure the background in the desktop interface

 1. Remove any sample from the sampling accessory.

 2. From the dashboard, select Preview and Measure Background.

The Background Preview window opens, and you can preview the background before continuing with the collection.

 3. To continue, select Start Background Measurement, or click Dashboard in the toolbar to cancel and return to the dash-
board.

During the measurement, you can pause, restart, or stop the collection. If you stop the collection, the partial data will be 
used. For example, if you plan to collect 8 scans, but you stop after 4, the background spectrum will be used with only 4 
scans.

Once the background spectrum is collected, you can preview the sample spectrum and make any necessary changes 
to the sample measurement settings, or you can return to the dashboard.

❖    To measure the background in the touchscreen interface

 1. From the home screen, select an analysis type.

 2. Open the Background tab to edit or review your background settings.

 3. To begin the measurement, touch Measure Background.

The Background Preview opens, and you can preview the background before proceeding.

 4. To proceed, touch Start Background Measurement.

During the measurement, you can pause, restart, or stop the collection. If you stop the collection, the partial data will be 
used. For example, if you plan to collect 8 scans, but you stop after 4, the background spectrum will be available with 4 
scans.
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Once the background spectrum is measured, you can preview the sample spectrum and make any necessary changes 
to the sample measurement settings, or you can select Home in the menu to return to the home screen.
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Measure a Sample

Measuring a sample requires you to prepare your sample, to set and save your measurement settings, to measure a 
background spectrum, and finally to measure the sample.

❖    To measure a sample using OMNIC Paradigm software for touchscreen

 1. Prepare your sample 

How you prepare your sample will depend on your spectrometer and sampling accessory. For details on preparing and 
loading the sample, see your sampling accessory’s user guide.

 2. Select the analysis type that reflects the analysis that you are performing. To measure a sample without performing 
additional analysis, select Measure.

After selecting an analysis type, the settings summary view opens.

Figure 4-1: The Summary tab displays common measurement settings.

 3. Review and edit your measurement settings. 

Open the Details tab to review additional measurement settings or open the Background tab to adjust settings for how 
the background is measured. Depending on your background settings, you may be prompted to measure a new 
background before measuring the sample.

See "Set and Save Measurement Options" for a description of each setting.

For details on setting up your analysis, see "Identify an Unknown Sample with ATR" 
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 4. When you are satisfied with your settings, touch Measure Sample. The sample preview opens and displays a live pre-
view of the spectrum.

 5. To proceed, touch Start Sample Measurement.

During the measurement, you can pause, restart, or stop and save your measurement. For example, if you feel your 
data are sufficient and you do not want to wait for more scans, touch Stop to save and use the data as is. Touch 
Restart to clear all data and begin scanning from the beginning. 

Once your sample is measured, you can process or analyze it in the spectral view, or you can measure another sample. To 
measure another sample from the Spectral view, touch Measure New Sample. 

❖    To measure a sample using OMNIC Paradigm software for desktop

 1. Prepare your sample 

How you prepare your sample will depend on your spectrometer and sampling accessory. For details on preparing and 
loading the sample, see your sampling accessory’s user guide.

 2. To edit the settings for a Search, QCheck, or Quantify analysis, open the Identify menu and open the corresponding 
setup option.

 3. Set and save your measurement settings. 

To use previously saved settings, select the settings from the Settings list. 

Figure 4-2: The Settings list displays your previously saved settings

See "Set and Save Measurement Options" for a description of each setting.

For details on setting up your analysis, see "Identify an Unknown Sample with ATR"

 4. In the New Measurement pane, click Preview and Measure Sample

Depending on your background settings, you may be prompted to measure a new background. If so, follow the on-
screen prompts to measure a new background. 

While measuring the sample, you can pause, restart, or stop and save your measurement. For example, if you feel that 
your data are sufficient and you do not want to wait for more scans, click Stop to save and use the data as is. Click 
Restart to clear all data and begin scanning from the beginning. 

Once your sample is measured, you can process or analyze it in the Spectral view, or you can measure another sample. To 
measure another sample from the Spectral view, click More to review common measurement settings, and then click 
Measure New Sample to begin. 
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Next Steps

Measuring a sample with OMNIC Paradigm software requires only a few simple steps. Before measuring the sample, 
review your measurement settings and ensure that you have a recent background spectrum in use. 

With your spectrum measured, you’re ready to identify, verify, or quantity the spectra. See “"Identify an Unknown Sample 
with ATR"” for a guide to using a library search to identify your sample. 

4.2.2 Process Data

Use the processing tools in OMNIC Paradigm software to better understand your data.

Apply Basic Equations to Acquired Data

You can perform basic equations (add, subtract, multiply and divide) with acquired sample spectra. There are a number of 
reasons why you might want to do this, especially for subtracting a reference spectrum. For more information, see the 
sections that follow.

To Perform Any Spectral Math Operation

To perform spectral math, the sample and reference spectra must have the same spectral resolution and be in the same Y-
axis unit. If they are not, the software automatically converts the selected reference spectrum to match the selected sample 
spectrum. In order to subtract, multiply or divide spectra, at least a portion of the spectral range (X-axis) of the two spectra 
must overlap.

❖    To perform any spectral math operation on a spectrum

 1. Acquire or open a spectrum of your sample and make sure that spectrum is selected in the spectral view.

 2. Choose Process (menu) > Spectral Math.

The software opens the Spectral Math setup window with the sample spectrum in the left pane and space for a 
reference spectrum in the right pane.
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Figure 4-1: Spectral Math Setup Window

 3. Use the settings list between the two panes to select a spectral math operation (Subtract, Add, Multiply or Divide).

 4. Use the Select Reference list to search for a spectrum in the current project, another project, or from a spectral library.

 5. Click Subtract (Add, Multiply, Divide) to start the operation.

The software opens the Spectral Math operation window with the two original spectra (bottom) and the current result 
with a factor slide bar (top). Here is an example showing a subtraction result:
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1. Current subtraction result

2. Factor

3. Sample

4. Reference

 6. Adjust or enter a factor as needed to increase or decrease the intensity of the reference in the result spectrum.

See the sections below for tips on adjusting the factor for each math type.

Note Use the bottom bar to change the Factor’s adjustable range.

 7. Choose Save.

The software shows the spectral view with the subtraction result in the spectral pane and at the top of the results panel, 
with the original sample and reference spectra directly below it.
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Subtract One Spectrum from Another (A-B)

Use Subtract to subtract one spectrum from another. Spectral subtraction is useful in a variety of situations. Here are some 
examples: 

 l If you measure a sample that is dissolved in a solvent, the spectrum will contain peaks due to the solvent. By sub-
tracting a spectrum of the pure solvent from the sample spectrum, you can eliminate the solvent peaks and produce a 
“clean” spectrum of the sample material.

 l When you measure a sample that is a mixture of two or more components, the spectrum is, theoretically, the sum of the 
spectra of all the components. By subtracting a spectrum of a pure component from the sample spectrum, you can pro-
duce a simpler mixture spectrum with that component removed. You can then search that spectrum against a library to 
identify the remaining components. (In this case, you might want to try using the Multi-Component Search option 
instead.)

 l If you measure a sample that contains an unknown contaminant, the spectrum will contain peaks due to the con-
taminant. By subtracting a spectrum of uncontaminated sample material from the first spectrum, you can produce a 
residual spectrum of the contaminant. You can then search that spectrum against a library to identify the contaminant.

 l If you collect spectra to monitor the quality of a material being produced, you can more easily detect changes from one 
batch to the next by subtracting one sample spectrum from the next (or vice versa) than by just comparing the spectra 
visually.

Tips on subtracting spectra

 l To determine the subtraction factor, watch the changes in the common peaks as you change the factor. The common 
peaks in the result spectrum should become smaller. The optimum factor is one which produces nulled (or zeroed) com-
mon peaks in the subtraction result without subtracting other important spectral information. If you use the correct 
factor, the peaks present in the result will be due solely to the sample material of interest.
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 l The initial subtraction factor is automatically calculated from the displayed region. If you display a different spectral 
region and perform the subtraction again, the difference spectrum will probably be different because the subtraction 
factor changed.

 l When you subtract a reference spectrum from a sample spectrum, the baseline regions are subtracted along with the 
regions that contain peaks. If the sample spectrum's baseline is not flat and at zero absorbance (or 100% trans-
mittance), the baseline of the subtraction result will have the same undesirable characteristics. If you correct the 
baseline first, you can obtain a “clean” subtraction in which corresponding peaks are subtracted out, without baseline 
problems in the result.

 l When you subtract the spectrum of a pure reference material from that of a mixture, the peaks may not subtract cleanly. 
This is because the reference spectrum does not account for any changes that may occur due to molecular interactions 
with the other components in the mixture or differences in relative concentrations of components. These conditions 
may cause some peaks to shift slightly or change shape.

Add Two Spectra Together (A+B)

Use Add to add two spectra together. Adding spectra can be useful in the following situations:

 l Add can be used to join together two spectra of different spectral ranges.

 l By adding two pure component spectra together, you can produce a theoretical composite spectrum that is the sum of 
the two component spectra. This theoretical composite spectrum can be compared with an unknown mixture spectrum 
in a quantitative analysis.

Tips on adding spectra

 l Use the Factor setting to scale the reference spectrum up or down before adding it to the sample spectrum.

 l If only one of the spectra contains data points in a spectral region, the Y value of the other spectrum is considered to be 
zero in that region when the spectra are added.

Multiply One Spectrum by Another (A*B)

Use Multiply to multiply two spectra. Most people use divide rather than multiply for most applications. But multiplying 
spectra can be useful for reprocessing a spectrum with a different background. For example, if you measure a sample that is 
adhered to a matrix, you can acquire a single beam spectrum of just the matrix and use that spectrum to cancel out the 
original background and replace it with the new one. Here is the equation:

S * B1/B2

Where:

S= sample spectrum (processed with original background)
B1 = original background
B2 = new background

Divide One Spectrum by Another (A/B)

Use Divide to divide one spectrum by another. Dividing spectra can be useful for reprocessing a spectrum with a different 
background. For example, if you measure a sample that is adhered to a matrix, you can acquire a single beam spectrum of 
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just the matrix and use that spectrum to cancel out the original background and replace it with the new one. Here is the 
equation:

S / (B2/B1)

Where:

S= sample spectrum (processed with original background)
B1 = original background
B2 = new background

Tips on dividing spectra

 l Data points that have zero absorbance values in the original sample spectrum will produce very strong absorbance val-
ues in the resulting spectrum.

Using Spectral Math with Data Security

When “Require reason for change for Spectral Math” is enabled in the Thermo Scientific Security Suite, Spectral Math 
requires a change reason and signature before the results can be saved, and the following change event is recorded in the 
audit log:

 l Date and time
 l Operation performed: subtract, add, multiply, divide
 l Sample spectrum title
 l Reference spectrum title
 l Factor
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Advanced Spectral Math

Advanced Spectral Math provides more flexibility and power than standard spectral math. While standard spectral math 
supports spectral subtraction, addition, multiplication, and division using a single reference spectrum, Advanced Spectral 
Math allows you to build custom equations using up to 10 reference spectra and using a wider range of operations.

For many applications, using the standard subtract, add, multiply, and divide functions in spectral math is simple and 
sufficient. However, if your analysis requires a more complex equation, Advanced Spectral Math may be required.

Both forms of spectral math are available only in the Desktop interface of OMNIC Paradigm software.

When choosing between the two methods, consider the following differences to decide which tool is right for you:

 l Standard Spectral Math

 l Supports only subtraction, addition, multiplication, and division using a single reference spectrum with a slider to 
adjust the factor

 l Advanced Spectral Math

 l Flexible equation builder using basic subtraction, addition, multiple, and division as well as derivatives, exponents, 
and more

 l Can include up to ten different reference spectra in the equation

Carrying Out Advanced Spectral Math

When you use Advanced Spectral Math, you will typically add spectra that you will use in the equation, build your equation, 
preview the results, and finally review the result in the Spectral View.

❖    To perform advanced spectral math

 1. In the Spectral View, select a measurement to use in Advanced Spectral Math.

 2. Open the Process menu and select Advanced Spectral Math. The equation builder opens.
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Figure 4-1: The Advanced Spectral Math view

 3. Add reference spectra to use in the equation.

You can add up to 10 spectra, and you do not need to use every spectrum that you open. You may find that it is easier 
to add the spectra first so that they are available while you focus on the equation, or you may prefer to add them only as 
needed.

 a. Select reference or library spectra. When you add a spectrum, a new tab opens automatically.

 l If you use a spectrum from a commercial (locked) library in the equation, you cannot export the result.

 4. Build the equation.

 a. Click an operator to add it to the equation.

 b. Once the operator is added, you can click any of the open  spaces to insert a spectrum or another operator.

 l To add a spectrum, with the open space selected, choose a spectrum and click Insert into Equation.

 l To add an operator, click the operator. If you have an open  space selected, the operator is inserted into that 
location. If you do not have any spaces selected, the new operator is wrapped around the the current equation.

 l You can also save your equation or load a previous equation.

 l To save the equation, simply click Save. The equation is added the list of available equations.

 l To load a previous equation, you must first open the correct number of spectra used in the equation. For 
example, if the equation used 3 spectra (A, B, and C), open at least 3 spectra. Your open spectra will 
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automatically be inserted into the equation in their corresponding position, but you can edit the equation as 
needed or replace the spectra.

 c. When you are satisfied with the equation, click Calculate to preview the result.

 5. Preview the result.

Figure 4-2: The shows the result on top and your reference spectra below

The result preview displays the spectrum resulting from your equation as well as each of the spectra used in the 
equation. The result is shown in the top pane and your reference spectra are shown in the bottom pane.

 l To edit the equation, click Cancel to return to the previous screen.

 l To save the results of the equation, enter a name for the resulting spectrum or leave the default and click Save.

 6. View the result in the Spectral View.

The resulting spectrum is listed in the Results pane. Spectra used in the equation are shown in the sub-panes below 
the result spectrum with a label indicating their use in the equation.
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Functions Available in Advanced Spectral Math

Function Description

k Constant

? + ? Addition

? - ? Subtraction

? * ? Multiplication

? / ? Division

log(?) Logarithm. Returns the base 10 log

exp(?) Returns the result of the constant e (2.7182818) raised to the power of the specified value

sqrt(?) Square root of the value

deriv(?) Derivative

savderiv(?) Savitsky-Golay Derivative

norderiv(?) Norris Derivative

Reprocess Spectra

You can transform the original interferogram data for your spectrum with new settings by using Reprocess.

When comparing your spectrum to a reference, you can get a more accurate comparison if both spectra were processed 
using the same settings. For example, if your spectrum was collected using a broader range than the reference or if it used a 
different apodization technique, your comparison may be inaccurate. Reprocessing allows you to transform the original data 
to match your reference spectrum, resulting in better results for your correlation, QCheck, or quantification analyses.

You cannot reprocess to a finer resolution than was originally used. Reprocessing can transform your data but cannot fill in 
data that was never collected.

If you reprocess multiple spectra, the options show only the values that they share. For example, if one spectrum was 
measured at a finer resolution, you can select only the shared, lower resolution for reprocessing. This is also true for range. 
You can set the max and min values for Truncate to only the shared, overlapping range. 

❖    To reprocess your spectra

Reprocess is available only in the Desktop view of the software.

 1. In the Spectra view, select one or more spectra.

 2. Go to the Process menu and select Reprocess. The Reprocess dialog shows the settings used for reprocessing and a 
preview of your resulting spectrum. If you are reprocessing more than one spectra, the preview shows only the first 
spectrum.
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 3. Change your reprocessing settings. To reprocess the spectrum using a different background spectrum, select Replace 
background spectrum and then select a new spectrum to use.

 4. Click Apply to reprocess the spectra.

You can undo the reprocessing by viewing the History panel and reverting to an earlier state. If you reprocessed more than 
one spectrum, you will have to revert each one individually.

Blank a region in your spectra

Clear data from a region of your spectrum with the Blank Regions tool in the Process menu. You can also blank regions in 
workflows with the Processing tile. 

The Blank Regions tool is a great way to get rid of noisy data that would interfere with your analysis. For example, blanking a 
region helps in the following situations:

 l Your spectrum has totally absorbing peaks because the sample is too thick. The random noise at the top of these peaks 
will cause poor results when you search the spectrum against a library or when you quantify or subtract the spectrum.

 l Your spectrum includes the region below the cutoff of an MCT detector (around 700 wavenumbers) or the cutoff of an 
ATR crystal. These regions contain only noise, since there is no spectral information present. If you don't exclude these 
regions, they will interfere with library searches and spectral processing.

Blanking a region

You can blank regions on one or more spectra.
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 1. Select the spectra that have regions you want to blank. Hold CTRL and click to select more than one spectrum or press 
CTRL + W to select all spectra.

 2. Go to the Process menu and select Blank Regions. If you have more than one region selected, they are shown in over-
lay view. 

 3. Use the region selector to select the region you want to delete. Click Add Region to delete more than one region, and 
click Apply to blank the regions.

To undo the change, view the spectrum's history and revert to a previous state.

Replace a region with a straight line

With the Straight Line command, you can replace a spectral region with data points that form a straight line. As with Blank 
Region, this is useful for removing unwanted features of your spectrum.
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Difference between Blank Region and Straight Line

Straight Line draws a straight line between the points adjacent to the edges of the selected region, while Blank Region 
simply deletes the points in the selected region. A change made to a spectrum by replacing a region with a straight line may 
not be apparent to someone who examines the spectrum. On the other hand, blanking the region makes it apparent that the 
original data have been removed from that region.

Note: If you replace a region that contains peaks with a straight line and then search the spectrum against a library, the 
comparison uses the straight-line region. This is unlike searching a library to identify a spectrum in which the region was 
blanked. In that case, the region is simply ignored.

The Straight Line command is available only in the Desktop view.

❖    To replace a spectral region with a straight line

 1. From the Spectra view, go to Process > Straight Line.

 2. Use the selector to choose a region to replace with the straight line. Select Add Region to use Straight Line on more 
than one region.
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 3. Select Apply.

 

A straight line replaces the region or regions.

To undo the Straight Line command, view the spectrum history and revert to an earlier state.

Apply Kramers-Kronig Correction

The Kramers-Kronig Correction is useful for converting a specular reflectance spectrum to a more typical transmission 
spectrum. The corrected spectrum uses absorbance units and is normalized to a maximum value of 1 absorbance unit.

Specular reflectance spectra are often problematic for analysis because their peak positions, intensity ratios, and spectral 
patterns prevent you from using them in quantitative analysis and spectral searches. 

This correction gives you the best results when the starting and ending frequencies of your spectrum are flat regions. You 
should also remove water vapor and carbon dioxide by either purging the spectrometer or using atmospheric suppression. If 
needed, you can also use the Straight Line tool to remove these features.

❖    To apply the Kramers-Kronig Correction

 l Desktop

From the Spectra view, go to the Process menu and select Apply Kramers-Kronig Correction. 
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 l Touchscreen 

From the Spectra view, open the main menu and select Spectral Corrections > Apply Kramers-Kronig Correction.  

Calculate average and standard deviation spectra

To find the average or standard deviation of spectra, use the Statistical Spectra tool in the Process menu.

For each X value of your spectrum, you can find the average or standard deviation of the Y value. This creates a new 
spectrum.

 l Average: Finds the arithmetic mean of the Y value for each data point. If you have taken several measurements of a 
sample material, you can calculate the average spectrum to reduce the effect of measurement variations. The average 
spectrum is also useful as a reference spectrum since it may be more representative of a compound than any single 
measurement.

 l Standard Deviation: Finds the standard deviation of the Y values for each data point. By comparing the variance of 
peaks, you can detect if impurities were introduced during a production process.

You can also use the standard deviation to compare spectra of a standard sample that you measured at different times. This 
is a useful way to test the repeatability of the measurement.

You can calculate statistical spectra only in the Desktop view of the software. Use the Processing tile to calculate statistical 
spectra in workflows. 

❖    To calculate statistical spectra

 1. From the Spectral view, select 2 or more spectra to use in the calculation.

 2. Go to the Process menu and select Statistical Spectra.

 3. Select the calculation you want to perform and the data format to use for the calculation and then select Calculate. The 
resulting spectrum is added to the Results panel. You can see which spectra were used to generate the new spectrum 
in the new spectrum's Measurement Information.

Reduce noise by smoothing spectra

Use Smooth in the Process menu to remove random noise and improve the shape of your spectrum. Smooth uses the 
Savitzky-Golay algorithm.

There are two types of smooth operations available:

 l Automatic smooth: An automatic smooth often gives a satisfactory result and is faster than a manual smooth.

 l Savitzky-Golay smooth: Manually set the number of points used in the algorithm. Using more points results in a greater 
degree of smoothing.

These images show the result of applying the most aggressive Savitzky-Golay smoothing to a noisy spectrum. This is a 
closely zoomed portion of the spectrum to more easily show the difference.

The spectrum before smoothing
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The spectrum after applying smoothing

Be careful when smoothing spectra with real sample peaks that are narrow, since these features are also smoothed. 
Smoothing degrades the effective spectral resolution of the data and can remove ("smooth out") small spectral features.

In general, it is better to measure the sample with more scans and a better resolution instead of using Smooth.

Smoothing is applied to the currently selected spectrum and does not create a new, resulting spectrum.

Desktop interface

❖    To apply automatic smoothing

 1. Open your spectrum in the Spectra view.

 2. With your spectrum selected, go to Process > Smooth Spectrum > Automatic.

The smoothing is applied automatically. View the measurement history to undo the smoothing.

To apply Savitsky-Golay smoothing

 1. Open your spectrum in the Spectra view.

 2. With your spectrum selected, go to Process > Smooth Spectrum > Savitzky-Golay.

 3. Set the number of smooth points to use in the Savitzky-Golay algorithm.
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 l The number of smooth points is used to set the size of the moving window used in the algorithm. Using more points 
causes more smoothing.

 4. Click Save.

Touchscreen interface

❖    To apply automatic smoothing

 1. Open your spectrum in the Spectra view.

 2. With your spectrum selected, go to Spectral Smoothing > Automatic.

The smoothing is applied automatically. View the measurement history to undo the smoothing.

❖    To apply Savitsky-Golay smoothing

 1. Open the measurement.

 2. Open the main menu and select Spectral Smoothing > Savitzy-Golay.

 3. Set the number of smooth points to use in the Savitzky-Golay algorithm.

 l The number of smooth points is used to set the size of the moving window used in the algorithm. Using more points 
causes more smoothing.

 4. Select Save.

Normalize spectra scale

Use Normalize to change the Y-axis scale of the selected spectra to a “normal” scale in which the Y values of the data points 
range from 0 absorbance units for the lowest point to 1 absorbance unit for the highest peak (for an absorbance-like 
spectrum) or from 10% to 100% transmittance (for a transmission-like spectrum). These normal scales are typical of spectra 
in commercial spectral libraries. 

After you normalize the scale of a spectrum, you cannot use it for quantitative analysis unless you know the scaling factor 
and adjust the quantitative results accordingly. 

Desktop interface

To normalize the scale in the desktop interface, from the Spectra view, go to Process > Normalize.

Touchscreen interface

To normalize the scale in the touchscreen interface, from the Spectra view, open the main menu and select Spectral 
Corrections > Normalize Scale.

View Interferograms

Use Retrieve Interferograms to view the original data for a spectrum, including the interferograms used for the background 
and for the sample.  If you discover a problem with the transformed data, you may be able to diagnose the problem by 
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examining the interferogram. For example, a sine wave in the baseline of a spectrum usually indicates a "double pass" of 
the infrared beam through the sample. The corresponding interferogram will often show a "spike" on the side of the data. 

❖    To retrieve the interferograms

Desktop view only 

 1. From the spectra view, select a spectrum. 

 2. Go to the Process menu and select Retrieve Interferograms. The two interferograms are added to the spectra view. 

 

4.2.3 Analyze Data

Use the analysis tools in OMNIC Paradigm software to identity unknown samples and to verify the components of your 
sample. 

Find peaks

Use Find Peaks in the Identify menu to identify peak locations in a spectrum. The command finds peaks in the displayed 
spectral region or in the selected region if you have selected one.

The command searches for peaks with Y-values above a threshold and then labels them with their X-values.
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❖    To find peaks

 1. Starting in the Spectra view, select a spectrum.

 2. Go to the Identify menu and select Find Peaks. You can also use the CTRL+K keyboard shortcut. The Find Peaks view 
opens.

 3. Adjust the region, threshold, and sensitivity to your liking. The display shows you the peaks found with the current 
settings. You can add multiple regions or include the entire range.

 4. Click Save. The peaks are annotated on the spectrum, and you can now create a Peak Results report, which includes 
all the found peak locations.

Setting Description

Region Indicates the region in which the tool will find peaks.

Threshold 

The Find Peaks tool identifies peaks found above this Y-axis limit.

If the Y-axis format of the spectrum produces downward pointing peaks, the peaks that extend below the 
threshold will be found. For example, if the threshold value is 0.5, peaks in the selected spectral region whose 
Y value is greater than or equal to 0.5 will be found and labeled

Table 4-1: Find peaks settings
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Setting Description

Sensitivity 

The sensitivity determines how readily Find Peaks finds shoulders on peaks and small peaks in the baseline. 
Unlike the threshold value, which merely specifies the Y value above which peaks are found, sensitivity 
considers the relative size of adjacent spectral features.

If you use a low sensitivity setting, a shoulder is treated as part of the larger peak and a small peak is treated 
as part of the noise in the baseline; neither feature will be found. At a higher sensitivity setting, the shoulder 
and small peak will be found and labeled as peaks.

If the sensitivity is set too high, noise and other unimportant features above the threshold will be found along 
with the useful features. Use a combination of threshold and sensitivity settings that lets you find just the 
spectral features you are interested in.

Identify samples and mixtures

In OMNIC Paradigm software, you can identify samples and mixtures by using correlation and multi-component searches. 
In these types of analyses, the spectrum of your sample is compared to spectra stored in libraries and the software finds the 
best matches. In a correlation search, each result is a single compound and in a multi-component search, each result shows 
several compounds that contribute to the overall composite spectrum. 

Identifying samples and mixtures

To identify samples and mixtures, measure your sample as usual. In the Spectra view, go to the Identify menu and select 
either Correlation search to find a single match or Multi-Component Search to identify composite matches and their 
contributing compounds. 

Search setup

Configure settings for correlation search and multi-component search using Search Setup. These settings are used 
automatically when you select Correlation Search or Multi-component Search from the Identify menu in the desktop 
interface or from the main menu in the touchscreen interface.

Using the desktop interface, you can also use Search Setup to specify the location of additional libraries on your system. 
See "Add Library Locations" for details.

Correlation search settings

A correlation search compares your measurement to compounds in your libraries and returns the closest matches. The 
results include the match value for each compound with a value between 0 and 100, with 100 indicating a perfect match. 

139 OMNIC Paradigm Software User Guide Thermo Scientific



Figure 4-1: Correlation search settings

Setting Description

Match historical search res-
ults

Select to have search results match those of legacy OMNIC applications. 
The improved algorithm used in OMNIC Paradigm software scales large peaks to reduce the effects of 
totally absorbing spectra. 

Select only if you are comparing new measurements with older data collected using legacy 
OMNIC software.

Maximum spectra in search 
results

Limit the number of search results. For example, with a maximum of 5, the search will return only the 5 
best matches. 

You can enter a value from 1 to 20.

Show compounds with 
match values above ____

Set a threshold for which matches are returned by the search. For example, with a value of 60, the 
correlation search will return only matches with a match value above 60.

Search all libraries
Select to search all of your libraries. Clear the selection to specify only specific libraries to use for the 
search.

Use full spectral range

Select to use the full spectral range for the search. Clear the selection to specify one or more limited 
ranges for the search. 

You can use multiple regions to exclude another region from the search. For example, include a region 
on either side of a totally absorbing peak to exclude it from the search. 
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Correlation search results

The results of the correlation search are shown in the results pane, ordered by match value.

A The results pane displays your original spectrum and the results of the correlation search. The res-
ults are nested below the spectrum that was searched. 

B The match value represents how similar the match was to the original spectrum, with a match of 
100 indicating a perfect match. 

C Hover over the gray arrow to view more details about the match, including the library where the 
match was found and the position in the library. 
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Multi-component search settings

Use multi-component search to identify the components making up your sample. 

Figure 4-2: Multi-component search settings

Setting Description

Maximum number of 
search results

Limit the number of composite search results.

Number of com-
ponents

Set the number of components to return for each composite.

Search all libraries Select to search all of your libraries. Clear the selection to specify only specific libraries to use for the search.

Use full spectral 
range

Select to use the full spectral range for the search. Clear the selection to specify one or more limited ranges for 
the search. 

You can use multiple regions to exclude another region from the search. For example, include a region on 
either side of a totally absorbing peak to exclude it from the search. 
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Multi-component search results

The results of the correlation search are shown in the results pane, ordered by match value.

A The sample spectrum and the composite spectrum

B Spectra of the compounds in the composite

C The composite spectrum is a combination of the component spectra. The composite match value 
shows the overall match value and shows how well the composite spectrum matches the sample, 
with 100 representing a perfect match.
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D Component spectra are nested under the composite that they are a part of.   

The cumulative value shows how each component contributes to the overall composite match 
value. The cumulative value for the first component shows its contribution to the overall match, 
and each additional component’s contribution adds to the overall match value. For example, 
consider a composite with a match value of 80, including a compound with a cumulative of 70 and 
a compound with a cumulative of 80.  In this case, the first compound contributes 70 to the match 
value and the second compound contributes another 10 to the match value. 

The composite percent value indicates the amount of the reference compound in the composite. 
For example, a composite value of 55% means the component contributes 55% to the total 
composite spectrum. The sum of the composite percent values is always 100%. Note that the 
composite percent value shows the contribution of the compound to the composite, not to the 
actual sample. In other words, a composite value of 55% for a found component does not 
necessarily mean the sample mixture contains 55% of that component. 

E Hover over the gray arrow to view details about each of the compounds.

Verify your sample with QCheck

In a QCheck analysis, your sample is compared to a known reference spectrum and the software provides a match value 
and a pass or fail result. QCheck is great for quickly verifying that your sample matches your internal standard. 

For a more detailed walkthough on using QCheck, see "Verify Sample Composition with QCheck".

Verifying samples with QCheck

To perform a QCheck analysis, measure your sample as usual. Then, in the Spectra view, go to the Identify menu and 
select QCheck. 

QCheck Setup

Use QCheck Setup to configure your QCheck analysis. Your saved QCheck settings will be used automatically when you 
select QCheck as your analysis type before measuring a sample or when you select QCheck from the Identify menu.

For more on using QCheck, see "Verify Sample Composition with QCheck".
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Figure 4-1: The QCheck setup screen

Setting Description

High Sensitivity
Select high sensitivity for more exact results between a sample that is very similar to the reference. You 
may want to deselect high sensitivity if you are measuring samples with some natural variation.

Pass/fail threshold

Set a threshold for pass or failure. Enter an integer between 0 and 100. 

A correlation value of 100 indicates a perfect match.

If you de-select this option, all results will show Pass.

Maximum spectra in 
QCheck results

Sets the number of results shown in the results panel. For example, if you set the value to 2, only the two 
best matches will be shown in the results panel.

Prompt for reference

Select to choose a reference during the measurement. De-select to specify one or more reference 
spectra in advance. If you are planning to compare several samples to the same references, it is 
convenient to set them in advance to avoid having to keep selecting the same reference every time you 
measure a sample.

To use a compound from a library as your reference, first extract the compound so that it is available in 
your database.

Blank diamond ATR region 
(2200 - 1955)

Select to exclude data in the region from 2200 wavenumbers to 1955 wavenumbers, where diamond 
ATR crystals absorb radiation.

Blank CO2 region (2390 - 
2240)

Select to exclude data in the region from 2390 wavenumbers to 2240 wavenumbers, where carbon 
dioxide absorbs radiation.
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Setting Description

Use full spectral range
Select to use the full range in the analysis.

De-select to specify only a limited range to use for the analysis.

Identify contaminants

If you have a known substance and you want to check for any other unexpected materials, use Contaminant Analysis. 
Contaminant Analysis compares a reference spectrum of your known material to the actual spectrum and identifies potential 
contaminants. Unlike QCheck, which compares your spectrum to a single reference spectrum and reports a match value 
and a pass or failure, contaminant analysis identifies likely contaminants in your sample. 

The results of Contaminant Analysis show you what contaminants may be present and in approximately what quantity.

Setting up and using Contaminant Analysis

Contaminant Analysis is available in both the Desktop and Touchscreen interfaces.

Contaminant Analysis in the Desktop interface

❖    To use contaminant analysis

 1. Assign a reference spectrum in Search Setup.

 a. Go to Identify > Search Setup.

 b. Select the Contaminant Analysis Search tab.

 c. Select a reference spectrum. This is the spectrum of your known material.

 d. Review your other settings.

 2. Click Save.

 3. In Spectra view, select the spectrum to analyze.

 4. Go to Identify > Search > Contaminant Analysis.

After a short time, the spectra view shows the results of the analysis.

Contaminant Analysis in the Touchscreen interface

❖    To use contaminant analysis

 1. Assign a reference spectrum in Search Setup.

 a. Open the main menu and select Search Setup. 

 b. Select the Contaminant Analysis Search tab.
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 c. Select a reference spectrum. This is the spectrum of your known material.

 d. Review your other settings.

 2. Select Save.

 3. In Spectra view, select the spectrum.

 4. Open the main menu and select Search > Contaminant Analysis.

After a short time, the spectra view shows the results of the analysis.

Contaminant Analysis settings

Setting Description

Max number of 
results

Set how many composite results are returned. For example, if you set 2 results, the contaminant analysis 
will show you 2 possible composites ordered by match value.

Number of 
contaminants

Set the number of compounds in each composite. For example, with 3 contaminants, in your results, each 
composite spectrum will include 3 possible contaminants.

Search all libraries Select which libraries to use in the search. Using fewer libraries speeds up the analysis.

Select reference 
source

Indicate if your reference spectrum is in a library or if it is a standalone measurement in your database.

Select reference
Your known compound. In the contaminant analysis results, each composite will include your known 
compound and suspected contaminants.

Use full spectral 
range

Limit the range or use the full spectrum in the analysis.

Interpret the results

Like other Search analyses, the results of the Contaminant Analysis are displayed in the Spectra view. The Results pane 
lists each composite and potential contaminants.
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Feature Description

A The sample spectrum and the composite spectrum

B Spectra of the compounds in the composite, including the known compound

C Show or hide the details of the composite

D
The composite match value shows how well the composite spectrum matches the sample, with 100 representing a 
perfect match.

E Hover over the gray arrow to view details about each of the compounds.

Details about each compound include the following:

Compound 
name

The name of the compound

Cumulative

The cumulative value shows how each component contributes to the overall composite match value. The 
cumulative value for the first component shows its contribution to the overall match, and each additional 
component’s contribution adds to the overall match value.

For example, consider a composite with a match value of 80, including a compound with a cumulative of 70 
and a compound with a cumulative of 80. 

In this case, the first compound contributes 70 to the match value and the second compound contributes 
another 10 to the match value. 
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Composite %

The composite percent value indicates the amount of the reference compound in the composite. For example, 
a composite value of 55% means the component contributes 55% to the total composite spectrum. The sum of 
the composite percent values is always 100%.

Note that the composite percent value shows the contribution of the compound to the composite, not to the 
actual sample. In other words, a composite value of 55% for a found component does not necessarily mean 
the sample mixture contains 55% of that component.

Library name The name of the library in which the compound was found

Index number The location of the compound in the library

Regions 
searched

Spectral regions used in the library search

4.2.4 Create Reports

Generate reports from template to quickly save and share your data as Microsoft Word, PowerPoint, or Excel files. Or, 
export your spectra, workflows, and settings to share with your colleagues.

Create and Share Reports and Export Data

Generate reports from templates to quickly save or share your data as Microsoft™ Word™, PowerPoint™, or Excel™ files, or 
export your spectra, workflows, or settings.

❖    To create a report from the desktop interface

 1. From the Spectra view, select File > Create Report.

 2. Enter a title for your report and select a format and template option. The preview updates to match your selections. 

If you select Save as your format, your report data is saved to the database.

 3. To configure the template, click Options and select items to include. Click OK to save your selection.
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 4. Click Create.

❖    To create a report from the touchscreen interface

 1. From the spectral view, open the menu and select Create Report.

 2. Enter a title for your report, select a directory to save the report to, choose a format, and finally select a template. The 
preview updates to match your format and template selection.

If you select Save as your format, your report data is saved to your database.

 3. To configure the template, touch Options and select items to include. Touch OK to save your selection.
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 4. Touch Create.

Export Settings, Spectra, or Workflows

Use OMNIC Paradigm software for desktop to export settings and workflows. Export spectra in either desktop or 
touchscreen mode.

❖    To export settings

 1. Select the settings you wish to export from the Settings list.

 2. Select Acquire Data > Export Settings.

 3. Name the settings file and click Save.

Settings are saved with a .expx file extension. These settings files store your measurement settings but not Search, 
QCheck, or Quantification settings. Settings files with a .expx file extension are not compatible with previous versions 
of OMNIC software.

❖    To export workflows

 l If you are using the desktop interface

 a. In the Workflows pane, right-click the workflow you wish to export and select Export from the menu.

 b. Name your workflow file and click Save.
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 c. Workflow files are saved with a .rwfl file extension.

 l If you are using the touchscreen interface

 a. In the Workflows tab, select the workflow you wish to export and select the more options menu. 

 b. Select Export.

 c. Name your workflow file and touch Save.

 d. Workflow files are saved with a .rwfl file extension.

❖    To export measurements

 l If you are using the desktop interface

 a. In the Measurements pane, right-click the spectrum you wish to export and select Export.

 b. Name your spectrum file and click Save. Spectra are saved with a .spa file extension. 

 l If you are using the touchscreen interface

 a. From the home screen, select the Measurements tab.

 b. Open the more options menu [ ] and select Export.

 c. Touch Save. Spectra are saved with a .spa file extension.

Create Historical Spectrum Report

A Historical Spectrum report includes detailed information about how a measurement changed over time as you carried out 
processing and analysis. The report shows the spectrum at each step in the history.

Creating a report of the measurement history is similar to creating other reports but requires you to first open the Historical 
Data view. The Historical Spectrum template will not be available if you open Create Report from the normal Spectral View.

❖    To create a Historical Spectrum template report

 1. Using the desktop interface, open a measurement in the Spectral View.

 2. Navigate to the measurement history tab.

 3. Right-click any item in the history and select Measurement History.
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 4. Open the File menu and select Create Report.

 5. In the Create Report dialog, enter a title for the report, select a format, and edit any template options. Only the Print and 
Save formats are available for Historical Spectrum template reports.

 6. Click Create.

Add Labels and Annotations to Spectra

Use the Annotation Tools to add custom labels or to highlight features of a spectrum. Annotations are great for adding extra 
information to reports when presenting or sharing your data.

You can create annotations only in the Desktop interface.

❖    To add peak annotations to a spectrum

 1. In the Spectral view, select a spectrum.

 2. Right-click the spectral pane, select Display Tools, and select either Peak Area or Peak Height.
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 3. Adjust the settings for the peak tools and click Save.

 4. To move the annotation, click and drag the text.

Peak height and peak area annotations cannot be edited or deleted using the right-click menu. To remove them, use 
the history to revert to an earlier processing step.

❖    To add custom labels and annotations to a spectrum

 1. In the Spectral view, select a spectrum.

 2. Right-click the spectral pane, select Annotation Tools, and select an annotation option.
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 3. To move the annotation, click and drag the text or, for an Ellipse or Rectangle, click and drag the top of the shape.

Right-click an annotation for additional customization options.

4.3 Time Series Analysis

4.3.1 Understand Time Series analysis

This topic offers an overview of important concepts related to Time Series analyses. When available, follow links to find 
more detailed information about specific features and best practices. 
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4.3.2 About Time Series analyses

A Time Series analysis is useful for exploring how sample measurements change over time. For example, you can use a 
Time Series analysis to explore how a sample evolves during a TGA-IR or GC-IR experiment, or you can open a collection 
of standard measurements to see if your measurements remain consistent throughout a given week or month, alerting you 
to times when the measurements vary. 

You can also create a Time Series analysis from a set of repeated measurements taken during a workflow. For instance, 
you might use a Repeat tile and a Delay tile to measure the same sample repeatedly for a given duration, such as taking a 
measurement every 60 seconds for an hour. Afterward, you can open the measurements in a Time Series analysis to 
explore how the sample changed over the duration of the workflow. 

Time Series analysis is still in development and more features will come in future releases. Currently, you can convert 
standard measurements and measurements from a workflow to a Time Series analysis, but you cannot yet collect data 
directly as a time-based measurement. 

Tip Use tags to organize your measurements and to make them easier to convert to a Time Series analysis later. 
Workflows can use the Tag tile to automatically tag all measurements, and individual measurements can apply a tag 
during data collection using the Tag setting on the dashboard. 

Key concepts and terms 

 l Time Series: A Time Series analysis consists of a set of 4 or more measurements plotted along a time period. 

 l See "Create a Time Series analysis" for instructions on how to convert measurements to a Time Series analysis. 

 l Profile: A profile is a representation of the series data and is used to show how the data changes over time. Each profile 
shows a different aspect of the measurement data, such as how a peak height or peak area changes. 

 l See "Profile types" for a description of each profile.

 l See "Create and use profiles" for instructions on how to apply, save, and edit profiles.

 l History: In a Time Series analysis, the history includes all processing and display conversion operations. You can use 
the history to see what processing operations have been applied to the data and to remove specific operations.

 l See "Process Time Series data" for instructions on applying and removing processing operations

Overview of the Time Series window

When you open measurements in Time Series, the analysis window opens and displays your data. 
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A Profile name The name of the displayed profile. 

B Profile view The profile view shows the profile curve of all your currently saved profiles. Right-click to change the x-
axis units. 

C Crosshair The crosshair shows the currently selected location in the profile. The spectrum corresponds to the 
selected location and the X and Y values are displayed in the lower-left corner of the screen.

D Time line Use the time line to scroll through your measurements. The spectra pane shows the spectrum at the 
current point in the time line. 

With the time line selected, use the left and right arrow keys to navigate to earlier and later spectra.

E Spectrum pane The spectrum pane shows the spectrum at the current time selected with the time line above.

F Measure, 
profile, and 
history tabs

The Measure, Profile, and History tabs

 l Measure tab: Displays information about the Time Series analysis.

 l Profile tab: Use the profile tab to create, edit, and apply profiles.

 l History tab: The History tab shows all the processing operations and display conversions that 
have been applied to the data. 

G Profile type tabs Use the profile type tabs to switch between your favorite profiles and your Time Series profiles.

 l Time Series profiles: These profiles are unique to this Time Series analysis. They cannot be 
reused with other analyses unless you recreate them independently. 

 l Favorites: These profiles are shared with all Time Series analyses and can be reused each time 
you create a Time Series analysis. 

H Profile settings The settings area displays the current settings for the selected profile. Use this area to edit the profile.
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I Profile actions When editing or creating a profile, you can preview or save it. After saving a profile, you can add it to 
your Favorites profiles or your individual Time Series profiles.  

 l Preview: Updates the profile preview to show you the profile curve using the current settings. 

 l Save: Saves the profile with the current settings.

 

 

4.3.3 Collect time series data

With a Time Series analysis, you can measure a series of data to identify and analyze change over time, such as in a TGA 
or GC analysis.

Preparing for data collection

Before you measure time series data, review and edit your measurement settings.

❖    To view and edit settings for a Time Series analysis

 1. Set your Analysis type to Time Series.

 

 2. Select More to view all additional settings specific to your Time Series analysis.
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Setting Description

Start from external trigger 

Select this option if you are using a remote start cable to trigger Time Series data collection 
automatically.

For further details, see the documentation for your spectrometer or other accessories.

Set measurement duration
Set the length of the measurement. The measurement will stop automatically after the set 
time, but you can stop the measurement earlier if you choose.

Stop measurement manually Continue measuring until you stop the measurement manually.

Delay between samples

Normally, the interval between samples is determined by the resolution, mirror velocity, and 
the number of scans per spectrum. 

You can use this option to manually set a longer interval between measurements. This can be 
useful if you know that your sample changes very slowly and want to limit the amount of data 
collected, for example.

Profile selection
Use this option to automatically apply a profile from your Favorites in addition to the Gram-
Schmidt profile.

Heaters 

If you are using a GC accessory, the Time Series settings also include settings for your 
heaters.

The current status shows whether the heaters are off or displays their current temperature.

 l Flow cell setpoint: Set the target temperature for the flow cell.

 l Transfer line setpoint: Set the target temperature for the transfer line.

 l Start heaters: Select to turn the heaters on. They automatically begin to ramp to the 
target setpoint. When the heaters are on, the button changes to Turn Heaters Off.

 l Show status: Select to open the heater status in a separate dialog. This is useful to 
monitor the heaters while navigating to different parts of the software.

Table 4-1: Table 1 Measurement settings for Time Series

Starting your Time Series measurement

After setting Time Series as your analysis type and reviewing your measurement settings, you are ready to start your 
analysis.

❖    To measure Time Series data

 1. Select Measure Time Series. 

The background preview opens in the target tab.

 2. Select Start Background Measurement and wait for the measurement to complete.

 3. Select Start Time Series Measurement.
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The Time Series measurement starts. During the measurement, the display shows the Gram-Schmidt profile in the top 
pane and the most recent spectrum in the bottom pane.

If you set a specific duration, the measurement continues until the duration and stops automatically. Otherwise, select 
Stop to end the measurement.

During the measurement, you can create and apply profiles or select points to view the spectrum at that time.

4.3.4 Import TGA file

If you are running a TGA experiment with a TA Instruments analyzer, you can import the TGA data to your series collection 
to add weight, temperature, and derivative weight to the results. 

❖    To import TGA data,

 1. Export the data from the TGA instrument as a file with a .tga extension. See the documentation that came with your 
analyzer for instructions on how to export the tga data.

 2. While viewing the series data, go to File > Time Series > Import TGA File.

 3. Select the TGA file and select Open.

The temperature, weight, and derivative weight profiles are added to the Profiles tab.
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4.3.5 Identify components in a time series analysis

By performing an Identify Components search in a Time Series Analysis, you can quickly identify the primary components of 
a Time Series measurement, including a TGA sample that you measured using a Thermo Scientific TGA-IR module. 

Setting up your Identify Components search 

You can specify several settings for your Identify Components search. Options for the Identify Components search are 
similar to a multi-component search. 

❖    To set up the Identify Components search 

 1. To go the Identify menu and select Search Setup. 

 2. Go to the Time Series Component Search tab. 

 3. Change your settings as desired and select Save. 

Setting Description

Maximum number of search 
results 

Use this option to set the maximum number of composite results that the software will find.  

Number of components Use this option to set the number of components found in each composite result.

Search all libraries 
Use this option to search all your libraries or only a subset of libraries. Including more libraries 
will make the search take longer.  

Use full spectral range 

Select to use the full spectral range for the search. Clear the selection to specify one or more lim-
ited ranges for the search.  You can use multiple regions to exclude another region from the 
search. For example, include a region on either side of a totally absorbing peak to exclude it from 
the search. 

Table 4-1: Settings for Identify Search 

Using an Identify Components search

When your Time Series measurement is finished, go to the Search tab to start an Identify Components search.

❖    To identify components

 1. In the Time Series view, go to the Search tab.

 2. From the Search type list, select Identify Components.
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 3. Select Search. 

The Search begins and displays the results. How long the search takes depends on how many libraries you are 
searching and on how long your Time Series measurement was. If you have a long measurement and are searching 
many libraries, the search may take several minutes.

 4. When the search is finished, interpret your results. 

Figure 4-1: Example results from an Identify Components search

    

A The profile pane shows the combined spectral response for all components over the full duration of data col-
lection.  Select a profile from the Profile list to view it here.  

Table 4-2: The results of an Identify Components search
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B The composite spectrum pane shows the spectrum linked to the selected decomposition time in the profile 
pane and the composite spectrum for the selected match at the same decomposition time. 

C The library match profiles pane shows the spectral response for each primary found component over the full 
duration of data collection. This lets you see when each primary component vaporized from the sample.     

D The results pane shows the composites and the component spectra found in the search. The composite is a 
calculated representation of all references in the match set. The amount of each reference in the composite is 
based on the amount present in the component profile at the selected decomposition time. The selected spec-
trum is red.

E The components contribute to the composite result. 

F The match value tells you how closely the match set fits all the spectra in the series data set. The higher the 
value is, the better the fit.

4.3.6 Create a Time Series analysis

Create a Time Series analysis by selecting a set of measurements and opening them in Time Series.

You can easily filter your measurements by using tags. If your desired measurements all share the same tag, you can 
search for that tag and then select all the measurements to create the Time Series analysis. The Tag tile in workflows can 
automatically tag every measurement your workflow collects. 

After filtering the measurement list, select one measurement and then press CTRL+A to select all measurements. 

Tip Use the ‘tags’ keyword to limit your search terms to only tags. 
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Figure 4-1: Using tags to filter measurements

❖    To create a Time Series analysis:

 1. Select a set of measurements to view in Time Series.

With one measurement selected, hold SHIFT and click to select a group of measurements or press CTRL+A to select 
all measurements.  

 2. Right-click the measurements and select Open in Time Series.

 

The Time Series analysis opens. 
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4.3.7 Process Time Series data

As with a standard measurement, you can process Time Series data to correct baselines or account for ATR 
measurements, perform spectral math, smooth data, and more. When you apply a processing operation in a Time Series 
analysis, the operation is applied to all spectra at once. For example, performing Auto Baseline Correct will correct the 
baseline of every spectrum in the analysis. 

Select an option from the Display menu to convert all spectra to that display format. For instance, if your analysis contains a 
mix of measurements using %transmittance units and absorbance units, selecting Display > Absorbance ensures that they 
all use absorbance units. 

You can view or remove past processing operations in the History tab. 

Convert all spectra to the same y-axis units

To convert all spectra to the same y-axis units, select an option from the Display menu. You should always make sure your 
spectra all use the same display units before you apply any profiles. If your spectra use a mix of units, the profiles may show 
inaccurate or misleading values. 

Remove a processing operation

To remove a processing operation, go to the History tab and right-click the operation. You can remove either a single 
operation or all operations. 

4.3.8 Apply profiles

A profile is a representation of the measurement data plotted over time. Use profiles to explore how your sample changes 
over time and to explore how the changes correlate to external factors, such as temperature in a TGA-IR experiment. 
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Profile types

Profile Type Description

Reconstruct
This is the default display when you create a Time Series analysis from previous measurements. The 
Reconstruct simply plots the count of spectra over time. 

Correlation

The Correlation profile compares every spectrum to a reference spectrum and shows the match value, like a 
QCheck analysis. The Y-Axis of the profile curve displays the correlation value, with a 1 indicating a perfect 
match. 

Select Set Correlation Reference to set the reference to the currently displayed spectrum. 

Area The Y-Axis of the Area profile shows how a peak area grows or shrinks. 

Peak The peak profile shows the change in peak height. 

Area Ratio

The Area Ratio profile shows the change in a ratio of one peak to another. With this profile, you specify the 
area for two peaks. The resulting ratio uses the first peak area as the numerator and the second peak area as 
the denominator. 

The “Intensity threshold” in this profile refers to the minimum peak area used in the calculation. If either peak 
area is less than or equal to this minimum value, the result will be 0 instead of the calculated ratio. This is 
useful for preventing extremely large values as the area of either peak approaches 0. 

Peak Ratio

The Peak Ratio profile calculates the ratio of two peak heights. 

In the Peak Ratio profile, the “Intensity Threshold” refers to the minimum peak height. If either peak is less 
than or equal to this minimum, the profile plots 0 instead of calculating the ratio. This is useful for preventing 
extremely large or small values as the height of either peak approaches 0. 

Chemigram The Chemigram profile shows the uncorrected area of the specified region. 

Peak position

The peak position profile displays how a specified peak shifts in the series, with the y-axis showing the peak 
position in wavenumbers. 

The “Intensity threshold” in this profile refers to a peak height minimum. If the peak is less than or equal to this 
height, the returned value is NaN, meaning “not a number,” creating a small gap in the curve. The profile 
curve skips these points and connects the points on either side. If the gap is large, there will be a visible blank 
space in the profile curve. 

Peak Width

The Peak Width profile measures the changing width in a specific peak. The y-axis value for this profile shows 
the width of the peak in wavenumbers. 

The Height% value determines where the peak is measured. For example, if the Height% is set to 75%, the 
width is measured at 75% of the peak height, as measured from the baseline. 

The Intensity Threshold in this profile is a peak height minimum. If the peak is less than or equal to the 
threshold, the width is not calculated and the profile instead returns NaN, meaning “not a number”, and the 
profile curve skips those values, connecting the points on both sides. If the gap is large, you will see a visible 
blank area in the profile curve. 
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Profile Type Description

Quant

The Quant profile uses a TQ Analyst Quant method to calculate the profile curve. The y-axis value depends 
on the QNT file you are using. 

To use a Quant profile, first, go to Identify > Quant Setup and select a QNT file. Then, create a Quant Profile. 

Create and use profiles

There are two categories of profiles

 l Time Series profiles: These profiles are unique to this Time Series analysis. They cannot be reused with other 
analyses unless you recreate them independently. 

 l Favorites: These profiles are shared with all Time Series analyses and can be reused each time you create a Time 
Series analysis. 

❖    To create and apply a profile

 1. Select either Time Series or Favorites tab.  

 2. Click New. 

 3. Enter a name for the profile. You can always change the name later. 

Tip It’s a good idea to use a descriptive name, especially for Quant profiles, to help you understand the profile curve 
later.  

 4. Select a profile type. See "Profile types"for a description of each profile.

 5. Use the controls to edit the settings. 

 6. Click Preview to see how the profile curve looks. 

 7. When you’re done, click Save. 

The profile is added to the list in either the Time Series or Favorites tabs, and the profile curve is added to the profile view.

Select Delete to remove and delete a profile. 

Select Edit to change the profile name, type, or settings.

 

4.3.9 Create a Time Series Report

Print or save a report to keep a record of your analysis results. Reports for a Time Series analysis show the following 
information, and each item is optional. 
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 l Title: The title of the report. 

 l Profiles: The profiles section shows the image of all profiles currently applied. The Report shows only the Time Series 
profiles or the Favorites profiles, depending on which tab you are using when you create the report. 

 l Spectrum: The spectrum section shows whichever spectrum was displayed when you went to the Create Report 
window. 

 l Time series information: This section shows details about the analysis, such as the name of the user who performed 
the analysis, the date and time of analysis, and the number of spectra included. 

 l Signature box: Including the signature box adds a space to add a signature, date, and additional comments. 

❖    To create a report for a Time Series Analysis:

 1. From a Time Series analysis tab, go to File > Create Report.

 2. Enter a Report Title and select a report format. Printed reports are also saved. 

 3. Select Options to customize what information is included in the report.

 4. Select Create. 

Find your saved reports on the dashboard with your other reports. 

To view your saved Time Series reports, view Reports on the dashboard. 

4.3.10 Manage your Time Series Analyses

To view and manage your previous Time Series analyses, select Time Series on the dashboard. 
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Here you can view your previous analyses or open, rename, or delete them. Select the More option to view additional 
details, including general information, processing history, and digital signature details, if present.  
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4.4 Microscopy
This section describes features used for FTIR microscopy in OMNIC Paradigm softwar.

4.4.1 View the sample

Move the stage and bring the sample into focus

The easiest way to bring the sample into focus is to select an approximate location of interest from the Mosaic capture list 
and to select the Autofocus before capture option. With these options selected, when you start the session, the stage will 
automatically move to the correct location, bring the sample into focus, and capture a mosaic. 

If you want to move to another location and bring a new region into focus, you can move the stage and bring the sample into 
focus using either the software or the optional joystick.

Move the stage using either OMNIC Paradigm software or the optional joystick. Never attempt to move the stage by hand. 

With the software

In the session view, open the Camera View to see the sample.  

 l To move the stage horizontally, open the Camera View and open the Stage tools. 

Click the arrows to the sides and above and below the sample image to move the stage. Change the movement speed 
to change how far the stage moves with each click. 

Thermo Scientific OMNIC Paradigm Software User Guide 170

4. How-to guides



4. How-to guides

Double-click inside the live video image to center the stage on that position. 

 l To move the stage up and down, open the Camera View and open the focus settings. Click the left and right arrows to 
move the stage up or down.
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Autofocus

To bring the sample into focus automatically, click Autofocus. The software moves the stage and up down to find the optimal 
focus. Autofocus works best with areas of high visual contrast. Autofocus may struggle with some low-contrast samples and 
samples with multiple focal planes. 

Tips for autofocus
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 l Adjust the illumination for optimal viewing. If the illumination is too high or too low, there may not be enough contrast for 
autofocus to find the proper focus. 

 l If you are using the 40x objective with the manual focus ring, make sure that the focus ring is set to the 0 position. An 
incorrectly positioned focus ring may interfere with autofocusing.

With the joystick

You can move the stage horizontally or vertically with the joystick, and with the movement speed control, you can move 
quickly or carefully. Use the Camera View or the optional eyepieces to judge your position. 

 l To move the stage horizontally, push or pull the joystick forward, backward, left, and right. 

 l To move the stage up or down, rotate the joystick clockwise to move the stage up or counterclockwise to move the 
stage down. 

Use the speed selector to change movement speeds. 

Illuminate the sample

You can control the amount of light that reaches the sample by using either the software or the optional joystick. Use the 
reflection illumination controls to set the light from above the sample and the transmission illumination controls to set the 
light from below the sample. 

With the software

To control the illumination in the software, open the Camera View. Select either Transmission or Reflection and drag the 
slider to the desired light setting. You can also enter an exact value.
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Autoilluminate

Click Autoilluminate for the software to automatically optimize the sample illumination.

With the optional joystick

The optional joystick has two control knobs to set the transmission and reflection illumination. Use the Camera View or the 
optional eyepieces to view the sample illumination. Rotate the knobs to control the light. 

Adjust aperture

The adjustable aperture defines the area that the IR beam interacts with the sample. This ensures that IR energy strikes 
only the area of interest and not the adjacent sample material, and it ensures that the small amount of diffracted radiation 
that passes around the edge of the area of interest does not reach the detector. 

During particle analysis, the software finds a set of ideal apertures for all of the particles, and then uses those apertures 
during the sample measurement. 

Set the aperture manually in the Advanced settings area of the dashboard or in the Camera view. 

❖    To adjust the size, shape, and rotation of the aperture

 1. Open the Camera view and select the aperture settings.

 

 2. Use the sliders or enter an exact value to adjust the height, width, and rotation of the aperture. 

Note  To visualize the aperture, adjust the illumination until you can see the bright blue rectangle of light passing 
through the aperture. 

Thermo Scientific OMNIC Paradigm Software User Guide 174

4. How-to guides



4. How-to guides

4.4.2 Prepare measurement settings

OMNIC Paradigm software has basic and advanced settings for how you view and measure samples with your 
FTIR microscope. 

Basic settings are used frequently and determine the type of analysis you are performing. Advanced settings need to be 
adjusted less commonly and relate to how the instrument hardware is configured and how the data is processed to generate 
the sample spectrum. 

Basic settings

Find the basic settings in the New Measurement pane after you set your sample location to the FTIR microscope. 

Figure 4-1: Basic measurement settings for microscopy

Setting Description

Autofocus before 
capture

Select to automatically bring the sample into focus when starting the session. 

If you do not select this option, you should either manually bring the sample into focus using the 
optional joystick and eyepieces before starting the session, or change your mosaic capture setting to 
Custom Mosaic. After starting the session, open the Camera View and bring the sample into focus 
manually before capturing a mosaic. 

Session name
The name of the session data. This name is used in the saved data and, if you have Security Suite 
software installed, in the audit trail. The default name is the date and time the session was started. 

Final format
Determines the units used for the collected data. You can convert to another Y-axis unit after collection 
by using the options in the Display menu. 

Sample scans
The number of scans collected at each sample point. Fewer scans results in faster data collection but 
potentially noisier data. 

Mosaic capture

Specify a mosaic type to capture automatically when you start the session. 

To start the session without capturing a mosaic, select <No Mosaic>. 

Extremely large mosaics require a large amount of hard-drive space to store and are time consuming 
to collect. To save disk space and measurement time, capture a mosaic of only the portion of the 
sample that you need for your analysis. 

Table 4-1: Basic measurement settings for microscopy
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Setting Description

Camera profile

Select a camera profile to best fit the type of sample that you are analyzing. Camera profiles set the 
brightness, contrast, white balance, and more to provide the best image of the sample.

Many samples are prepared on highly-reflective backgrounds but are not highly reflective themselves. 
Make sure you select an option that best fits the sample surface and the area of interest.

 l High Reflective: Highly reflective samples usually visible reflections when they are exposed to a 
light source (such as nearby lights or sunlight). These samples include glass slides, glossy paper, 
and well-polished metals, for example.

 l Matte: Select this option for dark materials with rough surfaces that have low visible reflections, 
such as very dark plastics, rubber, cardboard or paper, or fabric.

 l Diffuse: Select this option for materials that have medium or low reflectivity and are light in color. 
Use “Diffuse” for samples such as light color plastics, non-glossy papers, pharmaceutical tablets, 
or similar materials.

Finding the right camera profile

To check if the camera profile setting is right for the sample material, bring the sample image into focus 
and adjust the illumination either automatically or by using the manual controls.

The illumination number should be between15 and 70.

 l If it is less than 15,  the camera setting should be adjusted to the high-reflective profile.

 l If the number is greater than 70, the camera profile should be adjusted to either diffuse or matte.

Tag Add a tag to the session. Tags are useful for finding and filtering your saved sessions later. 

Resolution

Like the resolution of a photo or video, a better resolution will mean finer detail in your spectral data. 
For example, a better resolution will distinguish between two very close peaks while a poor resolution 
might combine them. 

A smaller value results in a better resolution but also takes longer to measure.

Profile
A default profile to use to display the chemical data after measuring a area, line, or set of points. You 
can change the profile after measuring data. For more on each profile, see Apply Profiles. 

Analyze using

The technique used for measuring the sample. The selected technique determines what settings are 
available during the session.

 l Reflection

 l Transmission

 l ATR

Analyze particles
Select to analyze particles. If selected, particle analysis tools are available in the Session view. This 
option must be selected before you start a session. 

Enable Polarizer 
acquistion

Select to use the polarizer and analyzer during data collection. You can also enable the polarizer dur-
ing the session. 
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Setting Description

Step size
The distance that the stage moves between sample points, in micrometers. A smaller step size 
measures the sample at more points in an area but takes longer to measure and requires more space 
to save. 

Aperture height and 
width

The aperture is used to exclude unwanted parts of the sample from the measurement and to prevent 
unwanted light from reaching the detector. 

Imagine the aperture as a rectangular window that the infrared beam passes through during the 
measurement. 

You can also set the aperture height, width, and rotation angle in the camera view. 

Background and advanced settings

The background and advanced settings areas provide additional options for how your data is collected and processed.

Setting Description

Use the fixed ref-
erence location on 
the RaptIR sample 
holder

The RaptIR sample holder has built-in reference points for transmission and reflection analyses. Select 
this option to automatically move the stage to the reference location after capturing your initial mosaic. 
This option is not available if you selected Custom Mosaic in the Mosaic Capture list.

Match sample scans
If selected, the number of scans used for the background measurement will be the same as the scans 
used for the sample. 

Table 4-2: Background settings for microscopy
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Setting Description

Set background 
scans

Select to choose a different number of scans for the background. 

Measure back-
ground before each 
region

If selected, the software will measure a new background before each new region of the sample. For 
example, if you have three area regions in your sample measurement, with this option selected, the soft-
ware collects a new background before each area. Note that a set of points that use the same meas-
urement settings is considered a single region.

Measure back-
ground once for 
entire sample

With the option selected, a new background is collected only when the measurement settings change. For
 example, if you have this option selected, if you measure three areas in one sample collection and they all
 use the same measurement settings, only one background is collected.

The following are advanced settings: 

Setting Description

Zero fill

Interpolates data points between the collected data points. This doesn’t increase the actual 
resolution of the data, but can smooth out sharp features and improve the line shape of a 
spectrum. 

Collect your sample and background spectra using the same Zero Fill setting. 

Options 

 l None: No zero filling is done. 

 l 1: One data point is added between each collected data point 

 l 2: Three data points are added between each collected data point

Optical velocity (cm/sec)
Determines the optical velocity in the interferometer. The default value is determined by the 
type of detector you are using, and can only be changed on certain spectrometers.

Gain
Sets the amplification of the detector signal. Higher gain increases the signal but also 
increase the noise. The optimal gain depends on the experiment. 

Apodization

Apodization refers to a mathematical function that is applied to the single beam data to 
reduce or remove peak side-lobes that can occur because the interferogram is not an infinite 
set of data. 

Strong apodization reduces more noise but can also reduce the resolution of the data and 
broaden peaks.

See "Apodization Functions" for a description of each of the options. 

Beamsplitter
If your instrument has multiple beamsplitters installed, you can select one of them here. If you 
have the the ABX installed on your spectrometer, configure the ABX first and select your 
beamsplitter to use here. 

Table 4-3: Advanced measurement settings for microscopy
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Setting Description

Sample spacing

Sample spacing refers to how frequently the interferogram is sampled. 

Lower sample spacing settings allow you to measure a more extended frequency range, and 
higher sample spacing settings are useful when measuring with very fast optical velocities, 
when the mirror is moving too quickly for the IR measurement to keep up.   

 l 0.5: The IR signal is measured at every zero crossing and at the top and bottom of the 
laser signal wave. This setting allows a much wider data range.  

 l 1: The IR signal is measured at every zero crossing of the laser wavelength. Use to 
extend the range beyond 7899 wavenumbers.

 l 2: The IR signal is measured at every other zero crossing. This is useful when using 
very fast optical velocities, but the maximum measured range must be below 7900.  

Mapping speed
High speed is good for most applications, but you may want to try Normal if you need to 
improve the quality of your data. 

Detector Displays the currently installed microscope detector.

Range limits
Sets the limits for the range of frequencies, in wavenumber, included in the collected 
spectrum.

Prompt for session name
If selected, the software presents a prompt to enter a new session name at the beginning of 
every new session. 

Atmospheric suppression

Suppresses the effects of water vapor and carbon dioxide on the spectra you have collected. 

In general, it is better to control for atmospheric conditions using a current background 
spectrum. If you measure the background frequently or if atmospheric conditions change 
slowly, there is no need to use this feature. 

Use this feature only if you measure the background infrequently or when atmospheric 
conditions change rapidly.

4.4.3 Capture a mosaic

A mosaic is a visual image of your sample surface. The camera captures a series of small, high-resolution images and 
stitches them together into a single mosaic, giving you a large image of the sample surface that you can use for your 
analysis. The mosaic acts as a workspace for your analysis, where you can explore regions of interest and specify areas 
and points for your IR data collection.

In general, when you are analyzing a sample, you will collect a low-magnification mosaic image with a 4x or 10x objective, 
adjust your settings as needed, then if needed, capture a high-magnification mosaic of a smaller area using the 15x or 30x 
objective. When you have captured a mosaic, draw regions or select particles, and begin measuring data.

You can capture a mosaic automatically when you start the session or manually from the Session view. 
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Types of mosaics

There are two types of mosaics:

 l Low-magnification (4x or 10x). Begin your analysis by capturing a low-magnification mosaic. This provides a larger 
overview of the sample surface. 

 l High-magnification (15x or 30x). If needed, capture a high-magnification mosaic of a smaller area of interest. The high-
magnification mosaic provides a better image but takes longer to collect. 

Automatic and manual captures

You can capture a mosaic automatically when you begin your session or you can first refine your measurement settings and 
then capture the mosaic manually.

Low-magnification mosaics

❖    To capture a mosaic automatically

 1. From the dashboard, select an option from the Mosaic Capture list. If you pick any option other than "Custom Mosaic," 
the software captures the mosaic automatically when you begin the session.

 2. Typically, you should select Autofocus before capture before you begin your session. With this option selected, the 
software automatically brings the sample into focus and optimizes the lighting for the best mosaic.

 3. Select Start Session. The session begins and the software automatically captures the mosaic.

❖    To capture a mosaic manually

 1. If you have not started a session, on the dashboard, select Custom Mosaic from the Mosaic capture list. Then, click 
Start Session.

 2. In the Session view, use the Camera View and move the stage to the desired position.

 3. Make sure the lower-magnification objective is selected. 

 4. Click Capture Mosaic.

 5. To add a to your low-magnification mosaic, make sure the Capture Mosaic tool shows that the low-magnification object-
ive.

 a. Select the Mosaic tool and draw the area to capture. 

 b. Click Capture Mosaic.

High-magnification mosaics

You must capture a low-magnification mosaic before you can capture a high-magnification mosaic.
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❖    To capture a high-magnification mosaic

 1. In the Session view, select the Mosaic tool from the floating toolbar.

 2. Click and drag to draw a rectangle on the low-magnification mosaic. This is the area where the high-magnification 
mosaic will be captured.

 3. Click Change Objective  to select the high-magnification option (usually 15x), if it is not already selected.

 4. Select Capture Mosaic.

The high-magnification mosaic is drawn on the top of the previous mosaic and a thumbnail image is added to the mosaic tab 
of the results panel.

Snapshots

A snapshot is a single image of the sample surface as it is viewed from the camera view.

❖    To capture a snapshot

 1. In the session view, open the Camera View.

 2. Click the snapshot tool. The snapshot is added to the mosaics tab.

 

Exploring mosaics

Use the navigation tools to zoom in or out and to view different areas of the mosaic.

The mosaic sky view

The sky view displays a high-level image of the mosaic. When you zoom in to view the mosaic, the sky view shows you 
where you are looking on the sample surface. 

You can also use the sky view to navigate the mosaic. Click an area on the sky view to move to that location. Click and drag 
the border of the focused region to zoom in or out.
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Navigation tools

 l To zoom in and out

 o Use the mouse scroll wheel to zoom in and out on the mosaic.

 o Once you have zoomed in slightly, you can use the mosaic sky view to zoom. Click and drag the border of the 
focused region on the sky view to make it larger or smaller. 

 l To view different areas of the mosaic, select the pan tool. With the pan tool selected, click and drag to move the mosaic 
image.

4.4.4 Analyze samples

Measure a background spectrum

Before you collect sample data, you must measure the background. A background is a measurement of the instrument 
sampling conditions without any sample present. After measuring the background and the sample, the sample data is 
ratioed against the background measurement to create the final sample spectrum.

The best location or material to use varies depending on the sample type or application. The table below provides some 
suggestions for collecting backgrounds.
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Sample type and application Background suggestion

Transmission, sample suspended over 
air 

Air

Transmission, sample on a salt plate An area of the salt plate where no sample material is present

Transmission, sample in a 
compression cell 

A crystal of KBr (or other halide salt) in the same compression cell next to the sample

Specular reflection A mirror or polished metal

Diffuse reflection Crushed KBr, silicon carbide paper or other rough, non-infrared-absorbing material

Reflection-absorption 
A mirror or polished metal, or an area of the sample support where no sample material 
is present

ATR Air

❖    To measure a background spectrum

 1. Start a session and capture a low-magnification mosaic.

 2. From the floating toolbar, select the Background tool.

 3. Click the mosaic at the point where you want to measure the background. A live single beam spectrum is displayed in 
the spectra pane. To move the background point, click the mosaic again.

 4. When you are happy with the single beam spectrum of the background, click Accept Background.

 5. Click Measure Background. The background spectrum is collected. When it is complete, it is added to the Background 
tab of the Spectra tab.

 

When the background measurement is complete, you are ready to place areas, lines, and points and measure your sample.
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If you are measuring multiple areas over a long period of time, replace your background measurement periodically. In 
general, you should always have a recent measurement of the background before you measure the sample.

Analyze particles

Use the particle analysis tools to locate, characterize, and identify microparticles.

❖    To analyze particles

 1. Prepare your sample

 2. On the dashboard, select Analyze particles.

 3. "Capture a mosaic"

 4. In the Session view, review the mosaic and make any needed changes to focus and illumination. Capture a high-
magnification mosaic if needed. 

 5. "Measure a background spectrum".

 6. Analyze particles.

 a. Select the Particle Analysis tool , and click and drag to draw a rectangle on the mosaic. This is the region of 
interest, where the software will detect particles. When you have drawn a region, the Particle Analysis pane opens.
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 b. Refine your selection using the options and selection tools.  Select Recalculate after updating settings to update 
the      particles. See the OMNIC Paradigm guides and tutorials for detailed explanations of the particle analysis tools 
and settings.

 c. When you are satisfied with your selection, click Accept. This saves the selection settings but does not yet 
measure the data. 

 d. Click Sample. 

Analyze areas, points, and lines

Create a chemical image of an area of the sample surface by specifying one or more areas to analyze. You can also 
measure lines or individual points using the line tool and point tool. You can measure areas, lines, and points together. 

Measure areas, lines, and points

Measuring areas, lines, and points requires you to first capture a mosaic and measure the background.

❖    To analyze areas, points, and lines

 1. "Capture a mosaic"

 2. "Measure a background spectrum".

 3. Specify areas, lines, and points to analyze. You can add multiple areas, lines, and points to a single analysis.

To analyze Select this tool Perform these steps
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Areas
 1. Select the area tool.

 2. Click and drag on the mosaic to draw the area. 

Lines
1. Select the line tool.

2. Click and drag to draw a line.

Points
1. Select the point tool.  

2. Click to add a point.

Use the cursor tool to select or delete areas, points, and lines. 

 4. When you are finished adding area, lines, and points, click Sample.

When the measurement is complete, view the results in the new tab. 

Using the polarizer

Microscopes with the polarizer option include separate polarizers for visible and for infrared light. 

For each light source, the microscope includes two polarizing filters, called the polarizer and the analyzer.

 l Polarizer: Positioned between the light source and the sample

 l Analyzer: Positioned between the sample and the camera or eyepieces and the detector

When using the polarizer, you can insert either the polarizer alone, for plane-polarized light, or the polarizer and the 
analyzer, for cross-polarized light. The polarizer and analyzer can be rotated together or independently. 

Using the polarizer and analyzer

To use the polarizers, start by viewing the sample in the camera view. Here, you can preview your polarizer settings and 
adjust the visible light polarizer and analyzer.

Previewing the sample in the camera view helps you find the ideal settings to using during the sample measurement.

❖    To use the polarizer and analyzer in the Camera View

 1. On the dashboard, select Enable Polarizer acquisition.

With this option selected, regions are measured using the polarizer. If you do not change any settings, the default 
polarizer and analyzer settings are used. You can change your mind during the session and enable or disable the 
polarizer before you collect data. 
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 2. Begin your microscopy session as usual, using either transmission or reflection analysis types. You cannot use the 
polarizer when using the ATR analysis type. 

 3. In the Microscopy Setup view, open the Camera View and go to the Polarizer tab.

Figure 4-1: The polarizer tab in the Camera View

 

 4. Select Visual to use the visible light polarizer. Select Spectral/IR to use the IR polarizer.

 l View the sample image in the Camera View while you adjust the visible light polarizer settings. 

 l To preview the IR polarizer settings, turn on the Live Spectra view and view the spectrum. 

Setting Description

Visual Select to enable the visual polarizer.

Spectral/IR Select to enable the IR polarizer

Link dials
If selected, the polarizer and analyzer rotate at the same rate. Changing the angle for one also changes the 
other.

Polarizer angle Set the angle of the polarizer.

Analyzer angle Set the angle of the analyzer.

No analyzer If selected, the analyzer is removed from the beam path and only the polarizer is used. ("Plane-polarized light")

Table 4-1: Polarizer settings in the Camera View

Collecting IR data with the polarizer

When measuring your sample with the polarizer enabled, you can measure in two ways: 

 l Measure the entire region the polarizer (and analyzer) at a single, fixed angle.

 l Automatically rotate the analyzer during the measurement and collect data at a specified interval, such as every 5 
degrees of rotation. 
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Figure 4-2: The Polarizer Setup options

❖    To collect data with the polarizer and analyzer

 1. In the Microscopy Setup view, click Polarizer Setup in the toolbar to view the polarizer settings.

 2. Select Enable Polarizer acquisition.

 3. Edit and review your polarizer settings.

 l To use a single, fixed angle, set the # of steps to 1. Only the starting position of the analyzer is used.

 l For a stepped collection, …

 a. Set the angle of the polarizer.

 b. Set the starting and ending angles of the analyzers.

 c. Set either the # of steps or the Degrees/step. 

 5. Define one or more regions and measure the sample as usual.

The background point is automatically measured at each analyzer angle to correspond with the sample. During sample 
collection, each point is measured at every angle.

Table 2. Polarizer acquisition settings

Setting Description

Enable Polarizer acquisition Select to use the polarizer (and optionally the analyzer) in the data collection.

Starting position  

 Polarizer Fixed angle of the polarizer

 Analyzer The starting angle of the analyzer. If the # of steps is set to 0, this is the only angle used.

No Analyzer Select to remove the analyzer from the beam path and use only the polarizer.

Ending position  
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Setting Description

Analyzer The analyzer ending angle.

Degrees/step Enter either the Degrees/step or the # of steps. The other value is calculated automatically. 

# of steps Enter either the Degrees/step or the # of steps. The other value is calculated automatically. 

Explore the polarized data

After collecting data with the polarizer, the results are shown in the Analysis tab. When viewing data collected with a 
polarizer, you can use the angle slider to view the profile image at each angle that was used in the collection. 

Apply profiles

The profile settings define the mathematical algorithm applied to each spectrum in the measurement, including the selected 
regions or points, to create a chemical image. The algorithm converts each spectrum into a number that is represented by a 
color in the chemical image. 

 

To apply profiles

You can select a default profile before you begin a session and you can quickly change profiles after measuring data. 

 l Before you start your session, select a profile from the Profiles list on the dashboard. This is the profile first displayed 
after measuring areas, lines, or points. 

 l After measuring areas, lines, or points, select the Profiles tab and choose an option from the Profile type list. Click 
Update to apply the changes. 

The available profile types are described below. 

Profile Description

Correlation

The Correlation profile shows the correlation between each sample point in the chemical image 
and the selected correlation spectrum. 

Each color in the profile intensity scale represents the degree of correlation with the correlation 
spectrum. 

Area

The Peak Area profile shows the corrected area of the specified peak for each sample point in the 
chemical image. The colors in the chemical image represent the relative area of the specified peak 
at each sample point. A higher intensity value (closer to the top of the profile intensity scale) 
indicates a larger peak area.
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Profile Description

Peak 

The Peak profile shows the corrected height of the specified peak for each sample point in the 
chemical image. The colors in the chemical image represent the relative intensity of the specified 
peak at each sample point. A higher intensity value (closer to the top of the profile intensity scale) 
indicates a larger peak.

Area Ratio

The Peak Area Ratio profile shows the ratio of the corrected areas of two specified peaks for each 
sample point in the chemical image. Using the ratio of two peaks lets you look at:

 l Changes in sample material (some peaks will increase while others may decrease)

 l Changes in two sample components

 l Changes in peak area normalized against another peak to make sure physical variations 
(focus for example) are not causing variations in measured peak area

 l Information about the number of layers present and the quality of the materials in a layered 
sample such as graphene 

The colors in the chemical image represent the relative ratioed areas of the specified peaks. A 
higher intensity value (closer to the top of the profile intensity scale) indicates a larger peak area 
ratio.

Peak Ratio

The Peak Height Ratio profile shows the ratio of the corrected heights of two specified peaks for 
each sample point in the chemical image. The colors in the chemical image represent the relative 
ratioed heights of the specified peaks. A higher intensity value (closer to the top of the profile 
intensity scale) indicates a larger peak height ratio.

Chemigram

The Chemigram profile shows the uncorrected area of the specified region for each sample point in 
the chemical image. The colors in the chemical image represent the relative area under the 
specified region at each sample point. A higher intensity value (closer to the top of the profile 
intensity scale) indicates a larger peak area.

Peak position

The Peak position profile shows the shift in the location of a specified peak along the X-axis. The 
measurement is based on the peak maximum in a specified region for each sample point in the 
chemical image. The colors and their associated X-axis values in the profile intensity scale indicate 
the relative locations of the peak maximum in the specified region.

Peak Width

The Peak Width profile shows the width of the specified peak for each sample point in the chemical 
image. The measurement is based on the full width of the peak at the specified height. The colors 
in the chemical image represent the relative width of the specified peak at each sample point. A 
higher intensity value (closer to the top of the profile intensity scale) indicates a wider peak.

Quant

Use a custom analytical method created with TQ Analyst software. 

To set a method, go to Identify > Quantify Setup and select a QNT file. 

See the help content for TQ Analyst software for more information on developing and calibrating 
methods.

MCR
The MCR profile finds components in the sample data based on their (calculated) pure component 
spectra and shows their locations in the chemical image. 
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Favorite and session profiles

You can save your profile settings to your favorite or your session profiles. 

 l Favorites are saved for use with all of your future sessions. For example, if you frequently use a peak position profile 
that uses the same peak location, you can save the profile with that peak location to your favorites so that you do not 
have to specify the position every time you use the profile. 

 l Session profiles are saved only with the session data. When you open the session in the future, your profile settings will 
still be present, but they will not be available during other sessions. This is useful when you want to save profile settings 
with a particular session, but you do not expect to use the settings regularly. 

❖    To save your profile settings

 1. In the Profiles tab, select a profile type and set your preferred options. 

 2. Enter a name and click Save

 3. To move a Favorite profile to your session profiles, on the Favorites tab, select the profile and click Save to session. 

Explore measurements in the Spectra view

When viewing your measurement results in the session view, you may want to explore a specific spectrum in more detail 
with tools not available in the session view. Fortunately, you can easily save a spectrum to your Measurements and then 
open it in the Spectra view. 

❖    To view a spectrum from your session analysis in the Spectra view

 1. In the Session Analysis view tab, select the Cursor tool and click a point you wish to analyze. 

 2. Open the spectra pane, if it is not already open, to view the spectrum at the selected point. 

 3. Right-click the spectrum and select Add selected spectrum to dashboard measurements. Note the X and Y position of 
the spectrum, as displayed in the spectra pane. 

 4. Click the Dashboard icon to return to the dashboard. 

 5. Under Measurements, find your spectrum. The spectrum is named using the X and Y position. 

 6. Right-click the spectrum and open it in the Spectra view. 

4.4.5 Report your microscopy analysis results

 

Create and customize microscopy reports

After analyzing a sample, you can print or save a report to record your findings. 
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❖    To create a microscopy report

 1. From the Session Analysis tab, go to File > Create Report.

 2. Enter a title for the report, select a format, and choose a template. The available templates depend on the type of 
analysis you performed. 

 3. To customize the report, select Options and choose elements to include or exclude. 

 4. Click Create. 

Thermo Scientific OMNIC Paradigm Software User Guide 192

4. How-to guides



[This page intentionally left blank]



4.5 Use Workflows
Use workflows to automate your tasks, ensuring that your analysis and processing will be carried out in exactly the same 
way each time.

4.5.1 About Workflows

You can use the workflow features in OMNIC Paradigm software to automate important procedures and frequent tasks. A 
workflow is a series of software operations that can be initiated with the click of a button. The software operations are 
represented by tiles, which you drag and drop onto the workflow canvas in OMNIC Paradigm software. You can specify 
settings for data collection, provide instructions for operators, and define data processing, reporting, and archiving in 
advance. Once a workflow has been created, operators can use it repeatedly to complete the steps the same way every 
time.

This article provides an overview of these basic workflow features and tools:

 l Workflow pane

 l Run Workflow window

 l Workflow editor

Workflow Pane

The workflow pane is always available at the bottom of the OMNIC Paradigm dashboard. Use this space to preview and run 
workflows you’ve created, and to open the workflow editor to edit or create a new workflow.
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Figure 4-1: Workflow Pane on the OMNIC Paradigm Dashboard

1. Most recent workflows (click once to preview a workflow; click twice 
to open it)

2. Right-click a workflow for more options

3. Preview of a selected workflow

4. Enlarge or reduce the Workflows pane

To do this... Take this action

Select and preview a workflow Click once on the workflow name

Test or run a workflow
Right-click the workflow and select Run. This opens the Run Workflow window where 
you can step through the workflow tasks.

Edit, rename, duplicate, delete or export 
the selected workflow

Right-click the workflow and choose an option from the shortcut menu.

Table 4-1: 
Work with existing workflows from the workflow pane
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Run Workflow Window

Use the Run Workflow window to test or run a workflow. To open the run Workflow window, right-click a workflow and select 
Run.

Figure 4-2: Right-click a workflow and select Run

1. Selected workflow (double-click to open this workflow)

From the Run Workflow window, use the arrow button to move to the next task in the workflow. The workflow will run exactly 
as it has been designed, with tasks and operator messages displayed as indicated by the workflow.
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Figure 4-3: Run Workflow Window

To stop the workflow and return to the dashboard, click the Stop button in the Play Workflow window. (If the workflow 
doesn’t have a Stop button, click the Dashboard button on the toolbar to stop the workflow.)

Workflow Editor

The workflow editor contains all the tools for creating workflows, including the workflow menu, toolbar, tile selection bar, and 
canvas. To open the workflow editor, right-click a workflow name on the dashboard and choose Edit from the shortcut 
menu.

You can also open the workflow editor from the OMNIC Paradigm main window by choosing:

File (menu) > Workflows > Create Workflow

The workflow canvas is where you select and set up the tasks you want the workflow to perform and join tasks together to 
create the workflow. The workflow editor opens with the mandatory “Workflow Start” and “Workflow End” tiles displayed on 
the canvas. Available settings for each tile in the current workflow are in the expandable sections below the canvas. Tools 
for scrolling, zooming and resetting the canvas view are at the right. A handy toolbar is above the canvas.
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Figure 4-4: Workflow Editor

1. Toolbar

2. Tile selection bar

3. Canvas

4. Tile settings

5. Tools to adjust and reset the canvas

6. Start tile

7. End tile

Each task is represented by a colorful tile in the tile selection bar. Here are some commonly used examples:
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Tools for creating, opening, and exporting workflows are located in the Workflow submenu (available from the OMNIC 
Paradigm File menu). Example workflows, available here, are a good place to start, or you can create a workflow from a 
spectrum’s history. See “Create and Run Your First Workflow” for details.

Tiles can be added, moved, copied and deleted to create the desired workflow. For more information, see the article titled 
“Edit a Workflow.”

4.5.2 Password Protect a Workflow

Lock a workflow with a password so that it cannot be edited by others. A locked workflow cannot be edited, deleted, or 
duplicated and will not display a preview. When a workflow is locked, it can still be renamed or exported.

Lock and Unlock a Workflow

You can lock and unlock workflows only from the desktop interface of OMNIC Paradigm software.

❖    To lock a workflow

 1. In the Workflow Editor, select Lock.

 2. Enter and confirm the password and click OK.

 3. Save your changes.

❖    To unlock a workflow

 1. On the dashboard, right-click the workflow and select Unlock.

 2. Enter the correct password and click OK.

Reset a Lost Password

If you lose or forget the password to a workflow, you can reset the password to unlock the workflow.

199 OMNIC Paradigm Software User Guide Thermo Scientific



You can only reset a workflow password  with an Administrator account type in Windows. To reset a password, run OMNIC 
Paradigm software as an Administrator. Note that if you are using Security Suite software, even if you grant an account 
access to the Reset Workflow Password control, the user must still run OMNIC Paradigm as an administrator. 

❖    To reset a workflow password

 1. From the Windows desktop, in the Start menu, navigate to Thermo Scientific > OMNIC Paradigm. Right click 
OMNIC Paradigm and select Run as administrator.

 2. In OMNIC Paradigm, using the desktop interface, select the locked workflow with the password to be reset.

 3. Select File > Workflow > Reset Password. This option appears only if you run OMNIC Paradigm software as an Admin-
istrator.

The password is removed from the workflow and the workflow is unlocked.

4.5.3 Create a Template Workflow

A template workflow allows you to create a single workflow that can be run using dynamic values depending on the 
situation. For example, with a template workflow, you can create a single workflow that can be run using several different 
sampling accessories. The operator can select an accessory and the workflow will be updated automatically to use images, 
quantification methods, and variables that match the accessory.

To create a template workflow, use the Workflow Table tile. With the Workflow Table tile, you import a table of options and 
corresponding values from a CSV file. Then use the values throughout the workflow.

With a Workflow table tile, you can …
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 l import many files and variables at once

 l allow the operator to select from a list of options or automate the selection

 l import custom variables or reference external files, such as images or QNT files

Using the Workflow Table tile requires you to build a CSV file of the options and data you want to include, configure the 
Workflow Table tile, and use the included data.

❖    To create a template workflow with the Workflow Table tile

Step 1: Create a CSV file for your data

 1. Create a CSV file to import with the Workflow Table tile.

Figure 4-1: The following example shows a table with three accessory options

 l Structuring the table. When creating the table, each row reflects an option or a category of related values. For 
example, you might use each row for an accessory, with the columns for data and files associated with that 
accessory. When developing your workflow, the column headings are used as variables. You can create the table 
directly as a CSV file, but it may be easier to work with a table in a spreadsheet program and then export the data 
as a CSV file.

 l Organizing your external assets. When referencing external assets, such as image or QNT files, keep your files 
very organized. This will make them easier to import in the Workflow Table tile and to update later.

Figure 4-2: Keep referenced assets organized

 2. Save the table as a CSV file.

Figure 4-3: This image shows the table as a CSV file

Step 2: Create the workflow and configure the Workflow Table tile.
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 1. In OMNIC Paradigm software, go to File > Workflows > Create. Name the workflow and select OK to open the 
Workflow Editor.

 2. Add any desired tiles to the workflow.

 3. Add the Workflow Table tile to the workflow. The placement of the Workflow Table tile depends on your individual 
requirements.

Figure 4-4: This example workflow uses the workflow table tile near the start

 4. Double-click the Workflow Table tile to open the tile settings.

 5. Configure the Workflow Table tile.

 a. Select Browse and open your CSV file.

If the CSV file included references to image, QNT, or SPA files, the tile indicates that the template expects 
additional files and provides a button to add and manage files.
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 b. For each category of required files, select Add and open the associated files that you listed in the CSV file. The file 
name must match exactly what you included in the CSV file.

Figure 4-5: These image files match the filenames in the CSV file

 c. To prompt the operator to select an option, select Operator Selection and choose a column. The column index of 
options determines which column of data is used for the options presented to the operator. The first column is 
column 1. You can also specify a column of images to display with the options. Set the index to 0 if you do not want 
to show an image.
To choose a row automatically, select Select row automatically. The first row is row 1. You can enter a specific 
value or use a variable. For example, use the Variable tile to increase the Repeat_Count variable from a Repeat 
tile by 1, then use the new variable to automatically loop through all of the options.

Step 3: Use the imported files and variables
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 1. Select another tile where you would like to use data from the Workflow Table tile. How you use values from the 
Workflow Table tile depends on your specific needs. Consider the following examples: 

 l To use a QNT file: In the TQ Analyst tile settings, select the + icon to select a variable. Select the Workflow Table 
variable that corresponds to the QNT files in your CSV file.
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 l To use an image in an Instruction tile. In the Instruction tile, click Image to add an image. Right-click the image 
placeholder and select the appropriate Workflow Table value.

 l To use a value as a variable. Select the + icon in the tile settings and select a Workflow Table variable.

 2. Save the workflow.

Step 4: Test your Workflow

It is a good idea to test your workflow to be sure that everything is loaded and working as expected.

If you workflow includes measuring data, you may want to use the Simulator mode to simplify the test.

205 OMNIC Paradigm Software User Guide Thermo Scientific



 1. (optional). Switch to Simulator mode.

 a. Return to the dashboard.

 b. Go to Configure > Connectivity.

 c. Select Simulator and select Connect.

 d. Choose an instrument to Simulate and select OK. It may take a moment for the software to switch to the new 
simulated instrument.

 2. Open your workflow in the Workflow Editor.

 3. Select Run to run the workflow.

Note that if your workflow measures data, the measurements will be saved to your database just as they would during a 
normal workflow. You may wish to delete these measurements that use simulated data.

 

4.5.4 Workflow Tiles Reference

Workflow tiles are icons that represent the tasks a workflow can perform.       Each tile has settings that define what the tile does 
when the workflow       runs. To see a tile’s settings, add the tile to your workflow on the       workflow canvas, then double-click the 
tile.     

This reference of workflow tiles is organized alphabetically. Each tile       description includes a description of available settings.     

ATR Correction

Corrects ATR spectra for the effects of variation in the depth of       penetration and the shifting infrared absorption bands that 
occur with the       ATR technique.     

Setting Description

Crystal 
type

Select the type of crystal used to measure the sample.

Angle of 
incidence

Enter the angle of incidence that was used to measure the sample.               See the specifications for the accessory to obtain this 
value.             

The Everest ATR Accessory: 45°

The default value is 45.00

Sample 
refractive 
index

Enter the refractive index of the sample at 1000 cm-1. Most               organic materials range between 1.45 and 1.55 at 1000 cm-1.               
Materials that contain carbon black have higher refractive index               values (1.7 or higher). If you do not know the refractive 
index of               your sample material at 1000 cm-1, we recommend using the default               value of 1.5.             

Number of 
bounces

Enter the expected number of internal reflections of the infrared               beam that occurred in the ATR crystal. See the 
documentation for               your ATR accessory for information about crystal material, angle               of incidence, and the number of 
bounces.             

The default value is 1.00
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Setting Description

Select 
spectrum

ATR Correction is applied to the specified spectrum.

Tile name Sets the name of the tile in the workflow canvas.

Decision

With a Decision tile, you can control the flow of the workflow based on       criteria that you specify. For example, you can 
provide two separate paths       based on whether or not a correlation search result had a match value       above a specified 
threshold.     

Setting Description

Pass/Fail

Select a pass/fail decision type to use a previously generated               pass/fail result as the decision criteria.             

For example, the Peak Analysis tile can generate a pass/fail               result based on the measurement of the peak height. For 
instance,               you can specify that if the peak height is above a given value,               generate a pass result, and if it was below that 
value, generate a               fail result. Then, you can use the decision tile to continue the               workflow in two separate paths, depending 
on that result.             

Numeric 
Value

Select a numeric value to be used in the decision. The value can               be data generated in a previous workflow tile or it can be 
a value               that the operator entered using the Instruction tile.             

For example, you can check if the match value of a search result               was above a specified threshold and continue the 
workflow based on               that criteria.             

String 
Value

Select a string value to be used in the decision. The string can               be data generated in a previous workflow tile or it can be 
text               entered by the operator using the Instruction tile.             

With a string value, you can check if the selected value is equal               to or contains your test string.             

For example, if you select Contains and provide “Poly” as the test               string, the decision tile will evaluate to True if the 
selected               value is Polystyrene.             

Spectrum 
Age

Ccontrol the flow of the workflow depending on the age of a               spectrum.             

For example, you can check if a background spectrum is more than               20 minutes old before moving on to another step in the 
workflow               and then measuring a new background if necessary.             

Tile name Sets the name of the tile in the workflow canvas.

Delay

Pauses the workflow for the indicated amount of time before proceeding.     

Setting Description

Delay (seconds) The number of seconds that the workflow will remain paused.

Message The message is displayed to the operator during the delay.

Tile name Sets the name of the tile in the workflow canvas.

Embedded Workflow

Use the Embedded Workflow tile to include one workflow in another.
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Using the Embedded Workflow tile, you can create one workflow for a subset       of common tiles or processes and then reuse 
that workflow in many other       workflows. If you want to change a setting or update a tile in the       embedded workflow, you can 
make the change once rather than having to       manually edit the settings in every workflow.     

You can update any embedded workflows in the Workflow Editor. Open the       workflow that includes the Embedded Workflow 
tile, right-click an empty       space on the canvas and click Update Embedded Workflow(s). Then select any       embedded 
workflows that you want to update.     

It is recommended that you always keep embedded workflows up to date to       ensure the workflows behave as expected.     

Setting Description

Select a Workflow file to 
import

Browse to a workflow file to use as the embedded workflow.

If you update the embedded workflow, you must browse to the               workflow and reload it or the changes will not 
be reflected in               this workflow.             

End

Every workflow has at least one End tile. If your workflow includes       Decision or Selection tiles, there may be more than one 
possible ending.     

Setting Description

End type
Choose Success or Failure for a visual indication of the workflows               end state. The end type does not affect data in the 
workflow. It               only provides a visual cue to the workflow developer.             

Note
Use the note field to enter text for a tooltip that appears when               hovering over the tile in the workflow canvas. This is useful for               
providing a reminder to the workflow developer. For example, if               used with a Failure end type, the note could summarize the 
test               that caused the failure.             

Tile 
name

Sets the name of the tile in the workflow canvas.

Equation

The Equation tile is an advanced tile for evaluating complex equations.       You can include variables from other tiles in the 
equation and use       built-in functions for common problems, such as calculating an average or       rounding a value. You can also 
use functions to find peak height or peak       location or to perform other operations on a spectrum.     

The tables below list valid operators and functions.

Operator Description Example

+ Addition 15 + 4 = 19

- Subtraction 15 - 4 = 11

* Multiplication 15 * 4 = 60

/ Division 15 / 4 = 3.75

- Negation -15 + 4 = -11

Table 4-1: 
Arithmetic Operations         
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Operator Description Example

mod
Modulo division 
(returns the remainder)

15 mod 4 = 3

& Text concatenation “abc” + “def” = “abcdef”

Comparison operators return O for false or 1 for true.

Operator Description Example Result

< Less than 2 < 3 true

> Greater than 3 > 2 true

<= Less than or equal to 2 <= 3 true

>= Greater than or equal to 3 >= 2 true

=, == Equals 3 = 3, 3 == 3 true, true

!=, <> Does not equal 3 != 3 false

true  true = 1 true

false  false = 0 true

Table 4-2: 
Comparison Operations         

Operator Description Example

AND True if both operands are true x AND y

OR True if either of the operands is true x OR y

Table 4-3: 
Logical Operations         

In the table below, parameters surrounded by square brackets ([]) are       optional.     

Operator Description

Average(list) The average of a list of numbers (sum divided by the number of               items)             

Avg(list) The average of a list of numbers (sum divided by the number of               items)             

Max(list) The highest value in the list

Min(list) The lowest value in the list

AMax(list) The absolute value of the maximum value

AMin(list) The absolute value of the minimum value

Sum(list) The sum of a list of numbers

Table 4-4: 
Functions
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Operator Description

StdDeviation
(list)

The standard deviation

Std(list) The standard deviation

acos(number) Arcosine of a number in radians

asin(number) Arcsine of a number in radians

atan(number) Arctangent of a number in radians

aTan2(X1,X2)
Arctangent of X1 divided by X2 in radians. The signs of both               arguments are used to determine the quadrant of the 
returned               value.             

cos(radians) Cosine of an angle measured in radians.

cosh(radians) Hyperbolic cosine of an angle measured in radians.

sin(radians) Sine of an angle measured in radians.

sinh(radians) Hyperbolic sine of an angle measured in radians.

tan(radians) Tangent of an angle measured in radians.

tanh(radians) Hyperbolic tangent of an angle measured in radians

Pi() Ratio of the circumference of a circle to its diameter

abs(number) Absolute value of a number.

Ceiling
(number)

Smallest integer greater than or equal to <number>. Example:               Ceiling(2.2) is 3.0             

Floor(number)
Largest integer less than or equal to <number>.               
Example: Floor(2.7) is 2.0             

Round
(number)

Rounds a floating point value to the nearest integer value. (tie               rounds to the nearest even integer. 3.5 -> 4; 4.5 -> 4             

sqrt(number) Square root of a number.

Truncate
(number)

Truncated number. Everything to the right of the decimal point is               removed, leaving only the integer portion of the 
number. The               returned value is not rounded.             

Random() Random fractional number between 0 and 1

exp(number) Result of the constant e (2.7182818) raised to the power of the               specified number (e^<number>)             

pow(base, 
power)

The base value raised to the power.
Example: pow(2,3) = 8             

log10(number) Base 10 log of number

log(number) Base 10 log of number

ln(number) Natural logarithm (base e logarithm) of a number

expneg(power) Result of the constant e (2.7182818) raised to the negative power               of the specified number (e^<-number>)             

ten(power) 10 raised to the power

tenneg(power) 10 raised to the negative power

negln(number) Negative natural log
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Operator Description

neglog
(number)

Negative base-10 log

invsqrt
(number)

Inverse square root

toNumber(text) Converts a text number to a numeral that can be used in equations.               (“10” to 10)             

textLength
(text)

Number of characters, including spaces, in the specified text. A               CRLF is counted as two characters.             

Y(location 
[,baseline] 
[,baseline2])

Y-axis value at the given location with a two-point baseline

Area(start,end 
[,baseline] 
[,baseline2])

Area between two spectral limits using a two-point baseline

Pmin(start,end 
[,baseline] 
[,baseline2])

Corrects the spectrum with a two-point baseline and then reports               the minimum Y-axis value between two spectrum 
limits             

Pmax(start,end 
[,baseline] 
[,baseline2])

Corrects the spectrum with a two-point baseline and then reports               the maximum Y-axis value between two spectrum 
limits             

Ploc(start,end 
[,baseline] 
[,baseline2])

Corrects the spectrum with a two-point baseline and then report               the location (X-axis value) at which the maximum Y-
axis value               occurs between two spectral limits             

Pavg(start,end 
[,baseline] 
[,baseline2])

Determines the average value of the spectrum between two spectral               limits             

PkHgt
(start,end 
[,baseline] 
[,baseline2])

Finds the height of a peak

PkArea
(start,end 
[,baseline] 
[,baseline2])

Area between two spectral limits using a two-point baseline

PkLoc
(start,end 
[,baseline] 
[,baseline2])

Corrects the spectrum with a two-point baseline and then report               the location (X-axis value) at which the maximum Y-
axis value               occurs between two spectral limits             

PkMin
(start,end 
[,baseline] 
[,baseline2])

Corrects the spectrum with a two-point baseline and then reports               the minimum Y-axis value between two spectrum 
limits             
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Operator Description

PkMax
(start,end 
[,baseline] 
[,baseline2])

Corrects the spectrum with a two-point baseline and then reports               the maximum Y-axis value between two spectrum 
limits             

Pwidth(start, 
end [,%height])

Determines the peak width between two spectral limits. Report the               width at which the peak reaches a specified 
percentage of the peak               maximum.             

Pcut(start, end 
[,%height])

Determines the location (X-axis value) of the cut-on or cut-off               point in the specified spectral region. For example, for a 
region               with increasing Y value, a cut-on point occurs where the increase               reaches the specified percentage of total 
increase across the               region. Here is an example showing a cut-on point with “percent”               set to 60:             

 

Ghalfwidth
(start, end)

Finds the width of a peak at half the peak height

Slope(x1, y1, 
x2, y2, x3, y3, 
...):

Returns the slope (y=mx+b)

Intercept(x1, 
y1, x2, y2, x3, 
y3, ...):

Returns the intercept point

ZSlope(x1, y1, 
x2, y2, x3, y3, 
...):

Returns the zslope (y=mx)

CorCoef(x1, 
y1, x2, y2, x3, 
y3, ...):

Correlation coefficient

Laser(x1, y1, 
x2, y2, x3, y3, 
...)

Calculates the best laser frequency for the instrument under the               conditions in which the spectrum was measured.             

x1, x2, x3 ... refer to the measured values of a peak or feature               of the spectrum.             

y1, y2, y3 ... refer to the true values of the corresponding peak               or feature.             

The output of the function is the value of the laser frequency               that would move the measured value as close as 
possible to the               true, actual value.             

DoesFileExist
(filename):

Accepts a full file path in quotes and returns true(1) or               false(2). 
Example:               DoesFileExist(“C:\Users\MyFiles\MyMethod.qnt”)             
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Operator Description

M(name) Returns the measurement method used

V(name) Returns the composite component

C(name) Returns the concentration of the component (name)

U(name):

 
Returns the uncertainty associate with the concentration of               component (name)             

TQ_Y(value): Enter the index value for the Y file. The first element is index               1.             

TQ_Z(value) Enter the index value for the Z file. The first element is index               1.             

U_Set(index, value) Sets the value at the index

TQ_UU(value) Access the user values attached to a TQ method

UU_Set(index, value)
Sets the user value at the specified index

 

Table 4-5: 
TQ Functions: These functions allow you to work with information from           a TQ method         

Export

Send data and reports to a user specified location. This location can be       on your local system or on a network or flash drive 
for alternate storage.     

Setting Description

Select data to archive Choose from available spectra and reports created or imported               during the workflow.             

File base name

The base name is prepended to the full file name.

When the file is archived, it is named according to the following               template:             

<base name>_<workflow name>.<tile name of data               creation>.<variable name>_YYYY_MM_DD_
HHMMSS_<time zone               in GMT>.<file extension>             

For example, with a base name of “example” and a workflow called               “my workflow”, a spectrum collected 
on the Measure tile would be               archived as the following:             

“example_my workflow.Measure.Sample_
2019_06_25_104928_GMT-0500.spa”             

Append date and time to file 
name

If selected, the system appends the date and time that the data are saved to the file name. This ensures 
that a new file is created every time the workflow is run. 

If not selected, every time you run the workflow, the previously exported file will be overwritten with a new 
file. This is useful if you want to update one file, rather than create new files.  

File location The directory in which the file will be archived.

Tile name Sets the name of the tile in the workflow canvas.
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Instruction

Use the Instruction tile to provide additional instructions to the       workflow operator. The Instruction tile can also include entry 
fields for       the operator to enter text or numeric data. These entries can later be       used in the workflow. For instance, text 
entered by the operator can be       added to a custom report.     

Setting Description

Add Image

Add an image that the operator will see on the instructions screen               during the workflow. Valid file types 
include:             

.PNG

.JPG

.GIF

.BMP

Add Text Box
Use to add text. This is useful for providing instructions to the               operator and for adding labels to text and 
numeric entry fields.             

Add or Remove PDF
Provide a button that operators can click or touch to view a               specified PDF.             

After adding the document button, click the button to specify the               PDF file.             

Add or Remove Cancel 
Button

Provides a cancel button that the operator can click or touch to               stop the workflow.             

+ Text Entry
Allows the operator to enter text which can be used later in the               workflow.             

For example, the operator can enter a file path which can be used               in the Archive tile.             

+ Numeric Entry

Allows the operator to enter a numeric value which can later be               used as a variable in other tiles.             

For example, the numeric value entered can be used in the Decision               tile as the condition in a Numeric 
Value decision.             

+ Value Display data from a variable, such as match value of a result from               a correlation search.             

Tile Name Sets the name of the tile in the workflow canvas.

Load Spectrum

Load a SPA file to use during the workflow. You can browse to a file       location on the instrument computer or on a flash drive 
or network       location or you can load a spectrum from the database.     

This can be useful for importing a saved spectrum to use as a reference.       For instance, you may want to import a reference 
spectrum to use in a       subtraction operation.     

Setting Description

From file
Load a SPA file from a location on your system or your network.             

File name: Browse to a SPA file to include a spectrum.
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Setting Description

From database

Select to load a spectrum from the database.

Selected spectrum: Choose a spectrum from the database.

Choose during workflow execution: Allow the operator to select a               spectrum during the workflow.             

Show only experiments containing this text: Limit the operator’s               choice to only spectra that contain the 
specified text in the               title or tags.             

Import spectrum every run

If selected, the spectrum is imported from the file system when the workflow is run. If the spectrum file is 
updated, the workflow will always use the latest version of the spectrum. 

If not selected, a copy of the spectrum file is imported when the workflow is created. This spectrum only 
changes if you manually edit the workflow and update spectrum files.  

Note that if you share this workflow or add it to a package, you will need to share the SPA file 
separately, and it must be saved on any other systems in the exact same file path specified in the 
Import Spectrum tile. 

Tile name Sets the name of the tile in the workflow canvas.

Measure

Use the measure tile to measure the background and a sample and to set the       measurement settings. Spectra and reports 
created during the workflow are       saved to the database and can be archived with the Archive tile.     

Setting Description

Background settings
Specifies whether the workflow will prompt the operator to acquire               a new background, use a spectrum from 
another tile in the               workflow, or measure a background only, without measuring a               sample.             

Correction settings Apply Atmospheric suppresion and/or a Kramers-Kronig correction.

Use internal polystyrene 
sample

If selected, an internal polystyrene reference sample installed in               the instrument will be used to validate the 
instrument’s               performance.             

Use sample prompt
Select to provide instructions to the operator before measuring               the sample. You may want to instruct the 
operator to insert the               sample.             

Use background prompt
Select to provide instructions to the operator before measuring               the background. It is a good idea to instruct 
the operator to               prepare to measure the background.             

Allow other workflows to 
access result of 
measurement

If selected, you can include spectra from this workflow in other               workflows. For example, once this workflow is 
run and has measured               a sample, a separate workflow could use the collected spectra as a               reference 
spectrum or in a report.             

Show spectrum during 
measurement

Select to view the spectrum during the measurement. If not               selected, operators see only a progress 
indicator.             

Progress text Provide a custom message to operators during the background and               sample measurement.             
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Setting Description

Other Measurement 
Settings

Customize the measurement settings used in this workflow or match               the settings used with another 
spectrum.             

Number of scans: The number of times that the sample will be               scanned. More scans typically means for 
accurate data, but will               take longer to measure.             

Match Settings: Select to match the measurement settings used with               a specified SPA or QNT file. Select All 
Settings to review all of               the settings used with this measurement.             

Spectrum Title: Select to append variable data to the spectrum               title.             

See Measurement Settings and Advanced Measurement settings for a               description of additional settings.             

Tile name Sets the name of the tile in the workflow canvas.

Peak Analysis

Find peak locations or analyze the Peak Height or the Peak Ratio of a spectrum.

Setting Description

Peak 
Height

Measure the height of a peak from zero absorbance (or 100%               transmittance), without regard to the position of the 
baseline, or               from the baseline. If measured from the baseline, the measurement               is called the "corrected peak height."             

Peak position: Enter the wavenumber of the peak to be measured.             

Corrected: Select to measure the peak height from the spectral               baseline rather than from zero absorbance (or 100% 
transmittance)             

Reference point: Select for single-point correction, using one               point as the baseline reference.             

Reference range: Select for two-point correction, using a point on               either side of the peak to calculate the baseline.             

Generate pass/fail result: Select to create a pass/fail result               that can be used in a Decision tile.             

Peak Ratio

Find the ratio of height between two peaks. Peaks can be               calculated from zero absorbance units or from a corrected               
baseline.             

Not corrected: The peak heights are measured from zero absorbance               (or from 100% transmittance)             

Single-point corrected: The peak height will be measured from the               baseline at the wavenumber you entered.             

Two-point corrected: A point on either side of the peak will be               used to calculate the baseline.             

Generate pass/fail result: Select to create a pass/fail result               that can be used in a Decision tile.             

Find 
Peaks

Find the locations of peaks in your spectrum. The resulting spectrum with labeled peaks is available as a spectrum in the 
Report tile and as a template option in the Template Report tile. 

Select 
spectrum

Select the spectrum that will be used in the peak analysis. You               can choose from spectra generated in the workflow or 
imported with               the Load Spectrum tile.             

Tile name Sets the name of the tile in the workflow canvas
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Processing

The Processing tile includes several tools for processing spectral data,       including subtraction, normalization, correlation, 
basic spectral math,       and baseline correction.     

Setting Description

Spectral Math
Perform basic operations using a sample spectrum and a reference             spectrum. For more on spectral math, 
see             "Apply Basic Equations to Acquired Data"

Sample spec-
trum

The starting spectrum to which the operation will be applied.

Reference 
spectrum

The reference spectrum used in the operation.

Operation

Add
Subtract
Divide 
Multiply

Spectral 
Math Type

Select a type of spectral math. Available options include

 l Factor

 l Pathlength

 l Range

Normalization

Use Normalize to change the Y-axis scale of the selected spectra               to a “normal” scale in which the Y values 
of the data points range               from 0 absorbance units for the lowest point to 1 absorbance unit               for the highest 
peak (for an absorbance-like spectrum) or from 10%               to 100% transmittance (for a transmission-like 
spectrum). These               normal scales are typical of spectra in commercial spectral               libraries.             

After a spectrum is normalized, you cannot use it for quantitative               analysis unless you know the scaling 
factor and adjust the               quantitative results accordingly.             

Select 
spectrum

The starting spectrum to which the operation will be applied.

Max range 
(cm-1)

Use to set the range used in the normalization.

Min range 
(cm-1)

Use to set the range used in the normalization.

Target value Target value is specified in absorbance units.

Derivative
Convert the spectrum to either its first or second derivative to             help you find the location or intensity of 
peaks.           

 
Select spec-
trum

The spectrum to which the operation will be applied.

 Order Select either first or second order derivative.

Correlation
Returns the match value between the first and second spectrum.               Like QCheck, the match value is given 
between 0.0 and 1.0, with               1.0 reflecting a perfect match.             

First 
spectrum

Select the starting spectrum that the second spectrum is being               compared to.             
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Setting Description

Second 
spectrum

Select a reference spectrum.

Spectral 
range

Use the spectral range to exclude totally absorbing peaks from the               correlation search.             

Scalar Math Apply an operation to a single spectrum.

Spectrum Select the spectrum to which the operation will be applied.

Operation

Add
Subtract
Divide 
Multiply

Factor
Increases or decreases the amplitude of the spectrum so that it               can be better compared to another 
spectrum.             

Baseline Correction Use to correct a baseline that is shifted.

Select 
spectrum

Select a spectrum for which the baseline will be corrected.

Polynomial 
order

Specify the polynomial order for the correction.

Conversion Convert a spectrum to another unit.

 
Select spec-
trum

Select the spectrum to convert.

 
Conversion 
type

Convert to one of the following: 

 l Absorbance

 l % Transmittance

 l % Reflectance

 l Log 1/Reflectance

 l Kubelka-Munk

Blank 
regions

 

Clear the data from one or more regions of your spectrum. See "Blank a region in your spectra" for more 
information about blanking regions. 

Set the start and end points for the region to blank. Click Add to add more regions. 

Statistical 
spectra

 

 

Calculate the average and standard deviation of 2 or more spectra. View the resulting spectra in the Report 
tile. See "Calculate average and standard deviation spectra" for more information about calculating the 
average or standard deviation of spectra. 

Select 2 or more spectra, the calculation to perform, and the data format used in the calculation. 

Tile name Sets the name of the tile in the workflow canvas

Repeat

Loop a portion of the workflow to repeat steps.
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Setting Description

Repeat ___ times Sets the number of times that the looped portion of the workflow               will repeat.             

Tile name Sets the name of the tile in the workflow canvas.

Report

Create a custom report that can be stored, archived, or printed. Reports       generated in the workflow are available in the 
Reports section of the       dashboard.     

Setting Description

Add image

Add an image that the operator will see on the report screen               during the workflow. Valid file types include:             

.PNG

.JPG

.GIF

.BMP

Add text
Use to add text. This is useful for providing instructions to the               operator and for adding labels to text and numeric entry 
fields.             

Add or remove 
document

Provide a button that operators can click or touch to view a               specified PDF.             

After adding the document button, click the button to specify the               PDF file.             

Add spectrum Add a spectrum to the report. Select any spectrum generated or               loaded earlier in the workflow.             

Add variable
Add a value from another workflow tile to the report. For example,               if the workflow included a measurement and a 
search, you can               include data from the results of the search.             

Add table
display a table of results, such as from TQ Analyst / Quant method             or peak analysis. Displays results from previous 
instances of             running the workflow, not just from the current run.           

Add or remove 
print button

With a print button, operators can print the report while viewing               the report screen.             

Tile name Sets the name of the tile in the workflow canvas

Run Program

Use the Run Program tile to have your workflow run an executable file. For       example, use this tile to create a step in your 
workflow that run s a       third-party automated sampling accessory.     

Combine this tile with the Variable tile or other tiles to create powerful       workflows. For example, use the count variable from 
the Repeat tile to       automatically increment an argument passed to the executable.     

The Run Program tile can run only executable files that do not require any user       interaction and that do not have a user 
interface.     

Setting Description

File name
The executable to run. Note that if you run this workflow on another computer, that computer must have 
this same EXE in the exact same file path. 
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Setting Description

Arguments

Pass arguments to the executable. To include variables in the command, select a variable from the list 
and click Add to Arguments List. When entering arguments, observe the following syntax requirements: 

 l Each argument must be enclosed in double quotes (“”)

 l Separate arguments with spaces

Example: “-p 6” “workflowname.variable.myVariable”

Verify program file integrity at 
run time

Ensures that the executable is exactly the same file during runtime.

When you create the workflow, the software stores the location and name of the executable file. 

If the file is replaced by a new executable with the same name, that file will be run instead. Select this 
option to ensure that the file is exactly the same file you selected when you created the workflow.  

We recommend leaving this selected to ensure that the exe has not been replaced with another file. If 
you update the exe intentionally, you must update the workflow as well. 

Turning this setting off is useful if you expect to update the EXE periodically and do not want to update 
the workflow. However, this may pose a security risk.  

Save Result

Exports collected data to a CSV file.

Setting Description

Select data to 
export

Select available data that can be exported to the CSV file, such               as peak heights or search result match values.             

Append to file

If selected, will append the exported data to an existing CSV               file.             

To append the data to an existing file, enter the name of the file               in the File Name field. If the file doesn’t exist, a new file 
will               be created with the name you entered.             

File name
(only available if Append to File is selected)

Enter               the name of the file that the data will be appended to. If the               file does not already exist, a new file will be created.             

File base 
name

(only available if Append to File is not selected)

The file base name is added to the file name before the date and               time.             

File location The directory in which the file will be appended or created.

Tile name Sets the name of the tile in the workflow canvas.

Search

Perform a correlation or a multi-component search.

Setting Description

Available libraries
Drag libraries from the Available Libraries column to the Selected               Libraries to use them in the search.             

Click Refresh to update the list of available libraries.
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Setting Description

Search type

Set the type of search that will be performed.

Correlation: Use to identify an unknown sample.
Number of               results: Set the number of results that will be shown.             

Multi-component: Use to identify the components of a sample.
Number               of components: Set the number of components that will be shown.             

Spectral Ranges Add a start and end value for the region that will be searched.             

Select spectrum Specify the spectrum that will be used in the search.

Tile name Sets the name of the tile in the workflow canvas

Selection

With a Selection tile, the operator chooses which path the workflow should       follow.     

Setting Description

Add image

Add an image that the operator will see on the selection screen               during the workflow. Valid file types include:             

.PNG

.JPG

.GIF

.BMP

Add text Use to add text. This is useful for providing instructions to the               operator.             

Add value
Add a value from another workflow tile to the report. For example,               if the workflow included a measurement and a search, 
you can               include data from the results of the search.             

Selection 
label

Edit the selection label to change the text that appears on the               workflow canvas.             

Start

This is the first tile in every workflow. The Start tile is added to the       workflow canvas automatically each time a new workflow 
is created.     

Setting Description

Workflow 
image

Determines the image that is displayed when the workflow is run.               Accepts a file path to an image file.             

The following file types are valid:

.PNG

.JPG

.GIF

.BMP
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Setting Description

Desired 
aspect ratio

Specify an aspect ratio to optimize the appearance of the workflow               when it is run. The aspect ratio should match the 
display used by               the operator as closely as possible.             

Examples: 
4:3 for older computer monitors

16:9 is               the standard for high-definition video and is common for current               computer monitors             

Accepts the following:
1:1
4:3
5:4
16:9
16:10
3:2
2:1

 

Tag Spectrum

Apply a tag to spectra created during the workflow.

Setting Description

Tag Apply a tag to a spectrum.

Select spectrum Choose the spectrum to which the tag will be applied.

Tile name Sets the name of the tile in the workflow canvas.

Template Report

Generate a report from a template. Reports generated in the workflow are       available in the Reports section of the dashboard. 
Most of the settings       for a template report depend on the template type that is selected.     

Setting Description

Template type

Choose from the following template types:

ValPro style

Single spectrum

Multiple spectra

Search results

Single quantification

QCheck

Multiple run quantification

Automatically advance workflow after 
displaying report for 5               seconds             

If selected, the workflow will advance after displaying the report               for 5 seconds. If not selected, 
the operator manually continues               the workflow.             
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Setting Description

Generate pass/fail result
If selected, specify text that will trigger a fail result. For               example, if you specify “fail,” the 
template report tile will               generate a fail result if the report includes the text “fail.”             

TQ Analyst

Quantify the components of the sample using a specified quantification       method.     

Setting Description

Quantification method Select a QNT file for the quantification method.

Select spectrum Select the spectrum that will be used for the quantification.

Tile name Sets the name of the tile in the workflow canvas.

Variable

Use the Variable tile to assign a new value to an existing variable or to       create a new, custom variable. Variables created or 
edited with the       variable tile can be used in other tiles.     

Setting Description

Operation

Select an operation type. The operation you select determines the               other settings that are available.             

Set Variable: Use to set the value of a current variable.

Create Variable: Use to create a new variable.

 

Set 
Variable

Variable to set: Select a variable to change the value.

Current variables: Provides a list of current variables in the               workflow. Select one and click Add to Expression to include 
the               variable in the expression.             

Create 
Variable

Numeric or Text: Select a type for the value of this variable. The               type determines what operations are valid for this 
variable. For               example, if you set the type to Text, you will not be able to use               the value of this variable for calculations.             

Variable name: Enter a name for the variable

Initial value: Enter a starting value for this variable

Workflow Table

Import a CSV file to use as a template for your workflow.

With the Workflow Table tile, you can import a table of options to use       throughout the workflow. For example, with this tile, 
you can select one       option when you begin the workflow and then automatically load specific       variables, methods, and 
images throughout the workflow that correspond to       that option. 

Setting Description

CSV file
Browse to a CSV file to import.

Browse to select a new file. Reload to check the file for updates.             
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Setting Description

Select row 
automatically

Automatically select a row from the CSV file.

Operator selection

The workflow operator selects a row manually during the workflow.

Operator prompt: Text instruction to display to the operator.

Column index for selection options: Specify the column to use as available options. The first column is index 1.

Column index for selection images: You can also display an image along with the selection options. Set the index 
to 0 if you are not using images.

Included files

Shows what files are expected based on the CSV file and how many have been included in the workflow.

 l Select Add to add one or more files.

 l Select Manage to view or remove included files

Tile name Sets the name of the tile in the workflow canvas.

 

4.6 Custom Solutions
Bundle and share workflows using the Package Editor and open and run packages using the Operator interface. 

 

4.6.1 Custom Solutions

This page offers a brief overview of using packages and the Operator interface in OMNIC Paradigm software to develop and 
run custom solutions. When available, follow the links to find more detailed information about using specific features.

What Are Custom Solutions?

With custom solutions in OMNIC Paradigm software, you can design and bundle workflows for other operators to use.

A developer designs workflows and bundles them with all their required files into Packages and then shares the packages 
as RDEP files.

An Administrator then opens the packages so that the workflows can be run using the Operator interface.

Packages and the Package Editor

A package is an organized collection of workflows that can be easily shared. When you bundle workflows into a package, 
the package includes all of the files and information necessary to run the workflow on another system, including any 
reference spectra, images, and QNT files.

When you create and export a package, an Administrator at another site can open the package in the Operator interface so 
that users can run all of the included workflows.
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For details on creating and exporting packages, see "Create or Edit a Package"

Figure 4-1: The Package Editor

There are two major elements to a package: 

 l Workflows: A workflow is a pre-determined set of procedures and settings that ensure that procedures are carried out 
in exactly the same way each time. For more on workflows, see "About Workflows".

 l Categories: In a package, workflows are organized into categories. You can group workflows into categories in any 
way that makes sense for your organization; however, a workflow can be included in only one category. The same 
workflow cannot be included in more than one category.

When you export a package, all of the required files used in the workflows are packaged as well, ensuring that operators 
have all the files they need to run the workflows when they open the package.

The Operator Interface

The Operator interface is used for running workflows loaded from packages and for managing packages. After opening a 
package, operators are presented with a simplified interface designed to run the package workflows.

The Operator Administrator can control which workflows are available by opening or deleting packages.
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Figure 4-2: The Operator Interface

The Operator interface is similar to OMNIC Paradigm software's touchscreen interface but presents only workflows from 
opened packages.

An Operator Administrator can open, update, and delete packages using the administrator controls. For details on opening 
and deleting packages, see "Operator Administrator"

Tips for Working with Packages

When creating workflows and packages, it can be challenging to keep track of dependencies, such as quant methods and 
embedded workflows. The following tips may help you manage your files and ensure your workflows are up to date and 
easy to maintain.

 l Organize your files so that they are easy to update and maintain. For example, you may want to create a single 
folder for resources used in your workflows. Then, within that folder, create specific folders for related items, such as 
quant methods, images, and spectra files. Then, keep the folder in the same location and keep the file names the same. 
You can then use the Update commands in the Workflow Editor to quickly update all of the workflow's dependencies.

 l Keep your workflows as simple as possible. For example, the Embedded Workflow tile is a powerful tool, but it adds 
greater complexity to your project. Whenever the embedded workflow is updated, you will need to manually update 
every other workflow that uses it.

4.6.2 Create or Edit a Package

You can create a new package or open and edit an existing package with the Package Editor.

Before you create a package, you will need at least one workflow. For more on creating and using workflows, see "About 
Workflows".

Packages can be created only in the Desktop interface of OMNIC Paradigm software.
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Create a New Package

❖    To create a new package

 1. Using the desktop interface, go to File > Packages > Create.

 2. Enter a name for the package and select OK. The package editor opens with one default category. You can add more 
categories or add workflows to the category.

 3. To add a workflow, select a category and select Add Workflow.

Workflows can be included in only a single category. You cannot use the same workflow in multiple categories.

 4. To add a category, select Add Category.

 5. Select Save to save the package. The saved package is available in the Packages pane of the dashboard. The 
package is saved automatically when you return to the dashboard but is not saved automatically if you exit the software 
from the Package Editor.

 6. To share the package, select Export. When you export the package, it is saved with an .rdep file name extension.

Tips for Organizing Workflows and Categories

There are a few important factors to consider when organizing your workflows and categories in packages.

 l A workflow can be included in only one category. You cannot use the same workflow in more than one category. If 
you have workflows that you want to share across categories, you may want to create a separate category only for 
these shared workflows. This is true even with multiple packages. If a previously loaded package already includes a 
workflow with the same name, the operator Administrator will not be able to open a new package if it includes that 
workflow in another category.

 l Categories must also have a unique name. When the operator opens a package, any category that uses the same 
name as a category from a previous package will be merged. For example, if a new package includes a category 
named Category A, and a previous package already included a Category A, the categories will be merged into a single 
category including all of the workflows from both categories.

Consider the following example:

 l Catogory A (First Package)

 o Workflow 1

 o Workflow 2

 l Category A (Second Package)

 o Workflow 3

Is displayed as : 
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 l Catogory A

 o Workflow 1

 o Workflow 2

 o Workflow 3

Edit a Package

You can open and edit a package either from the Packages pane on the dashboard or from a saved RDEP file.

❖    To edit a package

 l From the dashboard of the desktop interface

 1. Scroll to the Workflows pane and select Packages from the list.

 2. Right click a package and select Edit. The package opens in the package editor.

 l From a saved RDEP file

 1. From the dashboard, go to File > Packages > Open.

 2. Select a RDEP  file and select Open. The file is added to the list of packages on the dashboard.

 3. In the Packages pane, right click the package and select Edit.

If you open a RDEP file from the Package Editor, the package is opened in the Package Editor automatically.

Update Workflows

The Package Editor includes several tools for updating workflows and their associated files.

When you add a workflow to a package, the workflow file is copied to the package. Any updates apply only to this package 
copy and are not reflected in the original file or any other packages that have copied the workflow file.

To keep the workflow files and their associated files (such as images or QNT files) synchronized, you must update them in 
the Workflow Editor manually. To avoid unexpected behaviors or results, you may want to update the workflow directly 
using the Workflow Editor and then use only the Update Workflow command in the Package Editor.

Command Description

Update 
Workflow

Reloads the selected workflows and updates any changes, including any files included in the workflow (for 
example, changed image files)

Update 
Embedded

Updates any workflows embedded using the Embedded Workflow tile.

Update Quant Reloads any .QNT files that were included in the workflows.

Update Image Reloads any image files used in the workflows.
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Test Packages

Use the Run command to test the package before exporting it. By running the package, you can view and run categories 
and workflows as they will be shown in the Operator interface.

Note When you run the package, if you run any workflows that collect data, the measurements are added to your 
database just as if you ran the workflow normally.

Run Workflows Automatically

You can set a workflow to run automatically using Auto Run. If automatic running is enabled, the workflow will run without 
any operator input. The workflows will run in the background while you use the software. If a workflow is running in the 
background, the operator will need to wait for it to complete before running another workflow.

You can set workflows to auto run only if they do not require any user input.

If multiple workflows are scheduled to run with Auto Run, they are added to a queue. For example, if one workflow runs 
every hour and another every two hours, they will both run on the overlapping hours and will not interfere with one another.

❖    To enable Auto Run

 1. In the Package Editor, right-click a workflow and select Set Up Auto Run.

 2. Select Enable automatic running for this workflow and enter a value for the frequency in hours. You can also enter 
partial hours. For example, entering 0.5 will cause the workflow to run every 30 minutes.

 3. Select OK.

The workflow will run automatically after the package is opened in the Operator interface.

4.6.3 Operator Administrator

Use the Administrator controls in the Operator interface to manage packages, to change the Administrator password, and to 
return to the Desktop interface.

To access the administrator controls, select Administrator from the menu in the Operator interface and enter the correct 
password. The default password is Password. The Administrator should change the password immediately after installing 
the software.

Manage Packages

Use the Package Maintenance tab in the Administrator view to manage packages.

Open a Package

Opening a package loads the package categories and workflows into the Operator interface. Once the package is opened, 
operators can select categories and run workflows. Any workflows set to run automatically will begin running as scheduled.
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When you open a new package, new categories and workflows are added to the categories and workflows from previously 
opened packages. For example, if the administrator opens "Package A" and then later opens "Package B", the operator will 
see the categories and workflows from both packages.

❖    To open a package

 1. Using the Operator interface, open the menu and go to Administrator.

 2. Enter the password to access the administrator controls.

 3. In the Package Maintenance tab, select Open.

 4. Select a package file and select Open. Package files have a .rdep file name extension.

Update a Package

When you open a package with the same name as a previously opened package, the package is updated.

For example, if you have already opened a package called "Package A" in the past, when you open a new package that is 
also called "Package A", the new package replaces the previous package.

Delete a Package

Deleting a package removes that package's categories and workflows from the Operator interface.

❖    To delete a package

 1. Using the Operator interface, open the menu and go to Administrator.

 2. Enter the password to access the administrator controls.

 3. Select one or more packages from the list of packages.

 4. Select Delete and confirm your choice in the confirmation dialog.

Change Administrator Password

Use the Change Password tab to change the password for the Operator Administrator.
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4.7 Protect Your Data
OMNIC Paradigm software pairs with Security Suite software to ensure your data integrity and security. 

4.7.1 Data Security and Integrity with OMNIC Paradigm Soft-

ware

To ensure the security and integrity of your data and to help your lab comply with 21 CFR Part 11 or other regulations, pair 
the OMNIC™ Paradigm software with Thermo Scientific Security Suite software.

Security Suite is a comprehensive data security toolset, allowing you to perform the following tasks:

 l Limit and control access to features and tools in the OMNIC Paradigm software and other instrument applications.

 l Set and manage security policies to ensure proper data handling.

 l Customize and enforce digital signatures to establish responsibility. 

 l Log and view security events. 

You can purchase Security Suite software to manage a single system or to manage multiple instruments distributed on a 
network. After installation, configuring the OMNIC Paradigm application for security takes only moments.

For a discussion of how Security Suite software can help you comply with 21 CFR Part 11, see 21 CFR Part 11 Compliance.
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